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INTRODUCTION – CARVEWRIGHT 

CNC SYSTEM 
 

 

 

WHAT IS CNC? 
NC (Computer Numerical Control) is a computer control process used to 
direct precise movements of robotic cutting, carving, and milling tools. It 
was most commonly found in industrial manufacturing settings, but as the 

technology has advanced, it is finding its way into everyday life. It is how nearly 
everything is made today. The CarveWright CNC is a “Personal CNC” or “Desktop 
CNC” system, referring to its small footprint and ease-of-use. 

There are many different kinds of CNC Systems for doing various functions, but 
there is a common vocabulary that helps us identify and understand their basic 
operation. 

 

Axis - Axis refers to a direction of movement. In a 3 axis machine, the machine’s 
cutting capability will be in 3 directions; X,Y, & Z, or forward and back, left and 
right, & up and down.  It is possible for more or less axis depending on the function 
of the machine. The CarveWright is a 3 axis machine. 

Stepper Motors - A stepper motor (figure I.1) is a brushless DC electric motor that 
divides a full rotation into a number of equal steps. The motor's position can then 
be commanded to move and hold at one of these steps without any feedback 
sensor (open-loop control), as long as the motor is carefully sized to the 
application. Stepper motors are commonly used for lower-end CNC systems, as 
they lack the feedback for increased speed, power and accuracy of servo motors. 

Servo Motors - A servo motor (figure I.2) is a brushed motor that uses a built-in 
encoder for error-sensing feedback (closed loop control) to correct the 
performance of a machine. This means that the system can sense the exact 
position of the motor, and make corrections, if the motor ever gets out of position. 
This is an advantage over stepper motors, as steppers have no feedback to inform 
the system when they get out of position. The CarveWright is a full servo motor 
system. 

C

HARDWARE 
TERMS 

FIGURE I.1 STEPPER MOTOR 

FIGURE I.2 SERVO 
MOTOR 
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Gantry - A gantry (figure I.3) is a frame structure 
that spans an area and moves along tracks. A 
carriage is mounted to the structure that can 
move along the spanning bridge.  Many CNC 
machines use a gantry structure for their 3 axis 
control.  The movement of the gantry structure is 
the X axis, and the carriage is the Y axis.  The Z axis 
refers to the up and down movement of the carriage. 
Gantry systems are limited to the working area within its tracks.  This means the 
pieces being made with a gantry CNC are limited to the size of the machine itself. 
Small machines can only make small parts. 

Feed-Through - A feed-through is a machine that allows material to be feed 
through it at a controlled rate.  This is commonly seen in printers as they feed 
paper through the machine along its X axis. Feed through systems are not limited 
by their footprint for the size of pieces they can make.  A small machine can feed 
through long material.  The CarveWright uses a feed-through system for large 
project capacity even with it’s small footprint. 

Spindle - The spindle on a CNC refers to the spinning cutting head where the bits 
(tools) are attached.  The spindle is often the entire 
motor that drives the cutter, but in some cases can be 
driven by a motor located elsewhere in the machine.  
On low-end CNC machines, the spindle motor will 
often be a small off the shelf router that is mounted 
with brackets. The CarveWright (figure I.4) uses a cut 
motor that drives a spinning flexible shaft to drive the 

spindle. 

Controller - The controller is the brain of any CNC. It’s a computer that processes 
the machine code commands into the actual motion the machine performs. 
Controllers can range greatly in size and capability depending on the machine and 
application.  The CarveWright uses the ServoSmart controller, which was designed 
specifically for it. 

FIGURE I.3 GANTRY FRAME 

FIGURE I.4 CARVETIGHT 
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Computer-aided design (CAD) is computer software used to create a design. CAD 
software can be in either 2D or 3D and is an extremely precise way to design parts 
for manufacturing. There are dozens of CAD programs on the market today ranging 
in price and functionality.  The CarveWright system uses its own CAD program 
called Project Designer. 

Computer-aided manufacturing (CAM) is computer software used to convert the 
CAD files to machine language in order to control the machine.  Many CAD 
programs have CAM software incorporated in order to simplify the workflow.  
Often, the machine being used is selected from a list for the proper code to be 
written.  The CarveWright has an incorporated CAM software that writes the 
machine code during the upload process.  

Speed and Feed - This refers to two separate settings in CNC; the cutting speed 
and the feed rate.  The cutting speed is the speed difference between the cutting 
tool and the surface and the material it is operating on.  It is usually described as 
feet per minute.  The feed rate is the speed difference at which the cutter is 
advanced along the workpiece. They work together to determine how fast the 
cutter spins in relation to how fast the cutter is moved around the work piece.  
These settings are important to a successful project.  The wrong settings can cause 
breaking of bits, machine crashing, motor stalls, and burning of material. Most CNC 
systems require these settings to be programmed in for each bit and for each 
operation. The CarveWright’s speed and feed rates are pre-programmed, so they 
never have to be set by the user. 

Machine Setup - In order for a CNC machine to run an operation successfully, it’s 
parameters have to be defined.  These parameters include setting the length of the 
cutter and the X, Y, & Z positions of the work piece.  This is often a manual process 
of moving the machine’s spindle to the defining positions to program them in prior 
to running the job.  Some more advanced CNC systems today have automatic 
setup that eliminates the need for this manual process.  The CarveWright has an 
automated machine setup. 

Machine language (figure I.5) is a set of 
instructions sent to the machine to instruct it in 
its operation.  This is the language of the 
machine and includes the commands of 
position, speed, direction, etc. The most 
common CNC machine code is G-code.  There 
are also many different proprietary machine 
codes that have been developed by CNC manufactures 
over the years in order to increase the functionality and ease-of-use of their 
particular machines.  The CarveWright CNC uses a proprietary machine code.  

SOFTWARE 
TERMS 

FIGURE I.5 MACHINE CODE 
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FIGURE I.7 VECTORS ROUT ALONG A PATH 

Raster Cutting Operation (figure I.6) - In 
computer graphics, a raster graphics image, 
also known as “bitmap”, is a dot matrix data 
structure representing a generally rectangular 
grid of pixels.  Each pixel is a tiny square that 
represents a color.  The combination of all of 
these tiny squares creates an image.  A raster 
operation in CNC works much like a inkjet 

printer except each pixel has an assigned depth 
rather than a color.  It works from one end of 
the graphic and moves along one line of pixels before moving to the next line of 
pixels.  The Z axis changes its depth to match the depth information for each pixel, 
resulting in a 3D carving. 

Vector Cutting Operation (figure I.7) - Vector 
graphics is the use of geometrical primitives 
such as points, lines, curves, and shapes or 
polygons—all of which are based on 
mathematical expressions—to represent 
images in computer graphics. These graphics 
are infinitely scalable, since they contain no 
pixel information.  In CNC, a vector operation 
means the cutter can move along the path and 
trace along the line or curve. This type of 
operation can be very fast for operations like 
text, cutouts, and v-carving.

FIGURE I.6 RASTER CARVING LINE BY LINE 
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FIGURE I.8 CARVEWRIGHT CNC MACHINE 

OVERVIEW OF THE CARVEWRIGHT MACHINE 
You can think of the CarveWright CNC machine (figure I.8) as a subtractive 3D 
printer. It removes material, through cutting or carving, with a spinning bit, from a 
block of material set into the machine.  

 

The CarveWright CNC System is unlike most 
CNC’s in several ways.  For one, the footprint of 
the machine is much smaller at only 15x18x26, 
but packs a lot of power for its compact size.  The 
servo motors are a lot faster than the stepper 

motors used on most CNC’s. Unlike a gantry 
CNC, which is limited on project size by its bed, the CW uses a feed-through, belt 
drive system to feed material of virtually unlimited length. The controller is built 
into the machine and projects are uploaded to memory cards for transfer. Then 
the keypad and LCD panel located on the side of the CW allows the user to not 
only access their projects, but also many other built-in functions. 

 

The Project Designer software (figure I.9), is available for PC or MAC, allows several 
options for creation of 3D designs.  A library of elements (or patterns) is included 
with the software.  These can easily be placed on the 3 dimensional virtual board 
in a drag and drop fashion and then manipulated in a variety of manners including 
resizing, rotating, inverting, grouping and mirroring to create one-of-a kind 
designs.  Built in drawing tools allow for creation of designs along with various 
other tools for the addition of text, texture backgrounds, contoured regions, lines, 
curves and shapes.  Other options include the ability to 
import images, purchasing additional patterns from the 
Pattern Depot, and purchasing add-on modules to 
further expand the software’s features.  

There are two versions of Project Designer available:  

Project Designer BASIC is a free version that 
is packaged with every machine.  

Project Designer PRO is an upgrade version 
that has many more features and updates.  

Additionally, there are many add-on modules that expand the capabilities of the 
software. 

CARVEWRIGHT 
CNC MACHINE 

PROJECT 
DESIGNER 
SOFTWARE 

FIGURE I.9 PROJECT DESIGNER 
SOFTWARE 
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FIGURE I.11 CONFORMING VECTORS 

FIGURE I.12 VECTOR DRAWING SUITE 

FIGURE I.13 PATTERN MODELING SUITE 

The CarveWright System is designed to be modular, meaning you can buy only the 
features you want, and customize your software to your needs. This allows you 
control over your software and your budget. 

Centerline Text (figure I.10) adds an additional 
Rout Mode in the Text Tool feature. This feature 
uses the 60° and 90° V-groove bits to follow the 
center of the letters for a clean engraved, v-cut 
look.  The depth of the centerline is determined by 
the width of the text selected. 

 

Conforming Vectors (figure I.11) enables v-bit 
routing along a carved surface.  Without 
Conforming Vectors, these types of routs can only 
be made on the flat, top surface of the 
board.  The “conform” feature can be applied to 
any vector function, including Centerline Text and Vector Groups. 

 

2D Vector Drawing Suite (2D Advanced) (figure 
I.12) is a tool bar add-on for Project Designer that 
expands the drawing and vector manipulation 
capabilities of the software.  Define vector paths 
quickly, trace images, trim and merge vectors 
together, and many other features that assist in 
creating your own drawings. 

 

3D Pattern Modeling Suite (3D Advanced) (figure 
I.13) is a tool bar add-on for Project Designer that 
enables modeling of 3D relief patterns. Extrude, 
sweep, and puff shapes into dimensional creations. 
These tools are easy-to-use and make your own 
custom pattern design fun and simple. 

ADD-ON 
SOFTWARE 
MODULES 

FIGURE I.10 CENTERLINE TEXT 
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FIGURE I.16 PATTERN SCULPTOR 

 

The DXF Importer (figure I.14) allows the user to 
import 2D vector files created in 3rd Party 
software packages. DXF is a common format for 
vector software such as AutoCad, Illustrator, 
CorelDraw, and more. The DXF Importer tools 
allow for scaling, rearranging, flipping, rotating, 
auto-connecting of lines, splitting (tiling designs), 
create boards to layout shapes, and ultimately, 
importing those boards into Designer to be carved or cut out. 

 

The STL Importer (figure I.15) enables importing of 
3D STL files and preparing them for carving.   This 
is done by scaling the model to the desired output 
size, and then slicing, or cutting, it into pieces that 
can be carved on a flat board by the machine.  The 
cut angles and depths can be customized to give 
the best possible strategy for retaining the details 
of the model.  These slices, once carved, can then be reassembled into a physical 
3D model. 

 

Pattern Sculptor (figure I.16) is a creative sculpting 
and editing tool for 3D relief carving patterns. 
Quickly and intuitively smooth, smudge, and add 
or remove details to prepare patterns for relief 
carving. This software only works with Project 
Designer PRO. 

 

Pattern Editor (figure I.17) is supplied FREE with 
the CarveWright Scanning Probe.  Its primary 
purpose is to provide tools for cleaning up and 
preparing scans for carving.  Once finished, the 
patterns can be saved directly to Project Designer’s 
pattern library for immediate integration into your 
designs for carving. 

 

FIGURE I.14 DXF IMPORTER 

FIGURE I.15 STL IMPORTER 

FIGURE I.17 PATTERN EDITOR 
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FIGURE I.18 KEYHOLE FUNCTION 

FIGURE I.19 ROTARY JIG 

FIGURE I.21 SANDING MOPS 

Keyhole Function (figure I.18) enables plunge 
cutting keyhole shaped mounting slots in items 
such as picture frames and plaques. It’s a quick 
an easy way to automate making these hanging 
slots, so your work can be displayed. With 

Designer’s ability to design on the front and back of 
your boards, adding these professional looking 
hanging slots becomes simple. The keyhole bit required for this is included with 
this module. 

 

 
Scanning Probe (figure I.19) can also be purchased as an accessory to the 
CarveWright.  This probe attaches like a bit on the CW machine and allows for the 
reproduction of 3-dimensional objects by probing the 
object with an accuracy of up to .005 of an inch.  The 
resulting 3D data can then by downloaded and accessed 
from the included Pattern Editor software for further 
manipulation and use by the user. 

 

Rotary Jig (figure I.20) and accompanying software, enables the design, import, 
and carving of turned projects. It’s like a lathe, but with carvings. The rotary 
software, included with purchase of the jig, shows the carved round piece 
alongside a flat board where the design is manipulated. The jig is simple to use. 
Load your material, calibrate the jig, and carve your pieces in the round. With the 
STL Importer add on, you can even import STL’s directly into the rotary format. 

 

Sanding Mops (figure I.21) are a great way to speed up 
and simplify the sanding and cleaning of your carvings. 
Attach it to a drill press or another high speed motor, and 
quickly polish your projects without removing your carved 
details. It will literally save you hours of tedious, hand 
sanding work. With two grits and two sizes, no matter the 
project, we’ve got you covered. We also have sandpaper 
refills for when you wear them out from all the great projects you are making. 

 

ACCESSORIES 

FIGURE I.19 SCANNING PROBE 

FIGURE I.20 ROTARY JIG 
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Memory Card & Programmer (figures I.22 & I.23) are used to easily transfer of 
your project, from the Project Designer software, to the CW machine.  The 
memory card programmer attaches to a USB port and the project is uploaded to 
the memory card.  During this upload process, a time estimate calculation is 
displayed for the amount of time to project will take. There are also quality 
settings for changing the speed of the project.  The higher you set the quality level, 
the slower the machine carves. The memory card allows the design work to be 
accomplished from your office or computer room away from any sawdust or other 
possible hazards in your workshop.   

The card is inserted into the memory card slot on the side of your CW machine, 
and the project is selected from the on board keypad and LCD.  The capacity of the 
memory card is large enough to hold a significant number of projects and scans. 
How many it will hold depends on the size of the individual projects. If the card fills 
up, simply delete some of the files using the Flash Manager in the software. As 
long as you save the project file to your computer hard drive before compiling, it 
can be put onto the memory card over and over.  Compiled project files cannot be 
transferred from the card back to the software. 

 

Third Party Accessories (figure I.24) developers are becoming more and more a 
part of the CarveWright family. Many of these products are great additions to your 
CarveWright machine and are produced by customers easier and less expensive 
than we could. 

 

 

 

 

FIGURE I.23 PROGRAMMER 

FIGURE I.22 MEMORY CARD 

FIGURE I.24 THIRD PARTY ACCESSORIES 
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FIGURE I.25 CARVEWRIGHT BITS 

CarveWright Bits include a variety of bits for different carving and cutting 
purposes.  The CW carving 
& cutting bits are all high 
quality carbide 
designed for longer-
life and more precise 
cutting performance. 

There are three categories of bits (figure I.25) used with the system: 

Carving Bits are solid carbide ball nosed bits. Carving bits are used for 
doing detailed “raster” carving and shaping.  There are several sizes 
available for various types of carving.   
 
Cutting Bits are solid carbide straight end-mill bits. Cutting bits are used 
mostly for doing vector cutout functions. The bit will follow a path, or line, 
designated in the software to cut an object out, drill holes, or route lines 
into the material. 
 
Decorative Bits are a variety of “router” bits with several profiles to 
choose from.  They are “plungeable” and specifically calibrated with the 
Project Designer Software to ensure proper speed and feed settings for 
each bit. They are sold individually or as a set.   

Carving Bit accessories, such as split collets & rubber stop collars, description and 
uses are also available at 
www.carvewright.com/bits/ 

 

Pattern Depot (figure I.26) includes 
thousands of patterns from which to 

choose, save to your Pattern Library 
in your Project Designer software and 
then use over and over again in your projects. There are also many pre-designed 
projects available with all the project files and instructions needed to create them. 

To see the patterns and projects available, visit http://patterns.carvewright.com  

For more information about the complete CarveWright product line, visit 
www.carvewright.com  

FIGURE I.26 PATTERN DEPOT 
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FIGURE I.27 LITHOPHANE CARVING 

WHAT CAN THE CARVEWRIGHT CNC DO? 
 

Now that we have some basic understanding of 
what the CarveWright is, let’s explore what it 
can do.  The CarveWright is a very versatile 
system suitable for innumerable types of 
projects.  It is, mostly, up to the imagination of 
the user to determine what it makes.  
However, some types of projects are more 
common than others. 

 
Some Common Projects with the CarveWright CNC: 

• Sign Making 
• Furniture Design and 

Restoration 
• Architectural Elements 
• Crafts 

• Home Decor 
• Model Making 
• Mold Making 
• Musical Instruments 
• Lithophanes (figure I.27) 

 

Maximum Dimensions 

• Width – 14.5" 
• Depth – 5" 
• Length – 12’ carving 
• Weight – 20 lbs 
• Work pieces over 3’ long will 

require additional support, 
such as out-feed rollers, at 
the appropriate height. 

Minimum Dimensions 

• Width – 1.5" 
• Depth – .5" 
• Length – 7” 
• If any of these dimensions 

fall below the minimum 
limitations, the work piece 
will require a jig. 

 

 

TYPES OF 
PROJECTS 

CAPACITY OF 
THE CW 
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Approved For Use: 

• Wood  
(Hard and Soft woods) 

• Foams  
(HDU, XPS; EPS)  

• Plastics  
(PVC, Polycarbonate, Corian, 
Cast Acrylic) 

• Machinable Wax 

NOT Approved For Use: 

• Glass 
• Ceramics 
• Stone 
• Metals 
• Concrete 
• Soft plastics  

(low melt temperature) 

  

ACCEPTABLE 
MATERIALS 
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Quiz 

1. What does CNC stand for? 

 

2. What is the difference between a feed-through and a gantry? 

 

3. Is the CarveWright a feed-through or a gantry? 

 

4. Describe the two types of cutting operations. 

 

5. What is the Scanning Probe? 

 

6. Name the two types of CNC drive motors. 

 

7. Which type of drive motors does the CarveWright use? 

 

8. What is the name of the CarveWright CAD/CAM software? 

 

9. What are the maximum board dimensions of the CarveWright System? 

 

10. Can the CarveWright carve/cut metal? 

 

11. Name three add-on software modules for CarveWright, and describe what 

they do? 

 

12. What are the three categories of bits used with the CarveWright System? 

 

There is certainly more to know from this section, 
but this should give you a good indication of what 
you should have learned. 
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CHAPTER 1 – GETTING STARTED 
 

BEFORE YOU BEGIN CARVING 
I know you are excited to give your new purchase a test drive, but there are 
some things you need to do and learn first.  Most is located in our Getting 
Started Section under the SUPPORT menu:  
http://support.carvewright.com/getting-started/ 

INSPECT AND INVENTORY:  
The first step in getting started with the CarveWright CNC is to un-box the 
machine, inspect it for any shipping damage and inventory your order. If 
there are any issues, contact LHR Technologies, Inc. at 713-473-6572.  

MACHINE SET-UP: 
Follow the instructions in the Quick Start Guide located in the box and on 
our website.  READ BEFORE YOU TURN ON YOUR MACHINE. 

REMEMBER SAFETY FIRST: 
Please follow all safety suggestions listed in the CarveWright Machine Manual. 

CREATE A CUSTOMER ACCOUNT: 
Next, you will install your Designer software, create your own Customer 
Account and register your machine, software licenses and computers. Make 
sure to follow the steps in the Designer Software Quick Start Guide located 
in your box and on our website. These steps need to be accomplished 
before proceeding with this learning guide.  NOTE: You created a Store 
Account, when you purchased your machine; not a Customer Account. 

ADDITIONAL RESOURCES: 
Make sure you also read the CarveWright Hardware Manual and watch the 
instructional DVD. These contain the basic operating and troubleshooting 
information needed to successfully use the CarveWright CNC System.   

The CarveWright Project Designer Manual is also very thorough in its 
explanation of the CarveWright software and should be used as a 
companion to this guide.   

Other resources include tutorials, videos, Tips & Tricks, FAQs, maintenance 
schedules, repair documents, a Forum, Local User Groups and START U 
members.  
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HOW TO DESIGN YOUR PROJECT 
 

Start with quality patterns or, if you are importing an image (whole other animal), 
use a high resolution.  Remember images on the internet are a low resolution, so 
that they will quickly load on the browser page. Some clean up of these patterns 
can be done with other add-on software. 

Use any True Type Font, but remember thin fonts may result in chip out. Lower the 
height and add draft to help prevent this. 

There are four quality settings. The higher the setting, the less the sanding will be 
required.  You may want to carve a test piece prior to carving in your more 
expensive materials.  

Use sharp bits. It should be sharp enough to scrape away part of your fingernail. Bit 
optimization could also help with your projects success. 

Your desired finished piece size will most often dictate what size virtual and actual 
boards you will need. 

 

 

Finished Project size – Example: 24” x 8.436” 
 

TRASH IN = 
TRASH OUT 

DETERMINE 
PROJECT SIZE 
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Virtual Board Size (always larger than project) – Example: 26” x 12” x .75”  
Reserve .5” as keep out zone at the top of your virtual board to avoid board 
tracking roller when doing cut-outs. 

 

 

 

 

 

 
Actual Board (always larger than virtual) – Example: 33” x 13”  
Needs 3.5” on each end from start of carve to automatically stay under the rollers. 
This can be from the board or from a jig. Width is not as critical, just keep in mind, 
if your virtual is 12” and your actual is 12”, but your machine measures it as 
11.999” then it will ask if you want to shrink your project to fit the board. (Unless, 
of course, you don’t care if it shrinks it down.)
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PROJECT DESIGNER BASICS 
 

The Designer software is available in the BASIC & PRO versions.  Every registered 
machine allows for one BASIC license, which can be installed and registered on two 
computers.  The PRO version, additional add-on software, patterns & project 
licenses can be added to these BASIC licenses.  It is available for both MAC and 

Windows Operating Systems.  Check out further information such 
as computer requirements in the Software FAQs.   

Designer is used as a virtual board, to which you add different 
elements, such as patterns, text, drawing tools, textures, surfaces 

and more to create a PROJECT for carving on the machine. Always save your 
projects (.mpc) files to your hard drive for future use or changes. 
Upon upload to the memory card, those elements are changed 
into a language that the machine understands and is no longer 
readable by the Designer software. 

Designer software is only forward compatible. Projects designed in 
BASIC can opened in PRO, but those designed or saved in PRO cannot be opened in 
BASIC. Only one version can be open at a time, but both can be installed on your 
computer.  Any new features will be programmed for the PRO version.  

 

These step by-step tutorials have been designed to give you the opportunity to 
learn by doing.  They can be printed and sat beside you at your computer, while 
you follow each step to learn the different design features and create the project 
of each tutorial. Photos in these tutorials show what you should similarly be seeing 
on your own screen. 

Projects include: 

Ø Design Basic 
Ø Basic Shell 
Ø My First Carve 

All of these tutorials can be completed using just the features of Designer BASIC. 

 

PROJECT 
DESIGNER BASIC 
& PRO 

STEP-BY-STEP 
TUTORIALS 
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DESIGN BASICS 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
This project covers the following design concepts: 
 
 
Ø STARTING SOFTWARE 
Ø MENUS, TOOLBARS OR MOUSE 
Ø MANIPULATING THE WORKPIECE 
Ø PATTERN PLACEMENT 
Ø PATTERN MANIPULATION 
Ø CENTERING 
Ø MIRRORING 
Ø TEXTURE 
Ø MANAGING DATA 
Ø UPLOADING TO MEMORY CARD 
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INSTRUCTIONS: 
Ø STARTING THE 

SOFTWARE 
The Welcome screen appears 

with project options.   
 

Select “New Project” 
 
 

Set your board piece dimensions.   
Length: 12” 
Width: 5.5”  

Thickness: .750”    
 

Click ok 
 

NOTE: Put in the dimensions of 
the project board. This needs to 

be the finished size of your 
project. Do not include the 7” 

margin required by the machine. 
(more on the 7” rule later in this 

lesson) 
 
 

Ø MENUS, TOOLBARS OR 
MOUSE  

 
 

Ø MANIPULATING THE 
WORKPIECE  

 
Board piece will display on screen 

in three dimensions. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
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PATTERN PLACEMENT 

 

  Select the “pattern tool” to 
open the pattern library along the 

right side.  
 
 

Select the basic folder and find 
the Rosettes.  Select Rosette 04 

and place in on the board. 

 
 
 
 
 

Ø PATTERN MANIPULATION 
Use Red Nodes on the corners to 

Scale the pattern larger or smaller 
without skewing the pattern. 

 
KEEP OUT ZONE: Top .5” unless 

using sled to protect Board 
Tracking Roller. 

 

 

 

 

Ø CENTERING 

 
Right-Click on pattern to bring up 

menu of available options.  
 

 Select “Center” 
 “Center Both”  
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Ø PATTERN PLACEMENT 
 

Open the Leaves folder under 
Basic in the Pattern Library. 

Select Holly 01 and place the 
leaves on the board. 

 
 
 
 
 
 
 
 
 
 

Ø PATTERN MANIPULATION 
 

Scale using the red corner dots. 

 
 
 
 
 
 
 

Rotate using the green dot. 
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Ø MIRRORING 
 

 

 
 

Select leave pattern.  
Right-click and select Mirror > 

Mirror All. 
 
 
 
 
 
 
 
 
 

Notice the pattern is reflected on 
all four corners.  If you move one; 

the others follow exactly. 
 
 
 

Move patterns and adjust the 
angle & size to get your design 

arranged the way you like. 

 
 
 
 

Ø TEXTURE 
 

 
 

Toggle texture to see design. 
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Ø MANIPULATING THE 
WORKPIECE  

 
Zoom in or out to view. 

 
Rotate design to view it from 

different angles. 
 
 
 
 
 
 
 
 

Ø MANAGING DATA 
 
 

 
Select “File”, “Save”  

 
 
 
 
 
 
 

Always save your project to your 
hard-drive, but NOT in the 

CarveWright Program Folder. 
Once uploaded to the card, you 

cannot bring it back into the 
software for further manipulation 

or changes. 
 
 
 
 

*****IMPORTANT***** 
Name file and click “Save” to hard 

drive. 
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Ø UPLOADING TO MEMORY 
CARD 

 

 
 

Plug in your memory card 
programmer and insert the 

memory card.  

Select “File”, “Upload”  
  
 
 
 
 

Notice the estimate time based 
on which quality setting is 

selected.  The higher the quality 
the slower the machine will carve.  

 
Save to memory card. 

 
Example: 

MyFirstProject_N_31 
(Recognizable name_quality 

setting_estimated time to carve) 
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Basic Shell 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
This project covers the following design concepts: 
 
 
Ø STARTING SOFTWARE 
Ø MENUS, TOOLBARS OR MOUSE 
Ø MANIPULATING THE WORKPIECE 
Ø PATTERN PLACEMENT 
Ø PATTERN MANIPULATION 
Ø CENTERING 
Ø MIRRORING 
Ø MANAGING DATA 
Ø UPLOADING TO MEMORY CARD 
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INSTRUCTIONS: 
Ø STARTING THE 

SOFTWARE 
The Welcome screen 
appears with project 

options.   
 

Select “New Project” 
 
 
 
 
 
 
 
 
 
 
 

Set your board piece 
dimensions.   
Length: 12” 

Width: 6”  
Thickness: .75”    

 
Click ok 

 
 
 
 
 
 
 
 
 

Ø MENUS, TOOLBARS 
OR MOUSE  
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Ø MANIPULATING 
THE WORKPIECE  

 
Board piece will display on 

screen in three dimensions. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 
 
 
 

Ø PATTERN 
PLACEMENT 

 

  Select the “pattern 
tool” to open the pattern 

library along the right side.  
 
 
 
 

Select “Shell 02” under 
“Shells” in the Basic Library.  

Click on board to place.  
 
 
 

Ø PATTERN 
MANIPULATION 

Use Red Nodes on the 
corner to Scale the Shell 

larger. 
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Ø CENTERING 

 
Right-Click on “Shell” to 

bring up menu of available 
options.  

 
 Select “Center” 

 “Center Both”  
 
 
 
 
 
 
 
 

Ø MIRRORING 
 

 
Select “Filagree 00” under 

“Filagrees”  in the Basic 
library.  

 
Place on board next to the 

shell. 
 
 
 
 
 
 
 

 
Right-Click and select 

“Mirror”, “Mirror 
Horizontally”.  
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Notice the pattern is 

reflected across the board.  
If you move one; the other 

follows exactly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scale the pattern up and 
position around the base of 

the shell. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Rotate design to view it 

from different angles. 
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Ø MANAGING DATA 

 
 

 
Select “File”, “Save”  

 
 
 
 
 
 
 
 
 
 
 

*****IMPORTANT***** 
Name file and click “Save” 

to hard drive. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø UPLOADING TO 
MEMORY CARD 

 

 
Select “File”, “Upload”   
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Notice the estimated 
carving time of 13 min 44.  

 
Save to memory card. 

 
Example: 

Shell_N_14 
(Recognizable name_quality 

setting_estimated time to 
carve) 
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My First Carve 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü MANIPULATING THE WORKPIECE 
ü PATTERN PLACEMENT 
ü PATTERN MANIPULATION 
ü CENTERING 
ü MOVE ELEMENT 
ü MIRRORING 
ü FINE TUNING & OPTIMIZATION 
ü ADJUSTING DEPTH 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 
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INSTRUCTIONS:  
 

ü STARTING THE SOFTWARE 
 

Open the CarveWright Project 
Designer Software 

 
The Welcome screen appears with 

project options.   
 

 
Select “New Project” 

 
 
 
 

Set your project board dimensions.   
Length: 7” 
Width: 7”  

Thickness: .75”    
 

Click OK 
 
 

The project board size is not 
necessarily the actual size of the 

board being put into machine.   
 
 

ü MENUS, TOOLBARS, SHORTCUT 
KEYS OR MOUSE BUTTONS 

 
 
 

For every software function, we 
provide you three distinct ways to 

access that function.  They are 
usually menu, icon or right-click. 

Some common functions, such as 
Copy and Paste, also use shortcut 

keys.  These will also work in Project 
Designer. 
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ü MANIPULATING THE 

WORKPIECE  
 

Board piece will display on screen in 
three dimensions.  You can use 

these tools to get a different view of 
your project board. 

 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 
 

ü PATTERN PLACEMENT 
 

 Select the “Pattern Tool” 
icon to open the pattern library 

along the right side. 
 

Select “spring” under “Season 
Patterns” in your Favorites library. 

 
Click once on pattern & once on 

board to place or click & drag to the 
board. Double-clicking will attempt 

to open it in Pattern Editor 
Software. 

 
 

ü PATTERN MANIPULATION 
 

Use Red Nodes on the corner to 
Scale the element larger or smaller.   

 
Yellow nodes will stretch or skew 

the element. 
 

ü CENTERING 
 

Right‐Click on “spring” to bring up 
menu of available options. 

 
Select “Center” > “Center Both” 

If item is grey, then it is not 
available with the selected element. 



41 | P a g e  
 

ü PATTERN PLACEMENT 
 

 Select “leaf” under “Season 
Patterns” in your Favorites library. 

 
Place on board next to the stem. 

 
ü MOVE ELEMENT 

 
To move a selected element, find 

the point of the element where 
your cursor turns to 4 arrows 

pointing in north, south, east & 
west directions.   

 
Click once and drag to location. 

 
ü MIRRORING 

 
Right‐Click on the element and then 

select “Mirror” > “Mirror 
Horizontally”. 

 
Notice the pattern is reflected 
across the board’s centerline. 

 
 

Scale the pattern to size and 
position around the base of the 

stem. 
 
 
 
 

ü FINE TUNING & OPTIMIZATION 
OF YOUR PROJECT 

 
 
 

You should make adjustments to 
one of the two elements.  Adjusting 
the depth of the flower may make it 

loose some of its detail.  Plus, you 
may want the leaf to appear behind 

the stem. 
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ü ADJUSTING DEPTH 

 
 
 

Change the “Depth” of the leaf to 
.250”   

Hit “Enter” to apply.  
 

If you make changes to one 
mirrored object, it is reflected in the 

other(s). 
 

 
Rotate or zoom in on your project 

to view it from different angles and 
make any necessary adjustments. 

 
 

ü MANAGING DATA 
 

Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a 

memory card, it cannot be brought 
back from the memory card into 

the software.  Always SAVE YOUR 
PROJECT on your hard drive.  A 

Projects folder is recommended 
and you should know where you 

saved it. 
 

Name file and click “Save”  
 
 
 

ü UPLOADING TO MEMORY CARD 
 

Make sure your Memory Card 
 & Programmer are properly 

attached via your USB port, Select 
“File” > “Upload” to save to your 

memory card. 
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Select Quality Setting  
 

Ø DRAFT 
Ø NORMAL 
Ø BEST 

Ø OPTIMUM 
 

These settings determine the 
number of passes the machine 

makes to carve your project.  The 
more lines the better the surface  

finish.  Make your decision based on 
material type, fondness of sanding 

vs. machine time, & test carve vs. 
final.  Notice the estimated carving 

time differs by quality setting. 
 

Name Your Project  
 

Example: 
myfirstcarve_N_12m 

(recognizable name_quality 
setting_estimated time to carve) 

 
Click “Upload” 

 
 
 

NOTE: Actual board to be placed in 
machine should be 7” longer or you 
should use a sled that has 3.5 extra 
inches on each end to STAY UNDER 

THE ROLLERS. 
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WAIT!  Don’t start carving yet! 

There are still more things to know! 

 

 

 

 

PROPER PREPARATION OF MATERIALS 

 

roper board preparation is crucially important to successful operation of the 
CarveWright System.  The quality of your output will depend on the quality 
of your materials. Following some simple steps will ensure you greater 

success with your projects.  

All of the topics addressed in this document are outline and discussed in the 
Hardware Manual, as well as the CarveWright Instructional Video. 

 

 

 
The actual board that is loaded into the machine for carving needs to meet some 
basic requirements for success.  

Here’s why. The machine measures the board using two sensors. One is an 
electronic eye (board sensor assembly) at the base of the z-truck, which measures 
the width and the other is the brass wheel or roller (board tracking encoder) that 
measures the length of the board.  The board must maintain constant contact with 
the wheel in order to get an accurate measurement and project results.  

 

 

P

 BOARD 
PREPARATION 
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Here are some of those basic requirements for the material being put into the 
machine: 

NEEDS TO BE STRAIGHT AND SQUARED   
If the board varies in its width, it can become wedged in between the squaring 
plate and the sliding plate.  This can cause improper board tracking and can 
possibly break some teeth on the x-drive gears. 

CANNOT HAVE ANY WARPING  
Warping can cause issues that prevent the board from making proper contact with 
the board tracking encoder. The little brass roller on the keypad side of the 
machine is the board tracking sensor. Its teeth actually track the edge of the board 
creating the length measurement.  Anything that interferes with that 
measurement will result in an error or failed project. 

90º ANGLE AND FREE FROM DEFECTS 
The board’s edge that will ride along the board tracking sensor needs to be a 90º 
angle (not curved) and free from any knots, divots or other defects. 

NEEDS TRACTION 
The board tracking sensor needs to maintain steady contact with the roller.  A 
board that is too slick can slip.  A strip of masking tape along the bottom edge that 
goes over the roller will give it the extra bite that it may need. 

STAY UNDER THE ROLLERS 
If one end of the board pops out from under the 80 or so lbs of pressure that the 
compression rollers have, the board could pop up and lose contact with the roller.  
Also, if you have the required outfeed rollers for boards over 3 ft, you want to 
make sure the board is not “lifted” off the wheel as it goes onto an outfeed roller 
that may be set too high. 

MASKING A BOARD  
The board sensor assembly needs to “see” a consistent reflection as it measures 
the board width.  If your board is a dark color, either naturally or painted, has 
knots in the path that it is trying to measure or has a great variation in colors, you 
may want to run a strip of masking tape (beige) across the area that it is trying to 
“see”. 
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One of the most important items (and commonly missed) when getting started 
with the CarveWright CNC System is that the projects you carve need to be “Under 
the Rollers”.  To do this, you need to make your actual project board 7” longer 
than the “virtual” board that appears in the Project Designer software when you 
are laying out a project. This creates a 3.5” margin on both ends of the board for 
the machine to keep the board under the compression rollers to achieve the 
highest quality and to avoid problems with the project. 

 

When you load a project board and crank the machine down onto it, there are two 
compression rollers that engage the board and hold it into place.  These 2 rollers 
are what you want to stay underneath.  This means when the board is moving back 
and forth creating your project the board is always held down by both rollers.  
When a board comes out from under one of the rollers, the board will slightly “pop 
up” on the end that is no longer held down.  This can result in several issues; the 
board can come off the board tracking sensor creating a mis-measurement or 
error, it can cause an unsightly “snipe”; or a change in elevation of the carving; or, 
in the case of cutouts, the added stress this can put on the cutting bit can cause 
the bit to break. 

 

THE & INCH 
RULE 

FIG 2.2.3 - Stay Under Rollers. This board is under only one roller. 

FIG 2.2.2 - 7 Inch Rule. A & B showing the extra 3 1/2 inches on both ends of the board 



 

47 | P a g e  
 

NOTE: If you don’t have the extra 7 inches and you select “YES” to stay under 
rollers, the machine will automatically shrink your project down to add the 3.5” 
to both ends.  Your project will then be squished down, so the machine can claim 
the 3.5” on each end. 

 

FOLLOW THESE STEPS TO MAKE SURE YOU ARE FOLLOWING THE 7” RULE. 

• Make absolutely sure that your real board size is AT LEAST 7" longer than 
the "virtual" or board in Designer. If your project in the software is 12” 
long, you need to load a 19” board into the machine.  

• When setting up the project at the machine, it is easiest to stay under 
rollers by choosing the “Centered on Length” option. If you ever see an 
option on your LCD display for "scale project” you need to review your 
board dimensions. This means the machine has measured your board to be 
smaller than what is needed.  Just remember, you don’t normally want the 
machine to resize your projects in any way at all. 

• If you follow these steps, you will know that your project board will always 
be long enough to stay under the rollers. Since you now know you have a 
long enough board, you can answer NO to stay under rollers and it will 
result in the same outcome as choosing YES. 

If you follow the setup instructions outlined above, you can be assured of success 
when carving/cutting your projects. Some may ask, “If I make my board 7” longer 
than my Designer board, won’t that be wasting some wood?”. Yes, 3.5” on each 
end of the board is not used and can go into your recycle pile. There are methods 
of “jigging” your project to eliminate this waste.  Several jigging methods are 
covered in this Tips & Tricks 
http://www.carvewright.com/assets/tips/CarveWrightTips_and_Tricks_Apr08.pdf. 
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CARVING A PROJECT 

 
Once your project is saved and uploaded to the memory card, the card can then be 
inserted into the machine and the machine turned on.  

ALWAYS HAVE THE MACHINE IN THE OFF POSITION WHEN INSERTING AND 
REMOVING THE MEMORY CARD.   

The projects on the cards are accessed from the keypad. Simply press the ‘1’ 
(Projects) shortcut key to open the Projects Menu which can then be browsed 
using the up and down arrows. Once located, the desired project can be selected 
by pressing ENTER. Upon selection of a project from the project menu, the 
CarveWright will lead the user through the preparation process.  

Before starting, it is important to note the orientation of the project as viewed on 
the computer screen as compared to the orientation of the project as it is being 
carved on the machine. This is important in the event that a specific orientation or 
location of the project on the material is desired. If the project appears as in Figure 
2.3.1 on the computer screen it will be carved in the machine as seen in Figure 
2.3.2. Also, raster carvings will be completed from the front to the back of the 
machine beginning at the Starting Corner. In the case of Figure 2.3.2 the “P” will be 
carved first and the “T” last. 

 
 
 
 
 

 

SELECT YOUR 
PROJECT 

PROJECT 
ORIENTATION 

Figure 2.3.1 Orientation Of The 
Project On The Computer Screen Figure 2.3.2 Orientation Of  

The Project In The Machine 
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PROPER INSTALLATION OF THE WORKPIECE IS CRITICAL TO THE PERFORMANCE 
AND CONTINUED OPERATION OF THE MACHINE.  

Press down on the sliding guide plate release lever and move the sliding guide 
plate to the right so that it will clear the width of the workpiece. 

Check the bottom of the workpiece for features that will make it unusable in the 
machine. The bottom surface of the workpiece where it contacts the squaring 
plate must be flat and level for a width of at least 3/8ths inches along the bottom 
edge to allow the Board Tracking Sensor to accurately calculate the position of the 
workpiece at all times (see Figure 2.3.3).  

If a workpiece does not have the required surface available for the sensor to follow 
(e.g., if it is already carved on the back), it will be necessary to fasten the 
workpiece to a sled or carrier jig to do further work on it. If a workpiece is slightly 
cupped or bowed, the workpiece should be inserted with the cup or bow facing 
down. (See Section 2.2: Board Preparation for details on proper board preparation) 

 

 

Lay the workpiece on the traction drive so that it is centered lengthwise under the 
head. 

Push the board firmly up against the squaring plate. 

INSERT 
WORKPIECE 

Figure 2.3.3 Workpiece Insertion Details 
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Gently push the sliding plate up against the inside edge of the workpiece. DO NOT 
push the sliding plate against the workpiece with significant force. The sliding plate 
is used to guide the workpiece and is not intended to lock the piece in position. 

At this point it is critical to assure that the workpiece can travel freely in and out of 
the machine along its entire length without binding or encountering significant 
drag. Do this by moving the workpiece in and out of the machine by hand while it 
is lying flat on the traction drive. 
 
WARNING: Do not attempt to load a workpiece that has a significant taper to the 
sides. A tapered workpiece will bind between the sliding plate and the squaring 
plate and will damage the traction drive. 
 
WARNING: Do not attempt to load a workpiece that varies in thickness by more 
than 1/16” along its entire length. Using a workpiece with a larger thickness 
variation than 1/16” can lead to damage to the machine. 

Next, lower the head by turning the head crank handle counterclockwise. Once the 
correct pressure loading of the head is reached the clutch will begin to ratchet 
(causing a clicking sound). It is recommended that the crank be rotated at least 
two full revolutions once the clicking sound is heard to assure full loading. 
 
The clutch is intended to load the board against the traction drive with consistent 
force. In certain cases the machine can sense if the workpiece is not loaded 
enough and repeatably display Please Load Board on the LCD. Most often this 
decreased loading is caused by insufficient lubrication of the four vertical corner 
posts or the two vertical leadscrews. Please search for Checking Head Pressure in 
the troubleshooting section of our support site for the proper instructions on how 
to address this. http://support.carvewright.com/checking-the-head-pressure/  

Make sure that the top safety cover is closed before proceeding. 

Once the board is properly loaded, return the the keypad and LCD to continue the 
project setup.  The next question the machine will ask is to “Stay Under Rollers?” 
This question is covered in Section 2.2 Board Preparation. With a board, properly 
prepared following the 7 Inch rule, you can answer NO, as it will automatically stay 
under the rollers. 

The machine will then measure the workpiece. If the size of the inserted workpiece 
does not match the size of the designed project then the machine will prompt for 
additional information. The machine will ask different questions based on if the 
workpiece installed in the machine is larger or smaller than the project designed in 
the software. If the workpiece is smaller than the designed project, then the 
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options are: Scale the project to fit the workpiece or Load New Board. If the Scale 
option is selected then options Center On Board, Jog To Position, or Place On 
Corner are displayed in order to locate the project on the workpiece. 
 
WARNING: Be very careful when scaling down a project at the machine. The 
machine will scale the entire project to the largest size that will fit the inserted 
workpiece while maintaining the overall aspect ratio of height to width. It will not 
change the aspect ratio to fit that of the inserted workpiece. Scaling down can also 
lead to undesirable thinning of carved elements that may lead to chip out. 
 
If possible, measure the workpiece to carve before starting the project layout in 
the software. This will help guide the design and prevent unintended scaling issues 
if the project design is different than the available workpiece. Measuring it with 
the machine will be the most accurate way.If the inserted workpiece is larger than 
the project design then the available options are: Keep Original Size, Scale the 
project to fit the workpiece, or Load New Board. If Keep Original Size or Scale is 
selected then options Center On Board, Jog To Position, or Place On Corner are 
displayed in order to locate the project on the workpiece. 

Once all of the required data has been entered, the machine will prompt to insert 
the required bit. It will first ask to confirm the bit. Pressing ENTER will then move 
the cutting truck to the center of travel for easier access to the chuck. For projects 
that require more than one bit, the machine will prompt for each bit at this point 
and will store the calibration settings. The machine will locate the bit tip with its 
touch plate and will then locate the top surface of the board by touching the bit tip 
to the surface of the workpiece. 
 
If the workpiece chosen has existing carved features or defects that would prevent 
the bit from touching the top surface, it is possible to choose where the bit will 
touch when finding the board surface. To do this watch as the machine begins the 
operation to find the bit tip position. The message Finding Surface will be displayed 
on the LCD. Press the STOP key when this message appears. When prompted 
choose the Jog To Touch option. Use the arrow keys to move the bit tip to a 
suitable flat spot on the board and press ENTER to record position. The machine 
will remember this location and use it to locate the tips of all the bits used in the 
project. It is also possible to make "Jog To Touch" the default method by choosing 
this in the Configurations Menu. This option remains set only until the machine is 
powered off. 
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The machine will then proceed to carve the project. A real time carving completion 
estimator will be displayed on the LCD and provides an estimate as a percentage of 
how much of the current carving is completed.  

When the carving is completed, lift the top safety cover and crank the head up to 
free the workpiece. The workpiece can then be removed and examined. 

After removal from the machine, it is advisable to blow it free of dust with 
compressed air before proceeding to sanding with the Sanding Mops. 

 

For most projects arranged in the tutorials from this guide, the machine setup 
commands are as follows. These commands assume you have followed the steps 
for properly setting up your board as outlined earlier in this section. 

• Insert the memory card into the CarveWright CNC. 
• Turn the machine on and 1.Project Menu is automatically displayed. 
• Press enter to access the project list. 
• Scroll to the desired project and press enter. 
• Load the board and crank the head down. 
• Select NO to Stay Under Rollers and the machine proceeds to measure the 

width and the length. 
• The machine next asks Keep Original Size, press enter for yes. 
• Then press enter to select Center On Board. 
• Choose NO for Cut Board to Size. 
• The machine then prompts for the bit, press enter and the truck moves to 

the center for loading. Load the bit.  
• Once the bit is loaded, press enter and the machine will measure the bit on 

the touch plate and then find the board surface. 
• Last, the machine carves the project. 

 

 

 

 

 

 

 

QUICK PROJECT 
SETUP  
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CHAPTER 2 – CARVING SIGNS AND 

LITHOPHANES 
 
The two most common uses for the CarveWright CNC, especially for new users, is 
to make signs and lithopanes.  We all know what a sign is, but what is a lithopane?  
A lithopane is an image carved into a translucent 
material that can only be seen clearly when back lit 
with a light source.  Both signs and lithopanes are 
easy to make with the CarveWright System and in 
this section we will show you how. 

What’s in this Section? 

This section will cover using basic drawing tools, 
text, depth & height, bit optimization, textures, and 
import image. These procedures will cover Project 
Designer BASIC, Project Designer PRO, Centerline Text, and Conforming Vectors. 

TUTORIALS 
Live Laugh Love Sign – This project also covers fine tuning & optimization of your 
project with depth, height, feathering & draft; use of the text tool, drawing tools, 
regions, textures, & carving list; changing the board settings and selection of 
quality settings. 

Spring Blooms Sign – Expanding on the “My First Carve” project using more Project 
Designer features, including text, regions, and textures. 

Winter Snowflake – Project that continues to introduce more tools, including the 
basics of optimization including feather and draft. 

Martian Ray Gun – Martian Ray Gun sign project reinforcing the features learned 
from previous tutorials. 

House Number Sign – This project adds instruction in using drawing tools, grids & 
snap to grid; adding constraints; using Centerline Text (sold 
separately) and Conforming Vectors (sold separately), copy & paste, flip & rotate, 
creating a closed regions & staying under the rollers. 

Importing Images – There are several different image file types that can be used to 
import logos, clipart, photographs, scanned drawings, and more. This Design 
Project aims to assist you in overcoming some of the basic challenges. 
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OVERVIEW OF TEXT TOOLS 
 

The text tools are used to place text onto your project board.  This text can be 
manipulated and carved using a variety of Rout modes. The Text Tool uses 
whatever True Type Fonts (.ttf) you have located in your font folder.  The fonts are 
not coming from Designer. Remember one of your computers may not have the 
save fonts as your other computer.  There are many fonts available online, but 
they may not all be ideal to carve and too many fonts may slow down your 
software. 

 

Open Project Designer and click on New Project. 

 

Put in the dimensions of the Project board. This needs to be the finished size of 
your project. Do not include the 7 inch margin required by the machine. (more on 
the 7 inch rule later in this lesson)

TRUE TYPE 
FONTS 

USING THE TEXT 
TOOL 
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Select the Text tool from the tool bar at the top of the screen and click anywhere 
on the project board. 

This will open the Text Tool window. This window is slightly different in Designer 
Basic and Designer PRO.  

 

 

 

 

NOTE: The Centerline option under Rout Mode is only available in Demo mode, if 
the Centerline Text Add-On Module has not been purchased and activated. 
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Using this text window to type whatever is wanted to appear on the board. For 
this tutorial, we are going to write the word “RASTER”, choose “Times New 
Roman” in the font selector, select “Bold” as a style, and choose the Raster “Rout 
Mode”. Click “OK” to complete and then we’ll see the text displayed on the board. 

 

This text has all the features of a pattern and can be adjusted in size, position, and 
depth the same as any other pattern. Being in Raster mode, this text will be carved 
out as a raster, line by line, the same as the carved patterns. 

Select the Text Tool again and click on the board to open it again. The Text tool will 
remember the font settings we used before, but this time we will write the word 
“OUTLINE”, and choose the outline “Rout Mode”. 

 

 

 

 

 

 

 

 

 

Click ok and this will display on the board. 
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The outlined text appears with a v-grooved outline around the text. This will be cut 
with a 90 degree V- bit by default as a vector function.  As a vector cut, the V-bit 
will trace around the letters rather than carving line by line like the raster. 

 

 

 

 

 

 

 

 

 

Select the Text Tool again and click on the board to open it again. Now we will 
write the word “CENTERLINE”, choose the Centerline “Rout Mode”, and click OK.  If 
you have not purchased and activated Centerline Text, this will be working in 
DEMO mode and will not be able to be carved. 

 

Centerline Text is an algorithm that calculates the centerline of the font and 
calculates the depth based on the width of those lines. It defaults to using a 90 
degree v-bit and will carve the letters as a vector path. You can change this to the 
60 degree v-bit using the Select Bit icon. 
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Since the depth of Centerline text is determined by the variations in width of the 
font, you cannot change the depth, except by changing the size.  Centerline is 
applied to the top surface of the board. If you wish to use Centerline within a 
carved region or on any surface below the top of the board, you will need the 
Conforming Vectors add-on. 

 

 

 

 

 

 

 

 

Now, double click on the word RASTER on your board.  This will open the Text Tool 
window again, allowing you to make edits to this piece of text.  Use the arc slider to 
curve the lettering, and try increasing the spacing.  Click ok, again, and the edited 
text will display with your new settings. 

Now that we are familiar with the text tools, you are ready to make a sign! 
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PROJECT OPTIMIZATION  
 
When creating projects in Project Designer, there are several steps necessary for 
optimizing the project for carving.  There are several tools used for this process, 
primarily they are: draft, feather, and bit optimization. 

 

Draft sets an angle from the outer top edge of raised carvings out to the base of 
the carving. It is  primarily used to reduce chip-out issues. There are 4 settings of 
draft to choose from for raster patterns or text. 

Draft None Removes any Draft settings 

 

Draft Small This sets a small angle to the outer top edge of raised 
carvings to reduce chip-out issues. 

 

Draft Medium This sets a medium angle to the outer top edge of raised 
carvings to reduce chip-out issues. 

 

Draft large This sets a large angle to the outer top edge of raised carvings 
to reduce chip-out issues. 

 

As an example, let’s create some raster text on a board and choose a font with thin 
lines. 

DRAFT 
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By default, the text has straight edges raising up from the 
base of the letter to the top surface. We call these straight 
edges “cliffs”.  The problem that can occur with these edges has to do with the 
taper of the carving bit that is used to carve these. This angle can carve away the 
top edge of the cliff when it is carving the bottom corner. (Figure 1) 

 

 

Figure 1: No Draft 
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Draft is used to add an angle to these outer edges to give clearance for the taper of 
the bit.  (figure 2) 

 

As an added benefit, the draft settings can also create 
a nice bevel to the outer edge that enhances the look of the design.  It’s not only 
functional, but it looks great too. 

 

Figure 2: Draft Small 
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This sets an angle projected up and out from the base of the patternʼs outer edge. 
Used for creating a transition from the top surface of the board to the base of the 
carving. There are four settings to choose from in Designer BASIC, and a custom 
setting in Designer PRO 

Feather None Removes any feather settings. 

 

Feather 1/8 This sets the degree of feathering to 1/8” 

 

Feather 1/4 This sets the degree of feathering to 1/4” 

 

Feather 1/2 This sets the degree of feathering to 1/2” 

 

Feather Custom (Designer PRO) This sets the degree of feathering to any 
dimension up to 1” 

 
Feathering can reduce wear on the machine and bits, by creating a smoother 
transition around carvings, especially for deep carvings. 

 

 

 
       

 
 
 
 
 
 

 
 
 
 
 
 
 

FEATHER 
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Feather – left to right = None, 1/8, 1/4, and 1/2" 
 
 
Flip Feather 
Carved regions, created with any of the drawing tools, can have their feathers 
either on the inside or outside of the line. The Flip Feather icon is only highlighted 
when a carved region is selected. 
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Sets the limit with which the bit carves into tight areas to preserve the top level 
detail. There are five settings to choose from optimizing your carvings. 

 

Bit Optimization: None Applies no bit optimization. 

 

Bit Optimization: Low Slightly, decreases the depth of the carve in tight areas. 

 

Bit Optimization: Medium Decreases the depth of the carve in tight areas at 
medium level. 

 

Bit Optimization: High Decreases the depth of the carve in tight areas at high level. 

 

Bit Optimization: Best Eliminates all top level detail thinning in tight carved areas. 

As an example lets import a photograph and place it on the board. Photographs 
are good example because of the large amount of individual pixels that can vary 
greatly in depth. Some of these pixels can be deep, but they are right next to high 
pixels, essentially creating a “hole”.  When the bit goes to carve this, it will cause a 
widening of that hole from the diameter of the bit. 

   

BIT 
OPTIMIZATION 
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FINE TUNING 
The adjustment of depth and height are essential tools for fine tuning your designs 
in Project Designer. These tools allow the creation of more intricate layering of 
patterns to create more visual interest in the design. 

 
Depth is describing the lowest level, or the base, of the carving, pattern or 
element.  Most patterns, when placed on the board, are set to be at 1/4” deep.  
With the depth tool, this depth can be changed to whatever depth desired within 
the limits of the bit. 

 
 
 

 
 
 
 

 

 

 

 

 

 

Below: Depth left to right .125”, .25” and .5” 

 

 

 

 

 

 

 

DEPTH 

Depth at .25” Depth at .5” 
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Height at 100 Height at 30 

This is a relative value of the height from the deepest part of the carving to the top 
of the board being used. It can be set from 0-999 with 999 being no material 
removed from the highest point of the element. It will default to 100, which is it’s 
original thickness. 

This basically means you can make a pattern taller or shallower within its set 
depth. The deeper the pattern is, the higher you can raise it since there is more 
distance to work with. 

 

 

Depth for each = .5”. (From left to right – height = 20, 50, 100, 999) 

 

 

HEIGHT 
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Depth and height when used together can create the effect of elements appearing 
to be behind or above other elements. 
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TUTORIALS 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
This project covers the following design concepts: 
 
Ø PATTERN PLACEMENT 
Ø PATTERN MANIPULATION 
Ø FINE TUNING 
Ø ADJUSTING DEPTH & HEIGHT 
Ø TEXT TOOL 
Ø DRAWING TOOLS 
Ø REGIONS 
Ø TEXTURES 
Ø CARVING OPTIMIZATION 
Ø FEATHERING 
Ø DRAFT  
Ø CARVING LIST 
Ø BOARD SETTINGS 
Ø MANAGING DATA 
Ø UPLOADING TO MEMORY CARD 
Ø QUALITY SETTINGS 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

LIVE LAUGH 
LOVE 
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INSTRUCTIONS: 
 

Ø STARTING THE SOFTWARE 
 

Open the CarveWright Designer 
Software 

 
The Welcome screen appears with 

project options.   
 

 
Select “New Project” 

 
 
 
 
 
 
 
 
 
 

Set your board piece dimensions.   
Length: 12” 

Width: 6”  
Thickness: .75”    

 
Click ok 

 
 
 
 
 
 
 
 
 

Ø MENUS, TOOLBARS OR 
MOUSE  
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Ø MANIPULATING THE 
WORKPIECE  

 
Board piece will display on screen 

in three dimensions. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 
 
 

Ø PATTERN PLACEMENT 
 

  Select the “pattern tool” to 
open the pattern library along the 

right side.  
 
 
 
 

Select “Grapes01” under “Fruits 
and Vegetables” in the Basic 

Library.  Click on board to place.  
 
 
 

Ø PATTERN MANIPULATION 
Use Red Nodes on the corner to 

Scale the pattern. 
 

Also, use the Green Node to 
Rotate the pattern 
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Ø PATTERN PLACEMENT & 
MANIPULATION 

 
Adding Additional Patterns 

 
Select “Vine04” under “Vines and 
Stems” in the Basic Library.  Drag 

and drop it onto the board. 
 

Rotate and scale to fit with other 
pattern.  

 
 

*****IMPORTANT***** 
Notice how the patterns overlap.  
The stem of the vine is surfacing 

through the grape pattern. 
 

Ø FINE TUNING 
 

To fix this we will adjust the depth 
and height.   

 
Ø ADJUSTING DEPTH 

Select grapes and change depth to 
“.125” or “1/8” inch. 

 
Change the vine depth to “.125 or 

1/8” inch.  This shallows the entire 
design for faster carving, but does 

not fix the overlap. 
 

Ø ADJUSTING HEIGHT 
 

Select the vine pattern and adjust 
the Height to “30”.  This lowers 

the overall thickness of the 
pattern. 

 
Notice the stem is gone. 
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Ø BOARD SETTINGS 
 

  Use “Toggle Texture” to 
remove wood grain for better 

viewing.   
 
 
 
 
 
 
 
 
 
 

 
Select “Vine06” from “Vines and 

Stems” in the Pattern Library and 
place onto board. 

 
 
 
 
 
 
 
 
 

Use the right-click button on the 
mouse to bring up menu of 

available options for that pattern. 
 
 
 
 

 
 Select “Flip & Rotate”- “Rotate 

Horizontally”. 
 

Scale pattern down and overlap 
with grapes. 
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Ø FINE TUNING 
Ø ADJUSTING DEPTH & 

HEIGHT 
 

Like other patterns, change the 
Depth to “.125” or “1/8” inch.   

 
Change the Height to “30” to 

match other vine pattern. 
 
 
 
 
 

ü TEXT TOOL 
 

 
Next, select the “Text Tool” and 

click on board. 
 

Text dialog box will appear. 
 

  Select from any of the true type 
fonts that you have on your 

computer. 
 

Type the word “Live” 
 

Select “Raster” from one of the 
available Rout Modes. 

 
Notice the other options available 

from “Text Tool”. 
 
 
 

Manipulate the size and 
placement of the word, just as you 
would a pattern by scaling up and 

overlapping with the vine. 
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Right Click on “Live” and select 
“Copy”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on board, right click and 

select “Paste”. 
 
 
 
 
 
 
 
 
 

The word “Live” will appear again 
on the board.  Double click on 

word. 
 
 

Text dialog box will reopen. 
 

Change the word to “Laugh” and 
click “OK”. 
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The word “Laugh” will appear on 
the board the same size as “Love”. 

 
 
 

Move to place as shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click an open area of the board to 
unselect “Laugh”. 

 

 
Right click and select “Paste” 

again. 
 
 
 
 
 
 

The word “Live” from the 
clipboard will appear on the board 

again. 
 
 
 

Double click the word. 
 

When the Text dialog box appears, 
change word to “Love”. 

 
Move to place as shown. 

 
Click “OK”. 
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Right click on an open area of the 
board and choose “Select All”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice the yellow dotted line 
around all patterns. 

 
This allows you to move 

everything together. 
 
 
 
 
 
 
 
 
 
 
 

Adjust the patterns so they are 
better centered on the board. 
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ü DRAWING TOOLS 
 

 
Select the “Rectangle Tool”. 

 
 

Draw Rectangle across the entire 
board, leaving a border as shown. 

 
 
 
 
 
 
 

ü REGIONS 
 

 
Select “Carve Region”. 

 
This applies a carved area to the 

rectangle with a default depth of 
.25”. 

 
 
 
 
 
 
 
 
 
 
 

Ø FINE TUNING 
Ø ADJUSTING DEPTH  

 
Change the Depth to “.125” to 

shallow this region to match the 
rest of the carvings. 
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Right click and select “Center 

Both”. 
 
 
 
 
 
 
 
 
 
 
 
 

Ø TEXTURE 
 

 
Click on “Select Texture”. 

 
 

Texture dialog box appears 
displaying a variety of available 

textures. 
 

Select “Checkering 2” and leave 
the interval at 1”. 

 
 
 
 
 
 

Texture appears in the rectangular 
region, but is overtaking parts of 

the design. 
 
 
 
 
 
 
 
 
 

 

 

 
 
 



 

80 | P a g e  
 

Ø FINE TUNING 
Ø ADJUSTING HEIGHT 

 
Correct this by adjusting the 
Height to “20”.  This sets the 

texture back enough to be more 
subtle. 

 
 
 
 
 
 
 
 
 
 

Ø MANIPULATING THE 
WORKPIECE  

 
 

 
Rotate and/or zoom your 

workpiece to see your design 
board more clearly. 

 
 
 
 
 
 
 

Ø CARVING OPTIMIZATION 
 
 

Ø FEATHERING 
 
 

 
With the rectangular region 

selected, click on the “Feather 
Tool”. 

 
From the drop down menu, select 

“Feathering ½ inch”. 
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Adding a feathered edge applies 
an internal bevel to the region.   

 
It helps to eliminate a straight up 

and down edge referred to as a 
“cliff edge”. 

 
 
 
 
 
 
 
 
 
 

Ø CARVING LIST 
 
 

 
Select “View” and then “Carving 

List” 
 

The Carving List opens on the left 
displaying every element on the 

virtual design board. 
 
 
 
 

These elements can be rearranged 
or selected in a variety of ways. 

 
 
 
 

Select the 3 text files by holding 
down the shift button and clicking 

on each of them. 
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Ø CARVING OPTIMIZATION 
 
 

Ø DRAFT 
 

 
Select the “Draft Tool” and choose 

“Draft Large”. 

 
 

This puts a bevel on the edge of 
the letters removing cliff edge. 

 
 

Ø FEATHERING 
 

 
Select the “Feather Tool” button 
again.  This time select “Feather 

None”. 
 
 

This removes the feather from the 
letters. 

 
 
 
 
 

Select the 3 patterns from the 
Carving List. 

 
 

 
Select “Draft” and choose “Draft 

Medium”. 

 
 
 

This slight bevel to the patterns 
aids in the removal of cliff edge. 
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Now select each element and 
adjust their placement until the 

design arrangement is 
satisfactory. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Toggle the Texture back on to see 
the design with wood grain again. 

 
 
 
 
 
 
 
 

Ø BOARD SETTINGS 
 

 
Select “Edit” then “Board Settings” 

to open the board setting dialog 
box. 
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In the Board dialog box choose the 
Stain/Finish tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the wood type to 
“Mahogany” and the finish to 

“High Gloss”. 
Click “OK”. 

 
 
 
 
 
 
 
 
 
 
 

The board’s appearance changes 
to look like a finished board.   

 
 

 
Rotate to view it at different 

angles. 
 
 

 

 

 
 
 



 

85 | P a g e  
 

 
Select “File”, “Save”  

 
*****IMPORTANT***** 

Name file and click “Save” to hard 
drive. 

 
 
 
 
 
 
 
 
 
 

Ø UPLOADING TO MEMORY 
CARD 

 
 

 
Select “File”, “Upload” 

 
 
 
 
 
 
 
 
 
 

Ø QUALITY SETTINGS 
 

Flash Manager dialog box appears.  
Set your quality setting to Best, 

Normal and then Draft to see how 
the estimated time to carve 

changes. 
  

Save to memory card. 
 

Example: 
livelaughlove_N_27 

(recognizable name_quality 
setting_estimated time to carve) 

 

 

 
 



 

86 | P a g e  
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
This project covers the following design concepts: 
 
ü OPEN PROJECT OR LAST PROJECT 
ü DRAWING TOOLS 
ü CENTERING 
ü CARVE REGION 
ü FEATHERING 
ü TEXTURES 
ü FINE TUNING 
ü ADJUSTING HEIGHT 
ü PATTERN PLACEMENT 
ü TEXT TOOL 
ü ADJUSTING DEPTH 
ü USING DRAFT 
ü BOARD SETTINGS 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 

 
 
 
 
 
 
 
 
 

SPRING BLOOM 
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INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project 
Designer Software 
  
The Welcome screen appears with 
project options. 
 
Select “Last Project” or “Open 
Project” (if you have done something 
else, since Project 1-12 “My First 
Sign”). 
 
 

ü DRAWING TOOLS 
 

 
Select the “Rectangle” tool. 
 
Click in top left corner and drag to 
subscribe rectangle area around the 
flower. 
 
Set the “Size” to 6” x 6” and hit Enter to 
apply. 
 
 
You could have also used the square tool 
for this. 
 
ü CENTERING 

 
With the rectangle selected, right‐click to 
bring up menu of available options. 
 
Select “Center” > “Center Both” 
 
 
ü CARVE REGION 
Click on the “Carve Region” icon. 
 
 This creates a carved out region inside 
the boundary. Automatically defaults to 
.250” depth.  Remember depth of pattern 
& how depth effects carve time. 
 
ü FEATHERING 
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Click on “Feather” dropdown tool and 
select ¼” feather. 
 
Select “Accept”. 
 
 
 
 
This produces a ramped area and allows 
you to avoid “cliffs” while using a 
tapered bit. 
 
 
 
 
ü TEXTURES 

 
Select “Texture” tool.  
 
Texture dialog box appears displaying a 
variety of available textures. 
 
Select “Vertical Wave” and leave the 
interval at 1” 
 
Texture appears in the rectangular 
region, but is overtaking parts of the 
design. 
 
 

 
 
ü ADJUSTING HEIGHT 
 
 
 
Correct this by adjusting the Height of 
the texture to “20”.   
 
This sets the height low enough to not 
overpower the foreground objects. 
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ü PATTERN PLACEMENT 
 

Open Pattern Library and click: 
  
+ sign to open Favorites then  
+ sign to open Seasons then  
+ sign to open Spring pattern folder.   
 
 
 
 
 
 
 
 
 
 
 
 
Select “Grass” pattern and place onto 
board as shown. 
 
 
 
 
 
 
 
 
 
 
ü CENTERING 
 
Right-click to see available options and 
select Center > Horizontally. 
 
 
 
 
 
ü ADJUSTING HEIGHT 
 
Change Height of grass to 30. 
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ü FEATHERING 
Change Feathering to None. 
 
 
 
Make necessary adjustments to leaves or 
grass. 
 
 
ü TEXT TOOL 
 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Select from 
any of the true type fonts that you have 
on your computer.  Some work better 
than others. 
 
Type the word “Spring” 
 
Select “Raster” from one of the available 
Rout Modes. 
 
Notice the other options available from 
“Text Tool”. 
 
ü FINE TUNING  
 
Manipulate the size and placement of the 
word, just as you would a pattern by 
scaling to size. 
 

ü CENTERING 
 
Right-click to see available options and 
select Center > Horizontally. 
 
ü ADJUST DEPTH 

 
Set depth to .25” 
ü ADD DRAFT 
 
Select “Draft” drop-down menu and 
change to Medium. 
 
Draft gives a ramped area for the carving 
bit and avoids “cliffs” that may lead to 
chip out.  Reducing the Height of the text 
may also help. 
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ü BOARD SETTINGS 
 
Use “Toggle Texture” to remove wood 
grain for better viewing. 
 
 

 
Rotate or zoom in on your project to view 
it from different angles and make any 
necessary adjustments. 
 
 
 
 
 
 
 
ü MANAGING DATA 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory 
card, it cannot be brought back from the 
memory card into the software.  Always 
SAVE YOUR PROJECT on your hard drive.  A 
Projects folder is recommended and you 
should know where you saved it. 
 
 
 
 
 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card 
 & Programmer are properly attached via 
your USB port, Select “File” > “Upload” to 
save to your memory card. 
 
Select Quality Setting  
 
Ø DRAFT 
Ø NORMAL 
Ø BEST 
Ø OPTIMUM 
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These settings determine the number of 
passes the machine makes to carve your 
project.  The more lines the better the 
surface  finish.  Make your decision based 
on material type, fondness of sanding vs. 
machine time, & test carve vs. final.  Notice 
the estimated carving time differs by 
quality setting. 

 
Name Your Project  
 
Example: 
springbloom_N_45m 
(recognizable name_quality 
setting_estimated time to carve) 
 
Click “Upload” 

 
NOTE: Actual board to be placed in machine should be 7” longer or you should use a sled that has 3.5 extra inches on 
each end to STAY UNDER THE ROLLERS. 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü MANIPULATING THE WORKPIECE 
ü SNAP TO GRID 
ü DRAWING TOOLS 
ü CARVE REGION 
ü FEATHERING 
ü PATTERN PLACEMENT 
ü ROTATE ELEMENT 
ü COPY & PASTE 
ü ADJUSTING HEIGHT 
ü TEXT TOOL 
ü FINE TUNING 
ü ADJUSTING DEPTH 
ü TEXTURE 
ü BOARD SETTINGS 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 

 
 

 
 
 
 
 
 
 
 
 

WINTER 
SNOWFLAKE 
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INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project 
Designer Software 
 
The Welcome screen appears with 
project options.   
 

 
Select “New Project” 
 
 
 
 
Set your project board dimensions.   
Length: 7” 
Width: 7”  
Thickness: .75”    
 
Click OK 
 
 
The project board size is not necessarily 
the actual size of the board being put 
into machine. 
  
 
 
 
 

ü MENUS, TOOLBARS, SHORTCUT 
KEYS OR MOUSE BUTTONS 

 
For every software function, we 
provide you three distinct ways to 
access that function.  They are usually 
menu, icon or right-click. Some 
common functions, such as Copy and 
Paste, also use shortcut keys.  These 
will also work in Project Designer. 
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ü MANIPULATING THE WORKPIECE  
 

Board piece will display on screen in three 
dimensions.  You can use these tools to 
get a different view of your project board. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 

 
 
ü SNAP TO GRID 
 
Under LAYOUT menu, select SNAP. 
 
 
 
 
 
 
 
 
 
 
 
 
Snap Interval should be .5 inch interval by default. 
 
Check boxes: 
• Snap to grid 
• Snap to edges 
• View grid 
• View Bezier Control Points (should already be 

selected as default) 
 

Click ok 
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ü DRAWING TOOLS 
 
Using the grid, draw a box or rectangle .5” 
inside the project board, which should 
give you a box that is 6” x 6”.  
 
Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
 
 
 
 
 
 
 
 
ü CARVE REGION  
 
Select “Carve Region” icon. 
 
 
This creates a carved out region inside the 
boundary. Automatically defaults to .250” 
depth.  Remember depth of pattern & how 
depth effects carve time. 
 
 
 
 
 

 
 
 
ü FEATHERING 
 
Select the drop-down Feather menu and 
select ¼” feather. 
 
Select “Accept” 
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ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
Select “snowflake” under “Season Patterns” 
in your Favorites library from the winter 
folder. 
 
Click once on pattern and once on board to 
place or click and drag to the board. 
 
Double-clicking will attempt to open it in 
Pattern Editor Software. 
 
 
 
Set depth of snowflake to .250”. 
 
 
 
 
 
 
 
 
 
 
 
ü ROTATE ELEMENT 

 
Click on the green knob of the 
“Rotate” bar in the center of the element. 
 
Rotate snowflake.   
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ü PATTERN MANIPULATION 
 
 
Use Red Nodes on the corner to Scale the 
element larger or smaller.   
 
Yellow nodes will stretch or skew the 
element. 
 
 
 
 
 
ü SNAP TO GRID 
 
Click “Toggle Snap to Grid” icon to turn grid 
OFF. 
 
 
 
ü COPY & PASTE 
 
With the snowflake selected, right-click and 
select copy. 
 
Right-click again and select paste. 
 
 
 
 
 
 
 
ü PATTERN MANIPULATION 

 
Use Red Nodes on the corner to Scale the 
element smaller.   
 
Use Rotate knob to rotate the 
pattern. 
 
ü ADJUSTING HEIGHT 
 
Set the Height to .50. 
 
Adjusting height is useful in making the 
same elements look like they are behind or 
in front of other objects.  
 
 
 



 

99 | P a g e  
 

ü COPY & PASTE 
 
Right-click again and select “Paste”. 
 
Since the last thing you copied was the 
snowflake, you do not need to copy it, 
again.  It is still on your “Clipboard”. 
 
 
 
ü PATTERN MANIPULATION 
 Manipulate the pattern, again, 
changing the rotation & size of it until 
you have it arranged as you would like. 
 
ü TEXT TOOL 

 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Select from 
any of the true type fonts that you have 
on your computer.  Some work better 
than others. 
 
Type the word “Winter” 
 
Select “Raster” from one of the 
available Rout Modes. 
 
Notice the other options available from 
“Text Tool”. 
 
ü FINE TUNING  
 
Manipulate the size and placement of 
the word, just as you would a pattern by 
scaling to size. 
 
ü CENTERING 
 
Right-click to see available options and 
select Center > Horizontally. 
 
ü ADJUST DEPTH 
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ü TEXTURES 
 

Select “Texture” tool.  
 
Texture dialog box appears displaying a 
variety of available textures. 
 
Select “Peaks” and leave the interval at 
1” 
 
Click OK. 
 
 
 
 
Texture appears in the rectangular 
region, but is overtaking parts of the 
design. 
 
ü ADJUSTING HEIGHT 

 
Correct this by adjusting the Height to 
“10”.   
 
This sets the height low enough to not 
overpower the foreground objects. 
 
 
 
 
ü BOARD SETTINGS 
 
Go to View > Toggle Texture to remove 
wood grain for better viewing. 
 
Also look at View > Board Settings > 
Stain/Finish to see how you can change 
the Wood Type/Stain or Wood Finish.  
This is a great way to present a proposal 
to a potential customer. 
 

 
Rotate or zoom in on your project to 
view it from different angles and make 
any necessary adjustments. 
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REMEMBER THESE FUNCTIONS FROM PREVIOUS STEP-BY-STEP PROJECTS 
 
 
ü MANAGING DATA 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card 
 & Programmer are properly attached via your USB port, Select “File” > “Upload” to save to your memory card. 
 
Select Quality Setting  
 
Ø DRAFT 
Ø NORMAL 
Ø BEST 
Ø OPTIMUM 

 
These settings determine the number of passes the machine makes to carve your project.  The more lines the better the 
surface  finish.  Make your decision based on material type, fondness of sanding vs. machine time, & test carve vs. final.  
Notice the estimated carving time differs by quality setting. 

 
Name Your Project  
 
Example: 
winterflake_B_1h45m 
(recognizable name_quality setting_estimated time to carve) 
 
Click “Upload” 

 
NOTE: Actual board to be placed in machine should be 7” longer or you should use a sled that has 3.5 extra inches on 
each end to STAY UNDER THE ROLLERS. 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü DRAWING TOOLS 
ü CENTERING TOOLS 
ü CARVE REGION 
ü PATTERN PLACEMENT 
ü CREATING A RAISED REGION 
ü CHANGE DISPLAY 
ü TEXT TOOL 
ü USING THE CARVING LIST 
ü CREATING A TEXTURE 
ü GROUP PATTERNS 
ü MANAGING DATA 
 

 
 
 
 
 
 
 
 
 
 
 

MARTIAN RAY GUN 
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INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project Designer 
Software 
 
The Welcome screen appears with 
project options.   
 

 
Select “New Project” 
 
 
 
 
Set your project board dimensions.   
Length: 15” 
Width: 10”  
Thickness: 0.75”    
 
Click OK 
 
 
The project board size is not necessarily the 
actual size of the board being put into 
machine for carving. 
  
 
 
 
 
 
 
ü MENUS, TOOLBARS, SHORTCUT KEYS 

OR MOUSE BUTTONS 
 
For every software function, we provide 
you three distinct ways to access that 
function.  They are usually menu, icon or 
right-click. Some common functions, such 
as Copy and Paste, also use shortcut keys.  
These will also work in Project Designer. 
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ü DRAWING TOOLS 
 
Using the rectangle tool create a box on 
the front face of the work piece.  
 
Resize the box to be 12” long and 7” tall 
using the Sizing box found on the toolbar. 
 
 
 
 
 
 
 
 

 
 
ü CENTERING TOOLS 
 
With the rectangle selected, right‐click to 
bring up menu of available options. 
 
Select “Center” > “Center Both” 
 
 
 
 
 
 
 
 
 
 
ü CARVE REGION  
 
Select “Carve Region” icon. 
 
 
This creates a carved out region inside the 
boundary. Automatically defaults to .250” 
depth.  Remember depth of pattern & how 
depth effects carve time. 
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ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
Select “Raygun” under “RaygunProject” 
folder in your Favorites. 
 
Click once on pattern and once on board to 
place or click and drag to the board. 
 
Double-clicking will attempt to open it in 
Pattern Editor Software. 
 
Place the Raygun pattern onto the board 

 

With the Raygun pattern still highlighted, change its length dimension to 9”, set its height to 999, and set the depth to 
.25”.  All of these variables can be found in the size box on the top toolbars. 

 
 

 

Click on the “Atom Logo” in the pattern 
library and place it on the board in front of 
the Raygun 

Set its depth to .25” 

 
Rotate the Raygun pattern slightly.  You 
can do this by using grabbing and dragging 
the center green handle  

 

OR by inputting an angle in the Angle Input 
Box on the toolbar. 
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ü CREATING A RAISED REGION 
 
With the connected line tool, draw a 
tapered shape coming from the Raygun to 
the Atom logo.  
 
 
 
 
 
 
 
 
 
 

 
ü CARVE REGION  
 
Select “Carve Region” icon and set the 
depth to .2”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
ü CHANGE DISPLAY 
 
Using the icons in the view toolbar, toggle 
texture off, toggle grid on, and toggle the 
snap to grid. 
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ü CREATING A RAISED REGION 
 
Select connected line tool again and draw 
starburst shape centered to the lower left.  
 
 
 
 
 
 
 
 
 
 
 

 
ü CARVE REGION  
 
Select “Carve Region” icon and set the 
depth of the starburst to .23”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
ü TEXT TOOL 
 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Choose your 
font and type the name of your Raygun 
and click on OK (We call ours 
MAAARAUDER and use a font called 
Bend2Squares downloaded for free from 
urbanfonts.com) 
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Select “Raster” from one of the available 
Rout Modes. 
 
Scale the text and position it on the board. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add more text where desired using the 
above steps. (The other font used is 
Neuropol and was free at dafont.com) 
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ü USING THE CARVING LIST 
Now with all your text placed, open the 
caving list by selecting the “carving list” 
icon on the toolbar. 
 
 
 
From the carving list, select all of the text 
elements.   

Set their depth to .25” and the height to 
50. 

 
 
 
 
 
Set the draft of the text to medium using 
the “Draft” icon found on the toolbar. 

 
 
 
 
 
 
 
 
 
 
 
 
ü CREATING A TEXTURE  
 
Select the background region that you 
created earlier and select the “texture” 
icon from the toolbar 
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The Texture dialog box appears displaying a variety of 
available textures. 
 
Select the Vertical Waves texture and set the interval to 
.25” 

Click OK. 
 
 
 
 
 
 
 
 
 
 
 
The texture appears in the rectangular 
region, but is overtaking parts of the 
design. 
 
Correct this by adjusting the Height to 
“10”. 
 
 
 
This sets the height low enough to not 
overpower the foreground objects. 
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ü GROUP PATTERNS  
 
In the carving list select everything that is in it and select the group button at the bottom of the 
list. 
 
 
 
 
 
 

 
 
 
 
 
ü MANAGING DATA 
 
Save the project as Raygun box lid and 
we'll revisit it in a later project. 

Select “File” > “Save” 
 
 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory 
card, it cannot be brought back from the 
memory card into the software.  Always 
SAVE YOUR PROJECT on your hard drive.  
A Projects folder is recommended and 
you should know where you saved it. 
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This project covers the following design concepts: 
 
Ø DRAWING TOOLS 
Ø SNAP TO GRID 
Ø SETTING CONSTRAINTS 
Ø CUT PATH TOOL 
Ø CENTERLINE TEXT  
Ø COPY & PASTE 
Ø FLIP & ROTATE 
Ø CREATING A CLOSED REGION 
Ø MANAGING DATA 
Ø STAYING UNDER ROLLERS 
Ø UPLOADING TO MEMORY CARD 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

INSTRUCTIONS: 

HOUSE NUMBER SIGN 
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Ø STARTING THE SOFTWARE 

 
Open the CarveWright Designer 

Software 
 

The Welcome screen appears with 
project options.   

 

 
Select “New Project” 

 
 
 
 

Set your board piece dimensions.   
Length: 12” 
Width: 5.5”  

Thickness: .75”    
 

Click ok 
 
 
 
 
 
 
 

Ø BOARD SETTINGS 
 

  Use “Toggle Texture” to 
remove wood grain for better 

viewing.   
 
 
 

Ø SNAP TO GRID 
 

Go to the menu bar and click 
“Layout” then select “Snap…” 
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From the “Snap to Grid” dialog 
box change the “Snap Interval” to 

“.025”. 
 

Check Snap Objects to Grid; Snap 
Objects to Edges; View Grid & 

Center Grid 
 

Click “OK” 
 
 
 
 
 
 
 
 
 
 

On your work piece you should 
now see a set of grid lines. 

 
 
 
 
 
 
 
 

ü DRAWING TOOLS 
 

 
Select the “Line Segment Tool”. 

Draw a horizontal line on the 
board on the second gridline from 
the top.  The vertical green arrow 

shows the distance from the 
element to the top (or edge) of 

the board.  Move the element or 
change the number to”0.5”.  
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ü CONSTRAINTS 
 

In the “Length” box or with the 
Blue Number type “8.0” and press 

Enter. 
 
 
 
 
 
 

ü DRAWING TOOLS 

    
Click on the “Circle Drawing Tool” 

drop down menu and select the 
“Arc Tool”.   

 
With your mouse pointer place 

your cursor over the left red node 
on your horizontal line.  

 
 When done correctly it should 

give you a visual notification that 
you are connecting the two 

drawing methods.  
 

 When you see the connected 
notification, left click once.  Now 

count two grid lines to the left and 
two grid lines down and left click 

once. 
 

At this point, we will not set the 
arc radius. 

 

 
Select the “Arc Tool” 

again.  Do the same to the 
right side of the line 

segment. 
Your shape should look 

like the top part of a 
trapezoid. 
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Right click on the line and select 
“Center”, “Center Horizontally” 

 
 
 
 
 
 
 
 
 
 
 
 
 

ü COPY & PASTE 
 

Select the line segment that was 
just created.  Copy it and then 

paste. 

 

 

 

 

   

ü FLIP & ROTATE 

With only the pasted line segment 
selected, Right click and select 

“Flip & Rotate”, “Flip Vertically”.  
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Now move the copied line to the 
second grid line from the bottom.   

 
There should be two line 

segments in the Carving Tree. 
 
 
 
 
 

ü CONSTRAINTS 
Constraints are given to guarantee 

a uniform project layout.   
 

On both line segments, set the 
Constraints for Center of the 

Board and Edge of the Board to 
“0.0”.  

 
NOTE:  Changing the number 

applies a “Constraint” and the 
number indicates this by turning 

yellow. 
 

Note: To remove or edit a 
constraint, right click on the 
number and select remove. 

 
 

 
Select the Arc Tool and connect to 

each red node on the left side of 
the work piece. 

Note: If connection is successful, 
the Carving Tree will show only 

one Line Segment. 
 
 

Repeat prior action with the right 
side of the design project. 
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ü CREATING A CLOSED 
REGION 

 
The shape should now be 

completely connected (“closed 
region”). 

   
ü CUT PATH TOOL 

 
Note: Region is not fully 

connected, if “Cut Path” option is 
not available when the element is 

selected. 
 

Check each red node to make sure 
they are fully connected. 

 

 
Go to View and select “Toggle Grid 

Lines” 
 
 
 
 
 

ü SETTING CONSTRAINTS 
 

Start with the upper left arc.  Left 
click the green node and drag it 

toward the upper left of the 
board.  Depending on how far you 
dragged your arc, your radius (R=) 

will vary. 
 

  Left click on your radius (R=#) 
and a box will open where you can 
constrain your radius.  Type “.8” in 

the box and press Enter. 
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Repeat this step to constrain the 
three remaining corners to “.8”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

To change the radius on the 
vertical arcs, Left click and drag 

the left green node to the edge of 
the board.  Once you have an arc 
left click on the radius (R=#) and 

change it to “1.95”. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Repeat this step to constrain the 
other vertical arc to “1.95”. 
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ü CUT PATH TOOL 
 

 
Select the “Cut Path Tool”. 

 
  In the “Cut-Out Control” select 

“Flip Cut”, “Hide Cut-Out” and 
“Accept”. 

 
“Flip Cut” changes the cut path 

from the inside of the vector line 
to the outside of the line.  When 
cutting out carved patterns, the 

outside is preferred for better 
results. 

 
 

ü TEXT TOOL 
 

 
 

Select the “Text Tool”.   

Click anywhere on the board. 

Select the following options: 

Font = “Century” 
Justification = “Center” 

Text = (Your house number) 
Rout Mode = “Centerline” 

 
Select “OK”  

Right click on the newly added 
text and select “Center”, “Center 

Both”. 
 
 
 

To resize the address simply click 
and drag any of the red nodes. 
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Once the address is the size you 
like, save the project. 

 
Select “File”, “Save”  

 
*****IMPORTANT***** 

Name file and click “Save” to hard 
drive. 

 
Ø UPLOADING TO MEMORY 

CARD 
 

 
Select “File”, “Upload” 
Save to memory card. 

 
Ø STAYING UNDER ROLLERS 

Note:  The Auto-Jig option may 
appear when uploading to the 

memory card.  Auto-Jig scales a 
project according to a 

predetermined set of dimensions 
to avoid possible errors.  In this 
case the board we setup in the 

software is 12”. The actual piece 
that should be inserted into the 

machine needs to be at least 19” 
to stay under the rollers.  

Therefore, select “Ignore”. 

 
Example: 

streetnumbersign_N_13 
 

(recognizable name_quality 
setting_estimated time to carve) 
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IMPORTING IMAGES AND MAKING LITHOPANES 
Project Designer always comes with an import image function.  This importer, 
accessed from the file menu, allows the import of several bitmap, or raster, image 
type.  The file types that can be uploaded are the following: BMP, JPG, JPEP, PNG, 
MNG, GIF, XPM.  The most common of these formats used are the JPG and PNG 
formats, which are the standard image files found on the internet and produced by 
digital cameras.  

 

Images can vary greatly in resolution, so it is important to understand what it is in 
order to pick proper images for importing. Resolution in digital images is described 
by pixels. Raster, or bitmap, images are composed of rows and columns of 
individual squares referred to as pixels.  The size and number of these pixels 
determine the resolution. The rows and columns of pixels are described as width 
and height, and the size of the pixels is described as PPI (pixels per inch).  The 
higher number of pixels an image has, the higher resolution it is. It is important to 
use the highest resolution images you can for good quality carvings.  It is important 
to note that you cannot add pixels to an image to increase resolution.  An image 
can always be reduced, but never enlarged without losing image quality.  

For example; the CarveWright carves at a resolution of 128 ppi. So if I were to 
make an 8”x10” lithopane, I would need an image of 1024x1280 for the best 
quality carve. 

The next two tutorials in this section describe the process of importing images and 
making lithopanes. 

 

 

 

RESOLUTION 
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This project covers the following design concepts: 
 
ü IMPORT IMAGE 
ü SELECT CROP 
ü 3D VIEW 
ü CHANGING DEPTH 
ü LOWER TO REMOVE IMAGE BACKGROUND 
ü SAVE ITEM 

 
 
 
 
 
 
 
There are several different types of images that can be imported into the Designer 
software and made into patterns.  Besides various file formats, there are different 
types of images from logos to clipart to photographs to scanned drawings.  As 
unique and different as they may be, so too, are their challenges.   This Design 
Project aims to assist you in overcoming some of the basic challenges. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

IMPORTING IMAGES 
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The Designer software comes preloaded with over 50 quality patterns to use in your project designs.  There are 
also over 7,000 patterns available on the CW PatternDepot in virtually any subject imaginable.  Add to that the 
ability to import digital images and the possibilities with your CarveWright Designer Software become endless. 
 
BASIC IMAGE INFORMATION : 
 
A digital image is a numeric respresentation 
(normally binary) of a two-dimensional image.  
(Wikipedia)  
 
ü IMPORT IMAGE 
 
Open Designer Software. 
 
Go to “FILE > IMPORT > IMPORT IMAGE FILE”. 
 
Navigate to wherever your image is located on your 
computer. 
 
***IMAGE FILE TYPES & RESOLUTION*** 
 
The basic Designer Software can import various file types.   These file types are considered “raster” and are made up of 
pixels, rather than geometric shapes (vector). 
 
Ø .png  
Ø .jpg (.jpeg) 
Ø .bmp (bitmap) 
Ø .gif 
Ø .mng 
Ø .xpm 

 
Image resolution is the detail an image holds. There are 
several types of resolutions, but importing higher 
resolution images results in better quality patterns.   
 
Digital images come from a variety of sources.  Some of 
these may not be satisfactory to use or may require 
additional “clean-up” to be of usable quality.  
 
The Internet is a great source for variety, but remember, 
images on the internet are usually low resolution, so that 
they will load onto your computer screen faster.  Some 
digital photographs are very high resolution. Scanned photographs have other issues, such as low resolution flatbed 
scanners, poor quality image being scanned, debris on scanner or defects on image.  Scans of hand-drawn images also 
take into account how hard or lightly you are pressing down on the pencil.  
 
A high resolution logo from your customer is much better than a customer’s company logo pulled off of their website. 
 
Select the image you want to import. Click “Open”. 
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ü SELECT CROP 
 
During import image, you can crop your image. (Licensed patterns cannot be cropped in this method. For those we use 
the “clip carving” function.)  
 
To crop, hover over the dotted yellow line until you get the 
double ended arrow, then Click and Drag to frame the image, 
however you would like to crop that image.   
 
Converting a 2d image into 3d has presented itself as 
quite a challenge, and is almost impossible as there is 
simply not enough information in a flat 2d image to 
make it true 3d.  The Designer software gets you close by 
converting your 2d image into a grayscale and 
“assigning” a carving depth based on that grayscale. 
White gets the deepest carve and black the shallowest.  
There are 254 levels of gray inbetween that make up the 
detail.  This conversion takes place by clicking the NEXT 
button.  
 
Click “Next”. 
 
ü 3D VIEW 

 
There are several things you can do to manipulate your pattern at this point in the import process: 
 
Zoom & Rotate:  The Pattern View window that is the larger area on the right side will allow you to ZOOM or ROTATE the 
pattern to get a better view of it. 
 
Size:  The image width and height can be changed. The lock 
keeps the pattern in proper aspect without skewing it. 
 
Depth:  The depth is the size difference between white & 
black.  Default is always .25, but you may often want to 
narrow the difference for a smoother transitioning pattern by 
lowering the depth. 
 
Raise / Lower:  Raise moves the pattern up and eliminates the 
top layers (default is black).  X resets it to the original. Lower 
moves the pattern down and eliminates the bottom layers 
(default is white). 
 
Invert:  Changes the pattern to white on top and black on 
bottom. 
 
Floor Edges:  Floor edges should be left on to keep the edges 
all at the same depth for consistent feathering of the pattern. 
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This image technically should have two levels – white and black.  White is the deepest & black is the shallowest by default 
unless you selected Invert.  
 
ü CHANGING DEPTH 
 
Change depth to 0.1 or leave for thicker pattern.  
 
ü LOWER TO REMOVE IMAGE BACKGROUND  
 
Click the down arrow once to remove the white background.   
 
If it is not a pure white background, you may need to click 
several more times to get rid of most of the background that 
you do not want.  Pattern Editor (advanced software 
purchase required) may need to be used to clean up some 
patterns. 
 
Select “Finish”. 
 
ü SAVE ITEM 
 
Select the location in your Pattern Library Favorites folder (or create a New Category), where you want to save your new 
pattern.   
 
Name the pattern. 
 
Select “Save”. 
 
Now you can use the new pattern in your projects or use the shape of it to make cut-outs.  
 
EXPERIMENT TO FIND A PATTERN THAT WORKS: 
 
 

This is the image with multiple  
 

layers of gray. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is the pattern imported with NO manipulation. 
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This is the same pattern viewed from the side. (EEK!) 
 

 
 
 
 

 
 
 
 

 
This is the pattern after being manipulated. 

 
 
 

 
 
 

Here is another option. 
 
 
 
 
 
Other manipulation can be done using advanced 
software such as Pattern Editor, 2d Vector Drawing 
Tools & 3d Pattern Modeling. 
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CREATING A LITHOPANE 
Adopted from Tips & Tricks article; Lithopane 101 by Jason Allen and edited by 
CarveBuddy 
 
History: Originally Lithopanes (lithophanes) were made as a part of a piece 
of porcelain, typically the bottom of a cup or mug so the user would see the 
image when the cup was empty. 
 
It was created as a wax original by an artist who carved the wax to create 
thin and thick areas that would represent light and dark areas. This wax 
original went through several steps to end up as a part of the piece of 
porcelain.  
 
Our modern Lithopanes are made using editing software and carving or 
CNC machines. The lithopane itself is carved from a sheet of translucent 
material (usually ¼ of an inch thick). The carving creates the light and dark 
areas due to the variations in thickness. By carving away the material, an 
image can be formed that is visible when lighted from behind. 
 
Like a stained glass window, a Lithopane needs to be illuminated from 
behind to reveal the image. Illumination may be provided by an 
incandescent or fluorescent light, candle light, or sunlight. Direct sunlight is 
not needed -- the light from an overcast day will provide adequate back 
illumination.  
 
The Lithopane can be used mounted or unmounted. There are a number of 
mounting methods, some of them include: 
 
1) Mounted in a box with back lighting 
2) Attached to a suction cup to hang in a 

window 
3) As a part of a piece of stained glass art 
4) In the base of a lamp 
5) Inserted in a frame 
 
Although the first mounting style is commonly 
used as a night light, the image can be viewed 
in normal room lighting using a 9 watt “puck” 
light for back illumination, available for around 
$10 at any home improvement store. 
 
Size: In theory, the lithopane can be made in any size, but there are 
practical limits. Because the width of the CarveWright is limited, the 
maximum width is about 14". They look great in standard 4x6, 5x7 and 8x10 
sizes but you can make whatever size you wish. 
 



 

129 | P a g e  
 

Our largest lithopane was used on the Cpl. Jason Dunham memorial and it 
measured 14” x 28” (fig. 1) As long as you stay within the 14.5” maximum 
width of the CarveWright, you could honestly make a lithopane 8 feet in 
length. 
 
Color/Tint: The material that Lithopanes are made of comes in a variety of 
colors. In sunlight, using a white material, the color/tone of the Lithopane 
can be similar to a black and white photograph. Using a Bone or off-white 
color yields a sepia tone (antique-looking) photograph. The effect depends 
upon the color of the material being used. When used as a night light, an 
incandescent bulb will give the lithopane a warm tone. For larger 
Lithopanes, fluorescent lighting may be used and will provide a more neutral 
tone. 
 
Need some ideas of how to pose your subject? Browse “stock photo” sites 
that are in business to sell the rights to photos. The contributors to these 
sites are amateurs and professionals that have uploaded their photos for 
use by others. It costs nothing to look --- just search by the type of subject 
(like “baby”, “dog” , “deer”, etc.). Looking at how the pros compose a 
photograph can give you some good ideas on how to compose your own 
photos. 
 
Zoom in on the subject -- try to make the photo sized as close as possible 
to the finished product that you want to achieve. 
 
Use a white or light-colored background -- this will make the subject 
stand out. 
 
Save pictures at the highest resolution allowed -- too low of a resolution 
will decrease the sharpness and quality of the lithopane. 
 
Image Requirements: To make a good lithopane, a good digital image is 
needed. The best source is from a digital camera, but it is also possible to 
scan a photograph. If you scan and/or edit an image, be certain to save it at 
the highest resolution possible. 
 
Crop or Zoom In on the Subject: 
Cropping an image is done to draw 
attention to the subject. This will also 
eliminate a good amount of any 
unwanted background. (You can crop 
an image when you import your image 
into the Designer software that is 
included with your CarveWright 
machine) There are limits to how much 
the subject can be enlarged, 
depending upon the resolution of the 
photo -- as you zoom in, the pixels in 
the final image tend to become 
“blocky”, which reduces the sharpness 
of the final carving. 

SUGGESTIONS 
FOR 
PHOTOGRAPHS 
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Editor: For the “techies”, here is a general guide for the recommended 
maximum size litho using various megapixel settings. At different 
resolutions, some cameras offer an option to choose different image 
qualities. For the “non-techies” simply select “best” and you’ll be able 
achieve great looking lithos.  
 

 
The more pixels in the image file, the higher the resolution. Here’s an 
example of a digitally scanned photo at an original 2400 x 3000 resolution.  
 
Isolating the Subject: Many times it is desirable to isolate the subject 
(crop) from the background. First the background is removed around the 
image (this can done using the Pattern Editor software that is included with 
the scanning probe or with any photo editing software), then it is often best 
to “Feather” the edge to soften it. 
 
Composite Images: Isolated images also make it possible to make a 
composite of several individual images. This is useful if two (or more) 
subjects are to be combined from different photos or rearranged to 
different locations on the same photo. 
 
Avoid Low-Quality Images: Images that have been compressed for email 
or websites may have a reduced quality that may look fine for onscreen 
display, but are not suitable for lithos. In either of these cases, if it is 
necessary to use such an image it will be best to check with the original 
owner of the image, to see if a highquality (hi-res) image is available. The 
net effect of using low-quality/low-resolution images will be that the 
lithopane will not be as sharp as when the original image is used, and may 



 

131 | P a g e  
 

suffer from jpg artifacts (defects) that occur when an image has been 
compressed for the web or email. 
 
Scanned Prints: As a general rule, if the lithopane image is to be made 
from a scanned print (photo), the image on the print should be at least the 
same size as the lithopane. 
 
Professional Photographs and Artwork: The Federal Copyright Act 
provides protection to authors and artists for their original works, including 
photos and drawings. Among the protections that copyright owners have is 
the exclusive right to make copies of that work and prepare other works 
based on the original. You should “steer clear” of using material that is 
covered by copyright. In order to make a lithopane from a copyright 
protected item (regardless of whether it is marked with the © symbol or not), 
permission must be granted by the owner. The owner is the photographer, 
artist or the company that he or she works for. 
 
Ladies and gentlemen this is truly a simple process, every Lithopane that we 
have produced has been created and edited using just the software that is 
included with our CarveWright machine and scanning probe (the scanning 
probe software is not necessary to make great lithopanes). 
 
Our Process: The process starts with a digital photograph. The digital 
photo is imported into the Designer software, where the software will convert 
the image to as many as 256 shades of grey and build a “height map” image 
from it. The digital information from this image provides the depth value for 
the shades of grey in the image.  
 
The Designer software reads the image data and converts each pixel value 
into a depth to be carved into the material you are using, typically it is some 
type of cast acrylic material (Corian®, Staron®, Meganite™). These 
materials are opaque at normal thicknesses, but as the thickness 
decreases, they becomes more and more translucent. This effect duplicates 
the light and dark areas in the photograph. The carving cane be done using 
the 1/16” Carving bit that came with your CarveWright machine and takes 
anywhere from 35 minutes to 2 hours depending on the quality setting you 
select (good lithopanes can be produced using the “draft” setting but for 

better results use “best”).  With 
Designer PRO, the 1/32” Carving 
bit is an available option for 
achieving even higher detail. 
 
 
 
 
 
 
 
 
 

THE ART OF 
MAKING 
LITHOPANES 
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Use the following 9 steps and you will be making great Lithopanes that 
can be cherished for many generations to come! 
 
STEP 1 

Decide on the image that you would like to 
make into a Lithopane. 
 
STEP 2 
Start your Designer software, then click on 
“File” and scroll down to “Import Image” click 
again - this will open the “Import Image” 
window that asks you for the source of your 
image (i.e., where it is located) - you are given 

two options “From File” or “From Clipboard”. Select 
the appropriate option. 
 
STEP 3 
If you click “From File”, which is common, navigate to the photo file location. 
 
STEP 4 
Select the photograph you would like to edit and double click on it, or simply 
click “Open”. 
 
STEP 5 
The Designer software will import it into the “Import Image” window - here 
you will be able to crop the image to select the part of the image that you 

would like to make 
your Lithopane from. 
 
You can select any 
part of the photo 
(called cropping) by 
clicking and dragging 
on the dashed yellow 
box that is around 
the photo or image. 
 
STEP 6 
Once you have 
finished the cropping 
of your image, simply 
click the “Next” 
button located at the 
bottom of the “Import 
Image” window - 
doing so will convert 
the window over to 

the “3D View” window and will also do the magic of converting your image 
into the “height map” that will be used to produce your Lithopane. At this 
point you have some editing options “Raise”, “Lower” or “Invert” the image - 
we recommend you do none of these - just click the “Finish” button. 
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Give your image a name in the 
“Save Item” window and click 
“Save”. The image is now a 
CarveWright pattern (ptn) and 
can now be found in your 
pattern library by clicking on 
the blue shell at the top of your 
Designer software. 
 
STEP 7 
Click on the blue clamshell to 
open your pattern list, find the 
pattern that you just created 
from your image, click on it, 

then click on 
your board, 
place the image pattern on the board as you desire. 
 

STEP 8 - Setting Depth and Height 
The settings that we use are as follows - set your depth to .180 and the 
height to 450 - these settings will give you a nice, bright Lithopane that can 
be enjoyed at all hours of the day (it can be viewed in daylight when 
mounted in a backlit box). 
STEP 9 
Save your project as an mpc file with any name you choose, then upload 
your project to the memory card when you're ready to run the project at the 
machine. 
 
Lithopane Results: 
This 8x10 carving was 
done on Bone Corian 
from the CarveWright 
Store. Runtime was 59 
minutes on BEST 
quality setting. 
 
The pictures here don’t 
do the lithos justice - 
you have to see one up 
close, and in person to 
appreciate the detail 
and marvelous 
backlighting effect. 
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Most litho carving is done on 1/4” thick material, which is too thin to feed 
through the machine. Therefore, it is necessary to construct a jig (sled) for 
the material to be placed into. The jig will add to the overall thickness to 
meet/exceed the minimum 1/2” needed for the machine.  
 
Making a jig for carving on cast acrylic is very simple. Perhaps the easiest 
way to make your jig is to use your CarveWright/CompuCarve.  
 
Go to your local Home Center and buy a piece of 3/4” thick MDF (Medium 
Density-Fiberboard). Next, cut the piece to your desired dimensions. For this 
example we will use a 24” Long x 12” Wide x .75” Thick piece of MDF, and 
will create a jig to fit a sheet of 1/4” thick acrylic up to 11” x 17”. A common 
size is 8x10.  
 
Feel free to adjust the jig size and the 8”x10” recess dimensions to 
accommodate whatever size acrylic sheet you require. Just be certain that 

the overall size of the jig is a 
minimum of 7” longer than the 
acrylic you will carve on. This is 
essential so the jig will always be 
captive under the compression 
rollers. 
 
Create a new layout in Designer 
with a virtual board measuring 17” 
Long x 12” Wide x .75” Thick. (The 
virtual board is 7” shorter than the 

real board you place into the machine, which in this case will be 24” long).  
 
Draw an 8”x10” rectangle on the board and use the CENTER BOTH 
function to place the rectangle deadcenter on the board. (In our example, 
the jig will actually be 14” longer than the actual acrylic piece.  
This will allow you to create a rectangle recess up to 11” x 17” if desired.) 
Make the rectangle a CARVE REGION with a depth of .25”. This is the 
recess that your acrylic sheet will be placed, so it will sit flush with the top of 
the jig’s surface. 
Save the project, 
then upload it to 
your memory card 
and run the project 
on the 24” long 
MDF board. Once 
completed, you 
now have a jig to 
hold your cast 
acrylic sheet. 
  

MAKING A 
“SLED” OR “JIG” 
FOR LITHO 
CARVING 
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CHAPTER 3 – DYNAMIC SURFACE 
 
There are many tools in the Project Designer Software that allow for a lot of variety 
in your carvings.  The ability to carve all the way through your board, merge 
carvings and surfaces to each other, clip carvings to fit within a shape, and more.  

What’s in this Section? 

This section will cover using domes, textures, piercing, clip carving and merging. 
These procedures will cover 
both Project Designer BASIC 
and Project Designer PRO, 
Centerline Text, and 
Conforming Vectors. 

TUTORIALS 
Summer Sun – Learn more 
about layering using depth and 
height and the pierced carving 
tool. 

Pierced Wind Grill - This project shows how to use the pierced carving tool, clip 
carving & drill holes. 

Carving Cutouts – No Cutting Bit Required – This technique demonstrated how 
to carve your project all the way out of the board with using only the carving bit. 
This technique is perfect for doing appliques and other pieces where a bit change 
isn’t needed. 

Red Rooster Coffee Sign– Project Includes many techniques including import 
image and clip carving. Use this image for importing the sunrise. 

Home of the Brave- This project shows how to use the pierced carving tool, clip 
carving & drill holes. 

Curved Box Side – This project reinforces previously learned features and adds 
the surface tool, attachments, and the merge features. 

Lighthouse Welcome - Sign This 2 part project introduces several tools such as 
merging, clip carving, Conforming Vectors (sold separately), and cut path. 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü MANIPULATING THE WORKPIECE 
ü SNAP TO GRID 
ü DRAWING TOOLS 
ü CARVE REGION 
ü FEATHERING 
ü PATTERN PLACEMENT 
ü ROTATE ELEMENT 
ü COPY & PASTE 
ü ADJUSTING HEIGHT 
ü TEXT TOOL 
ü FINE TUNING 
ü ADJUSTING DEPTH 
ü TEXTURE 
ü BOARD SETTINGS 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 

 
 
 
 
 
 
 
 
 
 
 

SUMMER SUN 



 

137 | P a g e  
 

INSTRUCTIONS:  
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project 
Designer Software 
 
The Welcome screen appears with 
project options.   
 

 
Select “New Project” 
 
 
 
 
Set your project board dimensions.   
Length: 7” 
Width: 7”  
Thickness: .75”    
 
Click OK 
 
 
The project board size is not necessarily 
the actual size of the board being put 
into machine. 
  
 
 
 
 
 
 
ü SNAP TO GRID 
 
Under LAYOUT menu, select SNAP. 
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Snap Interval should be .5 inch interval by default. 
 
Check boxes: 
• Snap to grid 
• Snap to edges 
• View grid 
• View Bezier Control Points (should already be 

selected as default) 
 

Click ok 

 
 
 

ü DRAWING TOOLS 
 
Using the grid, draw a box or rectangle .5” 
inside the project board, which should give 
you a box that is 6” x 6”.  
 
Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
 
 
 
 
 
 
 
ü PIERCED CARVE 
 
 
Check the “Pierced” box on the toolbar. 
 
If you cannot find a certain icon on your 
tool bar, click on View > Toolbars to make 
sure they are all selected. 
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ü FEATHERING 
 
Select the drop-down Feather menu and 
select ¼” feather. 
 
Select “Accept” 
 

 
 
 

 
 
 
ü SNAP TO GRID 
 
Click “Toggle Snap to Grid” & “Toggle 
Gridline” icons to turn OFF.  
 
 
 
 
 
 
 
 
 

 
ü DRAWING TOOLS 
 
Select the “Connected Lines” tool. 
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Draw the Sun Rays by clicking in one area 
to create the first point, move to the 
next point and click once, so on until you 
come back to the first point.   To make a 
closed region hover over the first point 
until you see the “star 
burst” and click.  
 
Click Carve Region  
 
Set depth to .05” 
 
 Center Both  
 
 
Adjust size so that the rays 
slightly overlap the sides. 
 
 
ü DRAWING TOOL 
 
Draw a circle at the intersecting point of 
your rays. 
 
 
 
 
 
 
 
 
 
 
ü SURFACE 
 
Select “Surface” Icon 
 
Select “Double Dome” 
 
 
The darker area is the deapest. 
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ü FINE TUNING 
 
 
Set Depth to .06”   

 
Set Height to 300.   
 
 
 
 
 
 
 
 
 
ü LAYERING PATTERNS 
 
Patterns merge with one another and can 
be arranged using even the same pattern 
by overlapping, changing the orientation 
and varying the size, height and depths 
you can create your project. 
 
 
 
ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to open the 
pattern library along the right side. 
 
Select “cloud” under “Season Patterns” in 
your Favorites library from the summer 
folder. 
 
Place on project board. 
 
 
Copy & Paste to add another cloud. 
 
ü FLIP & ROTATE 
 
Right click on the second cloud and select 
Flip Horizontally.    
 
Resize larger than the first cloud and 
position slightly overlapping first cloud. 
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Adjust the depth of the larger cloud to 
.45” and the height to 50. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
Right Click on the larger cloud; then 
paste and move to the upper right 
quadrant of the project. 
 
 
 
 
 
 
 
 
 
 
 

ü TEXT TOOL 
 
Next, select the “Text Tool” and click on 
board. 
 
Text dialog box will appear.  Select from 
any of the true type fonts that you have 
on your computer.  Some work better 
than others. 
 
Type the word “Summer” 
 
Select “Raster” from one of the available 
Rout Modes. 
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Center Horizontally  
 
 
Position the word to go across the Sun 
and into the Sunray.  The entire word 
should have a background behind it. 
 
Set Text Depth to .04” 
 
 
 
 
 
 
 
ü SELECT ALL 
 
Select all by clicking once on one corner 
and then holding down the mouse 
button, drag your mouse to the opposite 
corner.  You can also right-click on the 
board (no element selected) and then 
select Select All. 
 
 
 
 
 
 
 
 
 
 
With everything selected, click on the 
“DRAFT” drop-down menu and apply a 
“Small Draft”. 
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With just the word selected, apply a 
MEDIUM draft. 
 
 
 
 
 
 
 
 
 
 
 
 
ü BOARD SETTINGS 
 
Go to View > Toggle Texture to remove 
wood grain for better viewing. 
 
Also look at View > Board Settings > 
Stain/Finish to see how you can change 
the Wood Type/Stain or Wood Finish.  
This is a great way to present a proposal 
to a potential customer. 
 

 
Rotate or zoom in on your project to view 
it from different angles and make any 
necessary adjustments. 
 
 
REMEMBER THESE FUNCTIONS FROM PREVIOUS STEP-BY-STEP PROJECTS 
 
 
ü MANAGING DATA 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card 
 & Programmer are properly attached via your USB port, Select “File” > “Upload” to save to your memory card. 
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Select Quality Setting  
 
Ø DRAFT 
Ø NORMAL 
Ø BEST 
Ø OPTIMUM 

 
These settings determine the number of passes the machine makes to carve your project.  The more lines the better the 
surface  finish.  Make your decision based on material type, fondness of sanding vs. machine time, & test carve vs. final.  
Notice the estimated carving time differs by quality setting. 

 
Name Your Project  
 
Example: 
Summersun_B_3h30m 
(recognizable name_quality setting_estimated time to carve) 
 
Click “Upload” 

 
NOTE: Actual board to be placed in machine should be 7” longer or you should use a sled that has 3.5 extra inches on 
each end to STAY UNDER THE ROLLERS. 
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This project covers the following design concepts: 
 
Ø PATTERN PLACEMENT 
Ø PATTERN MANIPULATION 
Ø FINE TUNING 
Ø ADJUSTING DEPTH & HEIGHT 
Ø DRAWING TOOLS 
Ø REGIONS 
Ø CARVING OPTIMIZATION 
Ø FEATHERING 
Ø CARVING LIST 
Ø BOARD SETTINGS 
Ø MANAGING DATA 
Ø UPLOADING TO MEMORY CARD 
Ø QUALITY SETTINGS 
Ø PIERCED CARVING 
Ø DRILLING HOLES 
Ø CLIP CARVING 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

INSTRUCTIONS: 

PIERCED WIND GRILL 
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Ø STARTING THE 

SOFTWARE 
 

Open the CarveWright 
Designer Software 

 
The Welcome screen 
appears with project 

options.   
 

 
Select “New Project” 

 
 
 
 
 
 
 
 
 
 

Set your board piece 
dimensions.   
Length: 12” 

Width: 8”  
Thickness: .75”    

 
Click ok 

 
 
 
 
 
 
 
 
 

Ø MENUS, TOOLBARS 
OR MOUSE  

 
 
 
 
 

 

 

 



 

148 | P a g e  
 

Ø MANIPULATING 
THE WORKPIECE  

 
Board piece will display on 

screen in three dimensions. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 
 
 

Ø DRILL HOLE TOOL 
 

 
 

Select the “Drill Hole Tool” 
and click on the top left 

corner of the workpiece. 
 
 
 

Drill Hole Tool dialog box 
appears.  Type “.125” inch 

for the diameter of the 
hole. 

 
 
 
 

Ø MIRROR 
 

 
Right click on the hole and 

select “Mirror”, “Mirror 
All”. 
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Holes should now 
appear in all four 

corners. 
 
 
 
 
 
 
 
 
 
 
 
 

Ø  PATTERN 
PLACEMENT 

 

  Select the “pattern 
tool” to open the pattern 

library along the right side.  
 

Select “Rosett04” under 
“Rosettes” and place on 

board by clicking or drag & 
drop. 

 
 
 
 
 
 
 

Ø CENTERING 
Right-Click on “Rosett04” to 

bring up menu of available 
options.  

 

 
 Select “Center”, 

 “Center Both”.  
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Select “Vine06” under 
“Vines and Stems” in the 

Basic Library.  Place it onto 
the board. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Select the “rosette” and 
scale down the size.  Use 

the Red node to maintain 
scale. 

 
 
 
 
 
 
 
 
 
 
 
 

Select the “vine” pattern, 
right click and select 

“Mirror All”. 
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ü DRAWING TOOLS 

 

 
Select the “Rectangle Tool”. 

 
 

Draw Rectangle across the 
entire board, leaving a 1” 

border as shown. 
 
 
 
 
 
 

ü REGIONS 
 

 
Select “Carve Region”. 

 
This applies a carved area 

to the rectangle with a 
default depth of .78”. 

 
 
 
 
 
 
 
 

Ø CENTERING 
With the rectangle 

selected, right click to bring 
up menu of available 

options.  
 

 
 Select “Center”, 

 “Center Both”.  
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Ø CARVING LIST 
 

 
Select “View” and then 

“Carving List” 
 

The Carving List opens on 
the left displaying every 

element on the virtual 
design board. 

 
 
 
 
 

Ø CLIP CARVING 
 

 
Select all of the pattern files 

in the Carving Lists, right 
click and choose “Clip 

Carving Inclusive”. 
 
 
 
 
 
 
 
 
 

Ø CARVING 
OPTIMIZATION 

 
Ø FEATHERING 

 

 
With the all still selected, 

click on the “Feather Tool”. 
 

From the drop down menu, 
select “Feathering None”. 
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Ø CARVING 
OPTIMIZATION 

 
Ø FEATHERING 

 

 
Select the Rectangle, right 
click and select “Feather ¼ 

inch”. 
 
 

Ø MANIPULATING 
THE WORKPIECE  

 
 

 
Rotate and/or zoom your 

workpiece to see your 
design board more clearly. 

 

 
Select “File”, “Save”  

 
*****IMPORTANT***** 
Name file and click “Save” 

to hard drive. 
 

Ø UPLOADING TO 
MEMORY CARD 

 

 
Select “File”, “Upload” 
Save to memory card. 

 
Example: 

piercedrosette_N_45 
(recognizable name_quality 

setting_estimated time to 
carve) 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü PATTERN PLACEMENT 
ü PATTERN MANIPULATION 
ü PIERCED PATTERN 
ü OUTLINE PATTERN – 3 OPTIONS 
ü PATH OFFSET 
ü CONNECTED LINES TOOL 
ü PIERCED CARVE REGION 
ü ADD FEATHERING 
ü CREATE TABS 
ü LINE SEGMENT TOOL 
ü SET TABS 
ü FINETUNING 
ü SAVE & UPLOADING TO MEMORY CARD  

 
This technique, generally, means your project will be done with only the carving bit.  
There would be no need for the measuring of both the carving & cutting bits during 
setup, or bit changes.  It eliminates the chances of the cut path not lining up with 
the pattern and avoids the use of the cutting bit altogether. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CARVING CUTOUTS 
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INSTRUCTIONS: 
 
ü STARTING SOFTWARE 
 
Open the CarveWright Project Designer Software 
 
The Welcome screen appears with project options.  
Select “New Project” 
 
Set your project board dimensions. 
Length: 20” 
Width: 14” 
Thickness: .75” 
Remember your actual board should be bigger than 
your virtual board unless you are using a sled. 
Click OK 
 
ü PATTERN PLACEMENT 
 
Open the Pattern Library Tool and select the STAR 
from the BASIC folder under CENTERS AND FILLS. 
 
To place a pattern, you can either click once on the 
pattern and then once on the virtual board or you 
can click and drag it onto the board.   
 
If you double click on the pattern, it will attempt to 
open it in Pattern Editor software and give you a 
message that “You may only edit unlicensed 
patterns, which you have authored.” Pattern Editor 
is also an advanced feature that you may not have 
purchased or activated.  
 
ü PATTERN MANIPULATION 
Resize to fit using one of the corner red knobs, so 
that your pattern stays proportional and is not 
skewed. 
 
Remember to keep at least a ½” away from the top 
portion of the board, so as not to interfere with the 
tracking roller.  
 
Right-click on the pattern and select CENTER & 
CENTER BOTH to center it on the board both 
horizontally & vertically.   
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This will lock the pattern into place and you will not be able to move the pattern placement until you go back and select 
again to toggle that feature off. 
 
ü PIERCE PATTERN  
 
With the pattern selected, click the Pierced 
button on the Input Toolbar.   
 
This sets the depth of the pattern to the bottom 
of the board.  
 
Change the FEATHERING to NONE. 
 
 
ü OUTLINE PATTERN 
 
THREE WAYS TO OUTLINE: 
 
Option 1: Uses the drawing tools in the Designer 
Software (1.X & 2.X) 
 
With some patterns, you can right-click on the 
pattern and select OUTLINE PATTERN and then 
enlarge it to fit around the pattern.   
 
Center outline path. 
 
 
 
 
Option 2: Uses the PATH OFFSET tool that is part of the advanced 2D Vector Drawing Suite (purchase required). 
 
With the pattern selected, right-click and select 
OUTLINE PATTERN.  Then select the PATH from 
your Carving List.  
 
ü PATH OFFSET 
 
Click on the PATH OFFSET tool and set the 
distance from the path to offset the outline.  I 
selected .5 and hit OK. 
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Option 3: Uses the drawing tools in the Designer Software (1.X or 2.X) 
 
Because of the shape of 
some patterns, it is not 
always possible to use 
options 1 or 2.  You will 
instead need to manually 
draw a path around the 
pattern using the 
CONNECTED LINES TOOL.    
 
 

ü CONNECTED LINES TOOL 
 
Click on the Connected Lines Tool from the DRAWING 
TOOLBAR.  Outline around the shape close to it, but not 
touching or crossing the pattern.  
 
To close the shape make sure you get the STARBURST.  
When you have a closed path, the CUT PATH Tool will 
become an option.  If it is not, play with the ends of the 
connected lines until they become closed. 
 
ü PIERCED CARVE REGION 
 
Now that you have a closed region, we are going to select 
the Carve Region tool and then select PIERCED. 
 
Remember, because there are two separate belts pulling 
your board through and a space between them, your 
carving bit will NOT carve into the belts or machine.  You 
will need to make sure that it does not interfere with the 
tracking roller.  If you are closer than a ½”, it will give you 
a warning message. 
 
 
ü ADD FEATHERING 
 
Cliffs are straight up and down edges that the top part of 
the tapered carving bit may hit. To avoid this, add a 
feathering to give it a ramped area to carve. 
 
Select path & Feathering tool, feathering size that gets 
you close to pattern, but not connected, and Accept it on 
the inside of the path.  
 
You may need to look at the back of the board to see how 
close you are and make adjustments. 
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ü CREATE TABS  
To keep from having a loose piece floating around in 
your machine, we will create tabs to hold the pattern to 
the project board.   
 
ü LINE SEGMENT TOOL 
 
First, you will need to use the LINE SEGMENT TOOL from 
your drawing toolbar. 
 
Draw lines across the pattern and carve region to 
connect the pattern to the board. 
 
ü SET TABS 
 
Click on the Tabs icon and select the settings.  (I usually 
just let it default and hit OK.) 
 
 
ü FINETUNING 
 
You can look at the REAR of the board to see the tab 
placement and if there are any changes you would like 
to make.  Don’t forget to consider adding DRAFT or BIT 
OPTIMIZATION to your pattern.  
 
 
ü SAVE & UPLOAD TO CARD 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the Software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card & Programmer are properly 
attached via your USB port, Select “File” > “Upload” to 
save to your memory card. 
 
Select Quality Setting  

Name Your Project  

Click “Upload” 



 

159 | P a g e  
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
This project uses only PROJECT DESIGNER SOFTWARE and covers the following design 
concepts: 
 
ü STARTING SOFTWARE 
ü MENUS, TOOLBARS, SHORTCUT KEYS OR MOUSE BUTTONS 
ü MANIPULATING THE WORKPIECE 
ü SNAP TO GRID 
ü DRAWING TOOLS 
ü CARVE REGION 
ü FEATHERING 
ü DOWNLOAD PATTERN 
ü PATTERN PLACEMENT 
ü COPY & PASTE 
ü FINE TUNING 
ü TEXT TOOL 
ü CENTERING 
ü ADJUSTING DEPTH 
ü MIRRORING TEXT 
ü UNDO 
ü COPY & PASTE 
ü CONSTRAINTS 
ü IMPORTING IMAGES 
ü CLIP CARVE 
ü MANAGING DATA 
ü UPLOADING TO MEMORY CARD  
ü SELECT QUALITY SETTING 
ü NAME PROJECT 

 
 
 
 
 

RED ROOSTER COFFEE 
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INSTRUCTIONS:  
 

ü STARTING THE SOFTWARE 
 

Open the CarveWright Project 
Designer Software 
 
The Welcome screen appears with 
project options.   
 

  Select “New Project” 
 
Set your project board dimensions.   
Length: 24” 
Width: 14”  
Thickness: .75”    
 
Click OK 
 
The project board size is not 
necessarily the actual size of the 
board being put into machine. 
 
ü MENUS, TOOLBARS, SHORTCUT 

KEYS OR MOUSE BUTTONS 
 
For every software function, we 
provide you three distinct ways to 
access that function.  They are usually 
menu, icon or right-click. Some 
common functions, such as Copy and 
Paste, also use shortcut keys.  These 
will also work in Project Designer. 
 
ü MANIPULATING THE WORKPIECE  

 
Board piece will display on screen in 
three dimensions.  You can use these 
tools to get a different view of your 
project board. 
 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
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Toggle Texture to turn off the wood 
grain. 
 
ü SNAP TO GRID 
 
Under LAYOUT menu, select SNAP. 
 
Snap Interval should be .5 inch 
interval by default. 
 
Change interval to: 1 inch 
 
Check boxes: 
• Snap to grid 
• View grid 
• View Bezier Control Points 

(should already be selected as 
default) 
 

Click ok 

Click the Front icon and zoom in to 
get closer to the project board. 

ü DRAWING TOOLS 
 
Using the grid, draw a rectangle 1” 
inside the project board from sides & 
top.  Make it 22” long & 9” tall.  
 
Select the “Pattern Tool” icon to open 
the pattern library along the right 
side. 
 
ü CARVE REGION  
 
Select “Carve Region” icon. 
 
This creates a carved out region inside 
the boundary. Automatically defaults 
to .250” depth.  Remember depth of 
pattern & how depth effects carve 
time. 
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ü FEATHERING 
 
Select the drop-down Feather menu 
and select 1/8” feather.  Select 
“Accept” 
 
 
 
ü DRAWING TOOLS 
 
Using the grid, draw a rectangle 1” 
inside the project board from sides & 
bottom.  Make it 22” long & 2” tall.  
 
ü CARVE REGION  
 
Select “Carve Region” icon. 
 
This creates a carved out region inside 
the boundary. Automatically defaults 
to .250” depth.  Remember depth of 
pattern & how depth effects carve 
time. 
 
ü FEATHERING 
 
Select the drop-down Feather menu 
and select 1/8” feather.  Select 
“Accept” 
 
ü DOWNLOAD PATTERN 
 
Patterns must be placed into your 
Pattern Library Favorites folder either 
as an individual pattern or as a 
collection. The TRY button lets you 
play with a pattern to see if you want 
to buy it. It will have a red 
background until it is purchased and 
activated (licensed). 
 
ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to 
open the pattern library along the 
right side. 
 

Select “Decorative Rooster” under “2013 Conference Collection”. 
 

Click once on pattern and 
once on board to place or 
click and drag to the board. 
 

Double-clicking will attempt to open it in Pattern Editor Software, which you 
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cannot do since it is licensed and you 
are not the author of the pattern. 
 
 
 
ü FINE TUNING  
 
Manipulate the size and placement of 
the pattern by scaling to size from a 
corner. 
 
Place it near the middle of the top 
rectangle and make smaller. We can 
adjust size & placement later. 
 
Set depth of rooster to .250”. 
 
Turn off Snap to Grid & View Grid 
under Layout > Snap 
 
ü TEXT TOOL 
 
Next, select the “Text Tool” and click 
on board. 
 
Text dialog box will appear.  Select 
from any of the true type fonts that 
you have on your computer. I used 
“Elephant”. Some work better than 
others. 
 
Type the word “Red Rooster Coffee” 
and arch to about 143 degrees. 
 
 “Raster” is selected by default. 
  
ü FINE TUNING  
 
Manipulate the size and placement of 
the word, just as you would a pattern 
by scaling to size from a corner. 
 
ü CENTERING 
 
Right-click to see available options 
and select Center > Horizontally. 
 
ü ADJUST DEPTH 

 
ü FEATHERING: None 

 
ü DRAFT: Medium 
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ü TEXT TOOL 
 
Select the “Text Tool” and click on 
board.  
Type the word “Since 2007” and 
change arch to 0 degrees and Text 
Spacing to 60. 
 “Raster” is selected by default.  
Font:  I used “Papyrus” 
 
Thin fonts tend to chip out, so to 
avoid this lower the height and add 
draft or select a fatter font. 
 
 
ü FINE TUNING  
 
Manipulate the size and placement of 
the word to under the rooster’s feet. 
 
CENTERING: Horizontal 
ADJUST DEPTH: 250 
ADJUST HEIGHT: 75 
FEATHERING: None 
DRAFT: Medium 
 
ü TEXT TOOL 
 
Select the “Text Tool” and click on 
board.  
Type the word “Fresh Roasted at 
Ratisseau’s Roost” or your own 
personalized message and change 
Text Spacing to 0. 
 “Raster” is selected by default.  
Font:  I used “Papyrus” 
 
ü FINE TUNING  
 
Manipulate the size and placement of 
the word to under the bottom 
rectangle. 
 
CENTERING: Horizontal 
ADJUST DEPTH: 250 
FEATHERING: None 
DRAFT: Medium 
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ü TEXT TOOL  
 
Select the “Text Tool” and click on 
board.  
Type the number “5”.  
Font:  I used “Elephant”, again. 
Open your Character Map and copy 
the “cent” sign for your font. 
 
 START > ALL PROGRAMS > 
ACCESSORIES > SYSTEM TOOLS > 
CHARACTER MAP on my Windows XP. 
You can select & copy or use the 
shortcut key Alt+0162. 
 
ü FINE TUNING  
Manipulate the size and placement to 
left hand side of bottom rectangle. 
ADJUST DEPTH: 250 
FEATHERING: None  
DRAFT: Medium 
 
ü MIRRORING TEXT 
 
Note: Be careful mirroring text 
because the letters will be backwards. 
 
ü UNDO 
 
The UNDO tool wiCtrl- Z will undo 
previous done functions, as will CTRL-
Z. 
 
ü COPY & PASTE  
  
Designer pastes the new item on top 
of the old item. 
 
Copy and Paste then move to right 
side of bottom box. 
 
ü CONSTRAINTS 
 
Use the constraints to get them both 
the same distance from the bottom 

and edges.  Set both to 1.5”.  Hit enter in the constraint box. 
If you ever get in this box by mistake, escape will get you out. 
 

ü IMPORT IMAGE 
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Designer can import several file 
formats.  Remember that trash in will 
be trash out, so select images with 
high resolution. This is not usually 
found on the internet for purposes of 
speed in uploading. 
 
Some images are also copyrighted 
and should not be used. 
 
Most images will come in as a square 
or rectangle, even if the background is 
white. If given a choice between 
format,s PNG will not give you the 
white background. 
 
Search on the internet for “sunrise 
clipart” Images. I used Google search 
engine.  Select your image to see 
bigger view.  Right click and select 
SAVE IMAGE AS to your Desktop. 
 
 
 
 
 
 
 
 
 
 
Back in Designer go to FILE > IMPORT 
> IMPORT IMAGE > FROM FILE and 
navigate to your desktop.  Select your 
sunrise image. 
 
Adjust the yellow dotted lines to crop 
the bottom of the image. 
 
Clink NEXT. 
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ü IMPORT IMAGE 
The software automatically converts 
the image to grayscale.  White gets 
the deepest carve and black the 
shallowest carve.  This is the way you 
want to keep it for Lithophanes as the 
deeper carve allows more light flow 
and shallower carve restricts it. 
 
Use the options to adjust SIZE, if 
necessary.  Make sure to Lock to keep 
correct proportions of the image. 
 
Change the depth to .2” to lessen the 
distance between white & black 
levels. 
 
Use the OPTIONS bar to remove from 
the top or bottom of the image. One 
click on the down arrow took away 
the unwanted background for me. 
 
Click NEXT, name and save into your 
FAVORITES folder. 
 
ü PATTERN PLACEMENT 
 
 Select the “Pattern Tool” icon to 
open the pattern library along the 
right side. 
 
Select imported image from your 
FAVORITES folder. 
 
If you need to edit the image and 
have the Pattern Editor license, 
double-click on it to open the tool.  
 
ü FINE TUNING  
Manipulate the size and placement to 
the top rectangle. I wanted the sun 
larger, so I am using the corners to 
stretch the image and maintain 
proportion until the sun is as big as I 
want it to be.  
ADJUST DEPTH: 250 
FEATHERING: None 

DRAFT: Medium  
ADJUST HEIGHT: 30 
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ü CLIP CARVE 
 
Right-click on the image and select 
Clip Carving > Inclusive. 
 
Clip Carving must have a closed & 
carved region below it. Inclusive 
shows image inside.  Exclusive shows 
image outside. 
 
 
ü CARVING LIST 
 
The Carving List is very useful 
especially when there are lots of 
elements on your project board.  
 
Go to VIEW > CARVING LIST. 
 
 
ü FEATHERING 
 
Select both rectangles and select Flip 
Feathering. 
 
 
 
 
 
 
 
ü TEXTURES 
 
Select bottom rectangle and click on 
Select Texture Tool. 
 
Select Checkering 2 and change 
interval to .25 
 
Click OK 
Change Height: 25  
 
Fine Tune any elements and do a test 
carve to check heights. 
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REMEMBER THESE FUNCTIONS 
FROM PREVIOUS STEP-BY-STEP 
PROJECTS 
ü MANAGING DATA 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a 
memory card, it cannot be brought 
back from the memory card into the 
software.  Always SAVE YOUR 
PROJECT on your hard drive.  A 
Projects folder is recommended and 
you should know where you saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card 
 & Programmer are properly attached 
via your USB port, Select “File” > 
“Upload” to save to your memory 
card. 
 
Select Quality Setting  
 
Ø DRAFT 
Ø NORMAL 
Ø BEST 
Ø OPTIMUM 

 
These settings determine the number 
of passes the machine makes to carve 
your project.  The more lines the 
better the surface  finish.  Make your 
decision based on material type, 
fondness of sanding vs. machine time, 
& test carve vs. final.  Notice the 
estimated carving time differs by 
quality setting. 

 
Name Your Project  
 
Example: 
redroosterN_2h45m 

(recognizable name_quality setting_estimated time to carve) 
 
Click “Upload” 

 
NOTE: Actual board to be placed in machine should be 7” longer or you 
should use a sled that has 3.5 extra inches on each end to STAY UNDER THE 
ROLLERS. 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü DOWNLOAD PATTERN 
ü INSTALL PATTERN 
ü ACTIVATE PATTERN 
ü PATTERN PLACEMENT 
ü VIEW GRIDLINES 
ü CENTER HORIZONTALLY 
ü MANIPULATE VIEW 
ü FINE TUNING 
ü CARVING LIST 
ü OUTLINE PATH 
ü CARVE REGION 
ü SNAP TO GRID 
ü DRAWING TOOLS 
ü SELECT TEXTURES 
ü GROUPING 
ü MERGE ADDITIVE 
ü CUT PATH 
ü SAVE & UPLOAD 

 

 
 

HOME OF THE 
BRAVE 
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INSTRUCTIONS: 
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project Designer 
Software  

 
*****PLEASE NOTE***** 

 Since, we are going to be messing with 
licenses, open with “Run as 
Administrator”, if using Win 7 or 8. 
 
The Welcome screen appears with 
Options – New Project; Last Project; 
Open Project or Documentation 
 
Select “New Project”  
 
Set your project board dimensions. 
Length: 20” 
Width: 11” 
Thickness: .75” 
Click OK 
 

Determining board length: finished, 
virtual or actual board.  See 7” Rule in 
Tips & Tricks – “Handy Tips for Everyone! 
– ISSUE 3 December 2007” 
 

ü DOWNLOAD PATTERN 
 

3 ways to Download a Licensed Pattern:  
 

1. Click the green TRY  
2. Click on Download link in email 
3. Log into Customer Account and 

click on DOWNLOAD PATTERN 
link 
 

PAY ATTENTION TO WHERE YOU ARE 
PUTTING THE PATTERN 
 

Downloads typical go into your 
“Downloads” folder, unless you 
specifically direct it to another folder or 
to your DESKTOP. 
 

16 BIT refers to a higher resolution 
pattern. 
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ü INSTALL PATTERN 
 

In Designer Software, Go to FILE > 
OPEN  
 
Navigate to where you downloaded the 
pattern.   
 
Again, it usually goes to your 
DOWNLOADS FOLDER.  You may want 
to sort that folder by Date Modified ↓ 
for most recent download.  
 
Numbers after it in parenthesis means 

you have downloaded it before. 
 
Select the pattern (.ptn) and Open. 
 
 
Pattern will open in an Import Image 
window.   
 
Select “Finish”, then “Next”.   
 
You do not need to make any 
adjustments to a licensed pattern or 
rename them.  It will be put into your 
FAVORITES folder in the Pattern Library 
Tool. (Blue Shell) 
 
  
 
  
ü ACTIVATE LICENSE 
 
Go to HELP > MANAGE LICENSES > 
ACTIVATE LICENSE 
 
Select “License Online Now” 
 
Enter Serial Number with capital letters 
and decimal points.  It will be in the 
follow format using both letters & 
numbers. XXXX.XXXX.XXXX.XXXX 
 
Customer Account Username & 
Password Required. 
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ü PATTERN PLACEMENT   
 
Open Pattern Library 
 
Notice in Pattern Library:  
Red background = unlicensed. 
White background = licensed or licensed  
not required. 
 
Place “Eagle & Banner – 4m3d” pattern 
onto board by clicking and dragging to 
the board or by clicking ONCE on pattern 
to select and ONCE on board to place . 
 
Conference attendees received this pattern complimentary from one of our Sponsors - CNC Mini Projects.  Please contact 
LHR Technologies to find out how you can purchase this pattern. 
 
ü VIEW GRIDLINES  
 

Go to Icon  or VIEW menu > Toggle 
Gridlines. 
 
To set the interval of the gridline, go to 
LAYOUT > Snap and set interval to .5”. 
 
Move your pattern down from top at 
least ½”.  This is to avoid contact with 
tracking roller unless you are going to 
use a sled. See Tips & Tricks – “Carving 
Jigs – Carrier Boards, Sleds and Rails – 
ISSUE 7 April 2008” 
 
Select Toggle Gridlines, again, to turn it 
off. 
 
ü CENTER HORIZONTALLY 
 
Right click on element to see available 
options for this pattern. Select Center > 

Center Horizontally.   
 
ü MANIPULATE VIEW 
 

Zoom and Rotate  board to get a 
better view of your pattern and what fine tuning needs to be done, such as depth, height, peaks, & draft. 

Mouse with roller wheel can be used for this too.  Use  to go back to front view. 
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ü FINE TUNING 
 
Resize pattern to 14.5” length. 
 
Change Depth to .25”. 
 
Add Draft to medium. 
 
Add Bit Optimization to Pattern 
 
ü CARVING LIST 
 
Open your Carving List, if it is not by 
going to VIEW > CARVING LIST. 
 
Carving List shows every element on that side of the project board. 
 
 
ü OUTLINE PATH 
 
Removing the peaks in the open areas of 
the pattern can be done a couple of 
ways.  
 
Right click on pattern and select OUTLINE 
PATH.  
 
Delete all paths from Carving List, except 
main eagle path. 
 
Hit Delete key to delete them from the 
Carving List and your project board or 

select the delete icon.  
 
 
 
ü CARVE REGION  
 
Select the eagle path 
Click the carve region tool. 
  
It will default to .25”, which is the current 
depth of our pattern taking away the 
peaks in our open areas of the pattern. 
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ü GRIDLINES & SNAP TO GRID 
 
 
 
Toggle on your Gridline 
 
Toggle on your Snap to Grid 
 
 
ü DRAWING TOOLS 
 
Select  Connected Line tool  
 
Draw an area that includes the paths 
inside the pattern.  
 
Leave enough room for .5” border at 
bottom. 
 
Make sure you get the “starburst” when 
connecting final point. 
 
Notice when you have a “CLOSED 
REGION”, icons like carve region and cut 
path are no longer grey.  This indicates 
that they are available for use with the 
element currently selected. 
 
 
 
Assign a CARVE REGION and leave at .25”.  
 
Add medium Draft to region. 
 
 
ü SELECT TEXTURES 
 
Click on the Select Textures tool.  
 
Select Texture to use. 
 
Change the interval of pattern to .15” 
 
Click OK 
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ü HEIGHT 
 
 
Notice how the vertical texture interferes 
with the pattern.   
 
Change the height to 10 for subtle effect 
and pushes it below the main pattern. 
 
 
 
 
 
 
 
 
 
ü DRAWING TOOLS 
 
Turn back on Gridlines.  Snap to grid 
should still be set. 
 
Select Connected Line tool to draw .5 
outside of textured carve region.  Follow 
the line of the top of the first box where 
it goes through the eagle pattern.  
 
 
Make closed region with “starburst”. 
 
 
 
 
 
ü CARVE REGION 
 
Select CARVE REGION 
 
Change depth to .125” to put below 
banner of pattern, but above textured 
middle to give a border to our project. 
 
Notice how the pattern and middle panel 
is overwhelmed, again, by the carve 
region.  
 
Toggle Gridline off. 
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ü GROUPING 
 
Select the two connected line areas that 
we want to merge. 
 
Right click and select Group, so that the 
merge does not affect other elements. 
 
ü MERGE ADDITIVE 
 
Click on the Merge Additive icon of the 
outside Connected Line region.  
 
Merge sets the conditions on how 
patterns or surfaces overlap one another. 

 
 
ü CUT PATH 
 
Select Path of eagle & outside Connected 
Line. 
 
Drawing tools must have carve region 
assigned to them.  You can add a carve 
region, outline element, then remove the 
carve region after you have the path. 
 
Right click and select OUTLINE PATTERNS. 
 
Flip Cut to outside of path and accept. 
 
Customize with text. 
 
ü SAVE & UPLOAD TO CARD 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card & Programmer are properly attached via your USB port, Select “File” > “Upload” to save 
to your memory card. 
 

Select Quality Setting > Name Your Project  > Click “Upload” 
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This project covers the following design concepts: 
 
Ø DRAWING TOOLS 
Ø REGIONS 
Ø SURFACES 
Ø ADJUSTING DEPTH & HEIGHT 
Ø CONSTRAINTS & ATTACHMENTS 
Ø CARVING LIST 
Ø MERGE 
Ø MANAGING DATA 
Ø UPLOADING TO MEMORY CARD 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

INSTRUCTIONS: 
Ø STARTING THE SOFTWARE 

 
 

Open the CarveWright Designer Software 
 
 

CURVED BOX 
SIDE 



 

179 | P a g e  
 

 
The Welcome screen 
appears with project 

options.   
 

 
Select “New Project” 

 
 
 
 
 
 
 
 
 
 

Set your board piece 
dimensions.   
Length: 14” 
Width: 7.5”  

Thickness: .75”    
 

Click ok 
 
 

Ø MANIPULATING 
THE WORKPIECE  

 
Board piece will display on 

screen in three 
dimensions. 

 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
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ü DRAWING TOOLS 
 

 
Select the “Rectangle 

Tool”. 
 
 

Draw Rectangle across the 
entire board, as shown. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set size of rectangle to 
Width:  “14.125 inch” 

Height: “6 inch” 
 
 
 
 
 

ü CENTERING 
 

   
 

Right Click and select 
“Center”, “Center 

Horizontally” 
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Ø SURFACES 

 
 

Use Select Surface Tool 
and choose “Domes” & 

“Vertical Dome” 
 
 

Ø ADJUSTING THE 
HEIGHT & DEPTH 

 
With the rectangular 

region selected, change 
the depth to “.5” and the 

height to “999”. 
 

Ø MANIPULATING 
THE WORKPIECE 

 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
 

You will see the curve 
become much more 

defined if you rotate it and 
look from a side angle. 

 
 
 

Ø CONSTRAINTS & 
ATTACHMENTS 

 
Right Click the Yellow 

Node at the top of the 
rectangle and choose 

attach. 
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Attach it to the top edge of 
the board and type in 

“.25”.  This locks the 
rectangle in place at a ¼ 

inch from the top border. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ü DRAWING TOOLS 
 

 
Select the “Rectangle 

Tool”. 
 

Select rectangle tool again 
and draw another 

rectangle along the 
bottom of the board.  

 
 
 
 
 
 
 

Ø CONSTRAINTS & 
ATTACHMENTS 

 
Set the dimensions to 

“14.125 inch x 1.25 inch” 
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ü CENTERING 
 

   
Right Click and select 

“Center”, “Center 
Horizontally” 

 
 
 
 
 
 
 
 
 
 
 
 

Ø CONSTRAINTS & 
ATTACHMENTS 

 
Attach the box to the 

bottom edge of the board 
by setting the distance to 

“0”. 
 
 
 
 
 
 
 
 
 

Ø SURFACES 

 
 

Choose Select Surface and 
select Top Dome under 

Domes. 
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Change the depth to .5” 
and the height to 999.  

Ø MANIPULATING 
THE WORKPIECE 

  Zoom 

  Rotate 

  Pan 

  Front 

  Rear 
Again you can see how this 

changes the contour from 
a side angle. 

 
Ø PATTERN 
PLACEMENT 

 

  Select the “pattern 
tool” to open the pattern 

library along the right side.  
 

Select “Lion01” under 
“Animate Objects” and 

place on board by clicking 
or drag & drop. 

 
Size to fit within the bigger 

rectangle dome. 
 

Ø MIRROR 
 

    
Right click on the lion and 

select “Mirror”, “Mirror 
Horizontally”. 

 
 

 

 

 
Note: The patterns are not showing up all the way. We need to fix this by using our 

merging tools. Select the Carving list under View on the top menu bar. 
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Ø CARVING LIST 

 

 
Select “View” and then 

“Carving List” 
 
 
 
 

Ø MERGE 
 

 
Select the “Lion” patterns 

in the carving list.  Click on 
the merge style and select 

Additive. 

 
 
 
 
 
 
 
 

Ø PATTERN 
PLACEMENT 

 

  
 

Select “Shield01” under 
“Shields” and place in the 

middle of the board. 
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Ø MERGE 
 

 
Select the “Shield” pattern 
in the carving list.  Click on 
the merge style and select 

Additive. 

 
 
 
 
 
 
 
 
 

ü CENTERING 
 

   
 

Select the “Shield01” 
pattern and select 
“Center”, “Center 

Horizontally”. 
 
 
 
 
 
 
 
 
 
 

Ø PATTERN 
PLACEMENT 

 

  
 

Under “Filagrees”, select 
“Filagree05” and place in 
the bottom corner of the 

board. 
 

Size to fit within the 
smaller rectangle along 

the bottom. 
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Ø MIRROR 
 

    
Right click on the hole and 

select “Mirror”, “Mirror 
Horizontally”. 

 
 
 
 
 

Ø CARVING LIST 
 

 
Select “View” and then 

“Carving List” 
 

Ø MERGE 
 

 
Select the “Filagree” 

patterns in the carving list.  
Click on the merge style 

and select Additive. 

 
 
 
 
 

Ø COPY & PASTE 
 

   
Right Click, choose “copy” 

and “paste” to put another 
filagree next to the 

existing filagree and again 
Mirror Horizontally. 

 
Ø MIRROR 
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Repeat this step again so 
the pattern is mirrored 

across the entire bottom 
of the board. 

 
 
 
 
 
 
 
 

Ø MANIPULATING 
THE WORKPIECE  

 
 

 
Rotate and/or zoom your 

workpiece to see your 
design board more clearly. 

 

 
Select “File”, “Save”  

 
*****IMPORTANT***** 
Name file and click “Save” 

to hard drive. 
 

Ø UPLOADING TO 
MEMORY CARD 

 

 
Select “File”, “Upload” 
Save to memory card. 

 
Example: 

lionboxside_N_45 
(recognizable 
name_quality 

setting_estimated time to 
carve) 
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This project covers the following design concepts: 
 
ü STARTING SOFTWARE 
ü DRAWING TOOLS 
ü CARVE REGION 
ü MERGE - SUBTRACTIVE 
ü TEXTURE 
ü CLIP CARVING – EXCLUSIVE 
ü TEXT TOOL 
ü CONFORMING VECTORS 
ü CUT PATH 
ü SAVE & UPLOADING TO MEMORY CARD  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LIGHTHOUSE 
WELCOME PT 1 
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INSTRUCTIONS: 
 
ü STARTING THE SOFTWARE 
 
Open the CarveWright Project 
Designer Software 
 
The Welcome screen appears with 
project options. 
 
Select “New Project” 
 
Set your project board 
dimensions. 
Length: 14” 
Width: 14” 
Thickness: .75” 
 
Click OK 
 
 
ü DRAWING TOOLS 
 
Draw two circles using the drawing tool 
making one smaller than the other. 
 
Center both circle on the board. 
 
 
 
 
 
 
ü CARVE REGION 
 
 
You can make the carve region 
whatever depth you like. 
 
I selected the following:  
Larger circle depth:  .125” 
Smaller circle depth: .250” 
 
 
Notice that the center (smaller 
circle) does not show a carve region of 
.250”. 
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ü MERGE - SUBTRACTIVE  
 
Open your Carving List, if it is not by 
going to VIEW > CARVING LIST. 
 
Select the outer circle, right click on 
Merge Icon and select Subtractive. 

 
 
 
 
 
 
 
 
 
 
Now you can see the inner circle with 
a slightly deeper carving depth.   
 
 
 
 
 
 
 
 
 
 
 
Alternative uses of this same 
technique: 
 
 Both circles could actually have the 
same carving depth or the outer circle 
could have a deeper carving depth 
than the inner circle. 
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ü TEXTURES 

 
Select “Texture” tool.  
 
Texture dialog box appears displaying a 
variety of available textures. 
 
Select “Checkering1” and change the 
interval to .5” 
 
Click OK. 
 
Notice the texture is applied to both 
circles.  
 

ü CLIP CARVING 
 
Select both circles then apply Clip 
Carving – Exclusive  

 
 
 
Now you have your circle inside a 
textured circle. 
 
 
ü FINE TUNING 
 
I would do a few other things to this 
project before carving. 
 
HEIGHT 
I selected the following:  
Larger circle height:  40” 
 
 
ü GROUPING 
 
Group these two circles. 
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ü PATTERN PLACEMENT 
 
 
Place a pattern on the board. Not sure 
where I got this one, but it is nice. 
 
Select a pattern and place it on the 
board.  
 
Resize to fit where you would like it.   
 
Change depth to meet the inner circle 
- .250” 
 
Change feather to NONE. 
 
 
ü CLIP CARVING - INCLUSIVE 
 
With the pattern selected, right-click 
and select Clip Carving – Inclusive. 
 
 
 
 
 
 
 
 
 
ü TEXT TOOL 
 
Open your Text Tool and make your 
selections. 
 
I used the following: 
Font:  Monotype Corsiva 
Justify: Center 
Rout Mode: Centerline 
 
I added both lines of text to one screen, 
but added spaces before the word 
Friends to offset it slightly. When using 
multiple lines, it may be easier to 
manipulate if you do them as separate 
items, however getting the fonts to the 
same size is a bit trickier. 
  
Click OK. 
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ü CONFORMING VECTORS 
 
Because we are placing text over a 
carved region and Centerline by itself 
only works on the top surface of the 
board, I am applying Conforming 
Vectors. Centerline is a vector. 
  
With the vector (Centerline) selected, 
click on the Conform box. 
 
Resize and place where it looks best. 
 
 
ü CUT PATH 
 
Select outer Circle and click on Cut 
Path Tool.  Assign Maximum Pass 
Depth to .27” Flip Cut to cut outside of 
the path and Accept. 
 
I turned off my wood grain to see my 
project better. 
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ü SAVE & UPLOAD TO CARD 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card & Programmer are properly attached via your USB port, Select “File” > “Upload” to save 
to your memory card. 
 
Select Quality Setting  

 
Name Your Project  
 
Click “Upload” 
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This project covers the following design concepts: 
 
ü OPEN PROJECT 
ü DRAWING TOOLS 
ü REVOLVE TOOL (PATTERN MODELING SUITE) 
ü CUT PATH 
ü SAVE & UPLOADING TO MEMORY CARD  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LIGHTHOUSE 
WELOME PT 2 
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INSTRUCTIONS:  
 
ü OPEN PROJECT 
 
Open the CarveWright Project 
Designer Software 
 
The Welcome screen appears with 
project options.   
 

 
Select “Open Project” 
 
 
 
 
Browse to find the Lighthouse 
Welcome project. 
  
 
ü DRAWING TOOLS 
 
Draw a circle that is slightly larger 
than the inside circle. 
  
Center on the board. 
 
 
 
 
 
 
ü REVOLVE TOOL  

(Pattern Modeling 
Suite)  

 
 
Select the Revolve Tool, 
which will open a 
window at the bottom of your screen. 
 
 
 
This is a slice of the circle with the 
right side being the outer portion and 
the left side being the center of your 
circle. 
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ü ARC TOOL 
 
Select the Arc Tool (drop down menu 
with Circle tool) and draw an arc on the 
far right side.   
 
 
You will need to move the arc from the 
bottom to the top, by clicking on the 
yellow radius node and dragging upward.  
Place as desired or similar to as I have 
done. 
 
Click OK. 
 
 
Notice the result of the Revolve tool. 
 
 
 
 
 
 
 
 
 
 
 
 
ü TOGGLE OFF CUT PATH TOOL 
 

I am then going to remove the Cut Path 
on my design by selecting the outside 
circle and clicking on the Cut Path tool 
again to remove it. 
 
ü DRAWING TOOL 
 
Create a new circle that is slightly larger 
than the outside circle and center on 
board. 
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ü REVOLVE TOOL 
  
Repeat the arc on the outside circle. 
 
Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ü CUT PATH TOOL 
 
Reassign cut path tool to new outer 
circle. 
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ü SAVE & UPLOAD TO CARD 
 
Select “File” > “Save” 
 

*****IMPORTANT***** 
Once a project is uploaded to a memory card, it cannot be brought back from the memory card into the software.  
Always SAVE YOUR PROJECT on your hard drive.  A Projects folder is recommended and you should know where you 
saved it. 
 
ü UPLOADING TO MEMORY CARD 
 
Make sure your Memory Card & Programmer are properly attached via your USB port, Select “File” > “Upload” to save 
to your memory card. 
 
Select Quality Setting  

 
Name Your Project  
 
Click “Upload” 
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CHAPTER 4 – PROJECT DESIGNER 

PRO 
 

 

 

 

 

 

 

 

 

MATERIALS TOOL   

The Materials tool is like our Textures tool in that it applies a set background to 
the area selected but is much more advanced. This tool has several new 
background options that can be selected from and can be manipulated to fit each 
individual project.  

The Materials Tool can be used with any closed shape. If the new tool does not 
become available for a user created region, this typically can be attributed to end 
points not being connected. 

The math behind the Materials Tool is based on Perlin Noise, created by Ken 
Perlin, which was originally created for the movie industry to generate realistic 
looking back ground textures. For more information on the techniques please click 
on the following link http://en.wikipedia.org/wiki/Perlin_noise. 
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Currently there are ten default backgrounds: 

• Cloud Cover 

• Clouds 

• Concrete 

• Default 

• Martian Landscape 

• Sandstone 

• Stoney 

• Tree Bark 

• Water Surface 

• Weathered Wood 

BACKGROUND 
OPTIONS  
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The menu can seem a little daunting at first but through reading and understand 
this manual it can be easily worked. There are several options that can be set on 
the backgrounds and they are H Samples, V Samples, Octaves, Persistance %, 
Threshold, Scale, Blur, Noise Smoothing, and Cos Filter.  These options only 
become available on created backgrounds. To create a background, select the base 
background from the list of included backgrounds that best fits the project.  

 

Once the background had been 
picked select the Clone option to 
create a new customizable option. 
Once the new background had 
been created it can be renamed 
so that it can easily be called from 
the list. After renaming the 
pattern it can be modified to fit 
the project.  The rest of the 
options should be experimented 
with to gain an understanding of them. 

 

 

MAKE VECTOR GROUP 
 

The Make Vector Group, introduced in Designer 3.0, is a tool that allows vector 
drawings to be carved with a V-bit which emulates the chip carving technique. 
These vector drawing can either be created in the Designer Software or imported 
DXF as files.  To begin using the tool, first place the set of closed loop vectors on 
the board.  All vectors must be closed and cannot intersect. If the regions intersect 
at any point, the tool will fail to open and an error message will be displayed 
(Members of a Vector Carving Group may not intersect). The intersecting vectors 
can be fixed or deleted in the Designer software and the Make Vector Group can 
be attempted again. If the any vectors are open, the tool will be gray and not 
accessible.  Select all vectors desired for the design and group them together using 
the Group function. Select the vectors in the newly created group and select the 
Make Vector Group icon. This will open a new window for the tool.   

The first option to be set is the vector selection mode. This can be set to Toggle, 
Alternate, or All.  Toggle allows each individual vector of the group to be selected 
or deselected, as needed.  Alternate will select alternating vector loops, starting 
from the single vector loop selected by the user.  All will select all of the vectors in 
the group. Use the All selection mode in conjunction with the Toggle mode to 
create custom vector configurations. When selecting vectors, check to ensure that 

MATERIALS 
MENU OPTIONS 
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the regions are not too close together, or too thin, to avoid chip-out in the finished 
carving.  Once the carve areas have been set, a bit will need to be selected. The 
default bit is the 90° V-bit, but the 60° V bit can also be selected. With a bit 
selected, press the OK button to apply the bit and view the resulting carving on the 
board. If alterations need to be made, select the group from the carving list and 
click the vector group icon to re-enter the tool. It is important to note that it is 
required that the tool be opened every time a change is made to the vector group.  
The carving will not automatically update until the tool is opened. 

 

PATTERN ALONG TRAJECTORY TOOL 
 
Similar to the Decorate with Text Tool, the Pattern Along Trajectory tool will apply 
a repeating pattern of carved elements to a selected path on the project board. 
This tool allows for the creation of many exciting projects that have been difficult 
or impossible up until now. It is important to note the two ways in which the word 
pattern is used in this document.  First, the Pattern Along Trajectory tool implies a 
pattern of repeating and evenly spaced elements (or instances) along a path.  The 
elements used in this repeating pattern can also be referred to as patterns.  These 
are the same patterns that can be found in the libraries that are used in the 
Designer software.  
 
Conceptually this tool is very simple.  First a path (or trajectory) is created and then 
up to two carvings are selected to be repeated along that path.  The trajectory can 
be any line, spline, arc, circle, square, or path that can be drawn with the Designer 
tools. Trajectories do not have to be closed shapes or have straight lines. Start by 
drawing the shape or path that the repeating pattern is to follow. The trajectory 
can be modified at any time, but modifying the shape or size of the path after the 
patterns have been applied can lead to changes in the spacing of the repeated 
carvings.  
 

When drawing the trajectory it is important to note and remember what point was 
drawn first.  This first point will always be the start point of your trajectory and will 
be the point on which the first instance is placed.  All indenting measurements will 
also use this point as reference.  For example, if a straight line trajectory was 
drawn from right-to-left, the start point of the trajectory would be its right 
endpoint and the first instance would be placed there.  Conversely, if the trajectory 
was drawn from left-to-right then the trajectory start point would be placed at the 
left end. 
 

CREATING A 
TRAJECTORY 
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Once the path is drawn and selected, enter the select Pattern Along Trajectory 
tool by clicking on the tilted orange shell icon.  Another window will open showing 
the board with a dashed line representing the trajectory.  The controls for 
positioning and spacing the carved elements along the trajectory are displayed 
along the bottom.   

 
From here there are several inputs needed in order to fully specify the final 
pattern.  We will summarize them here and then discuss then in greater detail later 
in this document. 

 
1) Select the pattern, or patterns, to apply to the trajectory from the pattern 

library. 
2) Adjust the size of the pattern and the rotation angle. 
3) Specify how many instances of each pattern will be placed on the 

trajectory.  There are two ways of doing this. The first is by specifying the 
total number of instances and the second is by specifying the spacing 
between each instance. Given only one of these two inputs the software 
will calculate the other. 

4) Specify where the final grouping of carvings should start along the 
trajectory.  The options are to start the pattern at the trajectory start point 
or to center the entire grouping on the center point of the trajectory’s 
length.  This can be thought of like text justification, where left justify 
pushes a string of characters to the left margin of a column and center 
justify centers the string in the column.  

5) Set an indent value.  If the pattern is not centered then there is and indent 
control that allows the pattern to be moved along the trajectory away 
from the start point.   

6)  Apply an offset distance to the pattern grouping either above or below the 
drawn trajectory path.  Both positive and negative numbers are allowed in 
this field and determine whether the pattern will move above or below the 

APPLYING THE 
CARVING 
ELEMENTS TO 
THE 
TRAJECTORY 



 

Page 207 of 242 
 

path.  It is important to note that a negative number will not always move 
the pattern in the same direction for every trajectory (sometimes it may 
move it above the line and sometime below). 

7) Decide how the offset distance should be determined.  There are two 
modes that will be discussed below, one using the original trajectory and 
spacing to set the position of the offset pattern and the second using a 
internally generated offset trajectory. 

8) Set the tilt of the carvings into and out of the board. This is similar to the 
tilt feature in the Designer software and allows for interesting layering 
options. 
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Begin by finding and highlighting the carved pattern to be added onto the 
trajectory from the library (just as would be done if a pattern was placed on the 
board in a typical fashion).   Once the pattern has been selected, click the Add 
button in the bottom left corner of the screen. A small picture of the selected 
pattern will now be displayed next to the Add button. You can add up to two 
patterns to the trajectory by selecting a second pattern and hitting Add again.  

 
An outline of the 
pattern now appears 
along the trajectory.  
After the pattern has 
been added new 
options will become 
available. These 
options include 
Count, Spacing, 
Center Patterns on 
Trajectory, Indent, 
Offsets Before 
Projection, Offset, H 
Tilt, and V Tilt.  
Clicking and dragging 
the outline allows for 

placing the first instance in any location along the trajectory (right/left as well as 
above/below). The Offset and Indent features can also be used to alter the 
position of the instances.  The standard Depth, Height, Angle, and Size tools are 
also available but are discussed in other CarveWright documentation.  

 

APPLYING A 
PATTERN TO 
THE 
TRAJECTORY 
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The number in the Count input field determines how many instances of a pattern 
will be placed along the trajectory (including the initial instance). The software 
calculates the length of the drawn trajectory and automatically calculated the 
spacing based on the number of instances entered. 

 
Conversely, if a 
number is 
entered into 
the Spacing 
input field, the 
number of 
pattern 
instances is 
adjusted based 
on how many 
can fit on the 
trajectory 
length with the 
given the 
spacing. The 
spacing can 
also be adjusted if a count is entered without altering the count as long as they can 
all fit on the trajectory (i.e. smaller spacing). 

 

 
 
 
 
 
 

SPECIFYING THE 
NUMBER OF 
INSTANCES IN 
THE PATTERN 
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The Center Patterns on Trajectory checkbox allows for the pattern group to be 
centered along the length of the trajectory.  Normally the box is unchecked and 
will align the instances to start point of the trajectory.  If however centering the 
instances on the trajectory is desired, simply check this box.  This function also 
works when the instances are placed above or below the trajectory. 
 

 

 
If the grouping is not centered, Indent allows for moving the pattern group along 
the trajectory.  If the trajectory is open (e.g. a line or spline) the center of the first 
instance is placed on the starting point of the trajectory.  Indenting the object will 
shift the pattern along the curve in the direction of the trajectory end point.  Only 
positive numbers are 
allowed in the 
indent field. 
 
 
 
 
 
 
 
 
 
 
 
 
 

SPECIFYING 
WHERE THE 
PATTERN GROUP 
IS PLACED ON 
THE 
TRAJECTORY 
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On a circle, the initial instance will be positioned at three o’ clock, and as the 
indent is increased the pattern moves clockwise around the circle. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The Offset field 
determines how 
far the center of 
the pattern lies 
above or below 
the trajectory 
path.  Positive and 
negatives number 
are allowed in this 
field.  In the case 
of an open 
trajectory (one 
with beginning 
and ending 
points), if an 
instance resides 
on either 
endpoint it can flip orientation if it is offset. If this happens simply indent the 
instance or change the spacing. 
 
 
 

 
 
 
 

SPECIFYING THE 
PATTERN GROUP 
POSITION 
ABOVE OR 
BELOW THE 
TRAJECTORY 
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The Offsets Before Projection checkbox lets the user chose how to position of 
offset instances.  Normally, the box is unchecked.  In this case the software creates 
a new hidden trajectory path offset from the drawn trajectory by the entered 
amount.  It then calculates the length of this new path, calculates the new spacing 
given the Count, and places the center of each instance along this path with the 
new spacing.  As you can see the instances follow a perfectly offset path and have 
equal spacing. 
 

 
 

 
If the box is checked, the software simply moves along the drawn trajectory to the 
point determined by the spacing, calculates a normal to the path at this point and 
then moves exactly the offset distance along that normal to place the center of 
each instance.  In this case you can see that in the parts of the trajectory with tight 
curvature, the 
instances are 
placed in 
different 
locations because 
of the slope 
normal to curve 
at the location 
points.  
 
 The difference 
between these 
two offset 
methods is 
usually only seen 
when the trajectory is very bumpy and folds back on itself. We encourage you to 
experiment with all of these options in as many different and interesting ways as 
you can. 
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The H Tilt will tilt the pattern along its vertical axis into and out of the surface of 
the wood.  The tilt indicator will be displayed by a green arrow inside a circle 
showing the direction of the tilt. On a circle starting at the original three o’ clock 
position, the H Tilt with tilt the top of the pattern down into the wood.  
 

 
 

Similarly, the V Tilt will tilt the pattern along its vertical axis (displayed by a green 
arrow inside a circle showing the direction of the tilt). On a circle starting at the 
original three o’ 
clock position, 
the V Tilt with 
tilt the left side 
of the pattern 
down into the 
wood. 
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The Preview button will show the patterns being assigned to the trajectory as they 
will look when carved. This helps with spacing when considering feathering.  
 

 
 
 
The Depth, Height, Angle, and Size tools will function the same as they would with 
a standard pattern addition. Once the patterns are set click the OK button and the 
pattern will be applied to the project and be ready to carve. To edit any part of the 
Pattern Along Trajectory parameters simply select one of the instance on the 
board and click the icon again. 
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CHAPTER 5 – THE IMPORTERS 
 
There are two additional importer options for Project Designer sold separately as 
add-on modules.  These are the DXF Importer, and the STL Importer. This section 
will cover the use of both of these. First, lets learn some basics about the files that 
these importer work with. 

 

DXF IMPORTER 
 

DXF (Drawing eXchange Format) 
is a vector graphic file format 
typically used with AutoCAD 
software. It can, however, be 
read and exported from most 
vector drawing programs, such as Adobe Illustrator and CorelDraw. DXF files 
contain only vector line/path information, which enables these drawings to be 
imported into Designer as drawn lines, rather than pattern shapes. 

 

DXF files can be generated by most vector drawing software.  There are many that 
can be found online by searching for DXF files or any other vector formats.  Vector 
clip art is readily found online for free and can always be converted to DXF format. 

 

If you are working in another vector drawing program, any vector file format, such 
as EPS, AI, and CDR files, can be opened in their respective packages and converted 
by using the export or save as functions. 

 

To learn how to use the DXF Importer, it is easiest to watch the tutorial videos 
available online here: http://www.carvewright.com/add-on-modules/DXF-
importer/  

DXF FILE 
FORMAT 

GETTING DXF 
FILES 

MAKE YOUR 
OWN DXF FILE 
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STL IMPORTER 
 

STL (STereoLithography) is a 3D 
file format supported by most 
3D software packages.  It is the 
standard file format for 3D 
printing and other forms of 
computer aided 
manufacturing.  Any 3D file can be exported or converted to an STL format. 

STL files can be generated by most 3D design software.  There are many that can 
be found online by searching for 3D models or visiting model sharing sites. 3D files 
that are not in STL format can be converted using a conversion program. 

If you are designing your own 3D files, the software you are using should have an 
export to STL option.  If you are finding models online and wish to convert them, 
there are free conversion programs that can convert from most formats. 

To learn how to use the STL Importer, it is easiest to watch the tutorial videos 
available online here: http://www.carvewright.com/add-on-modules/STL-
importer/  

 

 

  

STL FILE 
FORMAT 

GETTING STL 
FILES 

MAKE YOUR 
OWN STL FILE 
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CHAPTER 6 – THE SUITES 
 

There are two additional tool bar suites for Project Designer sold separately as 
add-on modules.  These are the Vector Drawing Suite, and the Pattern Modeling 
Suite. This section will cover the use of both of these.  

 

VECTOR DRAWING SUITE 
The Vector Drawing Suite (2D Advanced) is a tool bar add-on for Project Designer 
that expands the drawing and vector manipulation capabilities of the 
software.  Define vector paths quickly, trace images, trim and merge vectors 
together, and many other features that assist in creating your own drawings. 

 

The Smart Spline tool is the most powerful 
drawing tool available to Project Designer. It 
allows you to quickly define a shape by placing 
points, or vertexes, along a path, while on-the-
fly designating the segments between as either 
lines or curves. 

 

SMART SPLINE 
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The Trim Tool serves as a way to merge 
intersecting vectors by allowing you to delete 
overlapping segments and join closed vector 
shapes together. As an example, to make a 
cross, you could draw 2 rectangles 
overlapping, and then use the trim tool to 
remove the interior lines to create one 
continuous cross shape. 

 

The Offset Path tool is used to generate a path 
either inside or outside of an closed vector path 
at a specified distance. So, for example, if you 
wish to create an outline around a shape you’ve 
drawn, but you want it a half an inch larger all 
the way around, this is the tool you would use. 

 

 

 

The Copy Offset tool allows an object on the 
board to be copied either vertically or 
horizontally a give number of times with a given 
spacing. If you need to make multiple’s of a 
pattern, or even a tiled repeating pattern, this 
tool makes it quick and easy. 

 

Import Tracing Image allows for an image file 
(jpg, png, gif, bmp) to be imported and placed 
on the design board to be used as a pattern for 
tracing with the drawing tools. The image can be 
cropped and scaled during the import process to 
suit your needs and can be toggled on and off to 
better view your drawing. 

TRIM TOOL 

OFFSET PATH 

COPY OFFSET 

IMPORT 
TRACING IMAGE 
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The drawing tools offer several types of 
segments, including; line, spline (curve), and 
arch.  The Change Form selector tools allow you 
to quickly change segments to the selected 
form by simply clicking on them.  Select the 
Change to Line Tool and click on any spline or 
arch and it will change to a line, or vice versa. 

 

 

The points (vertexes) between the segments 
have two states, either tangent or 
free.  Tangent means a curved segment on 
either side of a point will be locked into the 
angle of the segment on the other side. The 
“free” state means the segments are not locked 
into the previous segments influence.  This tool 
allows for quickly changing those states for 
more control over defining your drawings. 

 

To see how to use all of the tools from the Vector Drawing Suite, watch the videos 
available online here: http://www.carvewright.com/add-on-modules/vector-
drawing/  

CHANGE FORM 
SELECTORS 

CHANGE 
TANGENCY 
SELECTORS 
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PATTERN MODELING SUITE 
 

The Pattern Modeling Suite (3D Advanced) is a tool bar add-on for Project Designer 
that enables modeling of 3D relief patterns. Extrude, sweep, and puff shapes into 
dimensional creations. These tools are easy-to-use and they make your own 
custom pattern designs fun and simple. 

 

The puffing tools allow closed vector shapes to 
be raised up or puffed in four different styles; 
Curve, bevel, flat and bubble. The steepness of 
the sides and depth of puffs can be adjusted to 
suit. 

 

 

 

The Sweep tools will allow a drawn profile to 
be swept along a single vector path. This 
means the profile will follow the line along it’s 
entire length.  There are two types of sweeps, 
rounded, which will round corners, and corner, 
which leaves sharp corners. 

PUFFING TOOL 

SWEEPS 



 

Page 221 of 242 
 

 

The Extrude tool allows a profile to be extruded 
along the inside of a closed vector shape.  The 
angle of the extrusion can be adjusted by 
setting horizontal, vertical, or setting a custom 
angle. 

 

 

 

 

The Revolve tool will rotate a profile around 
the center-point of a circle. The revolve tool 
only works with circles. 

 

 

The Tilt tool allows a pattern to be tilted 
vertically, horizontally, or a combination of both 
can be used to achieve different angles. 

 

 

 

 

The Sweep with Rails tool is a more dynamic 
sweep in that it uses two curves (rails). These 
two curves define the two edges of the surface. 
Then a profile is defined for the surface’s cross 
sections. 

 

To see how to use all of the tools from the Pattern Modeling Suite, watch the 
videos available online here: http://www.carvewright.com/add-on-
modules/pattern-modeling/   

EXTRUDE 

REVOLVE 

TILT TOOL 

SWEEP WITH 
RAILS 
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CHAPTER 7 – PATTERN SCULPTOR 
 

Pattern Sculptor is a creative sculpting and editing tool for 3D relief carving 
patterns. Quickly and intuitively smooth, smudge, and add or remove details to 
prepare patterns for carving. 

 

USES FOR PATTERN SCULPTOR 
Whether it’s a scan made 
with your Scanning 
Probe, a pattern made 
with the Modeling Suite, 
or an image or pattern 
imported from 
elsewhere, these tools 
allow for quick and 
seamless editing to 
correct or alter the 
original artwork. 

 

 

Sometimes, there are 
details you need in a 
pattern that you just can’t 
get with the existing tools 
in Designer or other 
packages. With Sculptor, 
those details are a few 
mouse clicks away. Sculpt 
in fine details, raise and 
lower specified areas, 
erase parts you don’t 
need, and so much more. 

 

 

CLEAN UP 
PATTERNS 

ADD OR REMOVE 
DETAILS 
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With so many free 3D files 
available these days, it’s 
nice to be able to 
transform them into 
useable relief patterns. 
With the Sculptor tools, we 
can make a 3D model flat 
and enhance it to bring out 
the important details. 

 

 

 

 

 

To learn how to use the Pattern Sculptor Tools, watch the videos available online 
here: http://www.carvewright.com/add-on-modules/pattern-sculptor/  

 

 

MAKE 3D TO 
RELIEF 
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CHAPTER 8 – ACCESSORIES 
 

SCANNING PROBE 
The CarveWright Scanning Probe opens up the 
world of 3D scanning to anyone. Now you can 
reproduce original pieces, repair antique 
furniture, even copy trim and moldings with 
ease. Almost any material can be scanned, 
even soft materials, such as clay or wax. Just 
plug the probe into the CarveWright, set the 
desired scan area, and watch the CarveWright go to work. 

 

The Scanning Probe can be used with either the Quick Change Chuck (QC) or 
CarveTight Spindle system. For the CarveTight, simply insert the straight bushing all 
the way into the machine spindle and tighten the grab paw just like you would 
when using a 1/2" shank bit. If you have upgraded to the CarveTight spindle, 
remove the tapered adapter and press the straight bushing down to within 0.25” 
of the probe body (See Figure 3).  

If you have a QC the Scanning probe will install just like any other bit with a 
tapered adapter. Please follow the dire ctions described below. Before installing 
the scanning probe into the QC, lift up the front safety cover and make sure that 
there are no other bits installed. Next, make sure that the quick release chuck is 
cocked and ready to accept the adapter mounted to the probe.  

To cock the chuck, place a 
thumb on the Z-Truck Grip 
Ridge and two fingers on the 
Chuck Release Flange. Press up 
on the chuck release flange as 
far as possible and release (See 
Figure 4). The flange will snap 
and stay up when the chuck is 
prepared to receive the probe 
assembly. Any time difficulty is 
encountered inserting the 
probe, simply pull up on the 
flange to insure the chuck is cocked. Press the probe assembly into the chuck until 
a slight snap is felt. The probe is now secure in the quick change There are two 

INSTALLATION 
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possible connector locations for plugging in your scanning probe depending on the 
configuration of your machine. For most machines that have an A-series Serial 
Number, the probe plugs directly into the Z-Truck mono receptacle. 

 

All C or B-series Serial Number CarveWright machines, and any A-series Serial 
Number machines that have been reconfigured, will plug into an accessory 
connector found on the left side of the head cover as shown below. Reconfigured 
A-series machines have the homing sensor board removed or unplugged. This 
configuration requires that a jumper cable be used to span the distance from the 
probe cable to the cover connector. A cable clip is loosely attached to the cable to 
manage the cable during the scanning operation. This cable and clip are now 
provided with the probe at the time of purchase but you ma y need this cable if; 1) 
you have an A serial machine, 2) you purchased your probe before November 1, 
2008, and 3) the machine has been reconfigured by removing or unplugging 
homing sensor board. 
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To install the probe using the cover connection, simply plug the jumper cable into 
the cover connector and slide the cable clip over the front lip of the head casting. 
The clip needs to be approximately centered left to right in the machine. Next, plug 
the probe mono jack connector into the other end of the jumper cable. Make sure 
that the cable clip allows enough slack for the probe to move fully left to right by 
pushing the truck to the left/right sides of the machine with your hand. The probe 
is now installed. 

Since there are two possible locations to connect the probe, the connection 
location must be set in the machine’s memory via the Options menu through the 
machine keypad. The B-serial number CarveWright machines are configured to the 
correct setting at the factory, but this setting must be changed if the homing 
sensor board is eliminated or unplugged from the reconfigured A-series machines. 
If this setting is not changed, “Scan Area” will be displayed on the LCD screen even 
though there is no probe connected. To change this setting, do the following: 

1. Insert the card and turn on the machine. “Scan Area: should appear on the 
LCD screen. 

2. Press the “0” (Options) key on the keypad. 
3. Using the up/down arrows, scroll down to the number 5, “User Options” 

menu item and press ENTER. You can also simply press the “5” key when 
the first option appears. 
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4. Scroll down to Scan Probe. Make sure it is on “Cover” instead of “Z truck”. 
Press ENTER to toggle between the options. 

5. Press stop until you get back to main menu. It should say Project Menu. 

 

Insert the probe plug into the jack located on the Z-Truck. If the probe is correctly 
installed the CarveWright machine will recognize it when the cover is closed and 
power is turned on. The scanning functionality can now be accessed through the 
keypad. 

Once the machine is configured and turned ON, it will search to see if the scanning 
probe jumper cable is plugged into the accessory connector. If it is, the machine 
assumes that the user has inserted, or will insert, the scanning probe into the quick 
release chuck and disables the spindle motor from spinning. Pressing ENTER at the 
“Scan Menu” will move the spindle to the home position. Once at the home 
position, the machine will check to see that the probe is plugged in and operating 
correctly. 

When the probe is at rest (not touching anything), it should be in the electrically 
Closed position. If the probe is operating correctly, the LCD will prompt you to “Jog 
to the Starting Corner”. If however, the machine detects that the probe is not in 
the Closed position, the LCD will prompt you to “Check Probe and Connection” and 
will show you the current state of the probe as Open. In most cased this simply 
means that the probe is not plugged into the jumper cable correctly. Check all 
connections and move the tip of the probe around watching to see if the state 
displayed on the LCD changes to Closed. If you cannot resolve this issue by 
plugging and unplugging, please call CarveWright service at 713-473-6572. 

When removing the jumper cable remember to depress the release latch before 
pulling it free. On some machines the latch may be on the bottom of the 
connector. 
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Important Note: It is recommended that you unplug your flexshaft from the 
spindle if you are doing significant scanning. It makes for more consistent scans. Be 
sure to always follow the directions when reassembling the flexshaft so that you 
do not bind the flexshaft core and damage the machine. 

 

 
Because most objects that will be scanned are not suitable for scanning directly 
they will have to be placed onto a fixture called a scanning sled before proceeding 
(not included with purchase). The scanning sled should be designed so that the 
CarveWright can easily feed it through the machine and so that the scanning probe 
has the proper clearances to function. 

 
The dimensions of the sled can vary but the maximum width is 14.5” and the 
maximum depth is 2.25” from the mounting surface to the top of the rails. There is 
no maximum length but any sled over 3 feet long will require additional stand-
alone outfeed support rollers. The support rollers should be adjusted properly to 
avoid letting the sled sag or rise, as any transition going on and off the rollers will 
be reflected in the scan data. 

The vertical rails must be at least as high as the object being scanned. If the object 
is taller than the vertical rails the machine or object can be damaged.  

The maximum height that the scanner body can clear is 1 inch. If the object to be 
scanned is taller than 1 inch in any location, check for possible interferences 
between it and the probe body. Interference is possible if there is a 1 inch tall point 
in the object within 1 inch of a portion of the object that lies at a depth near the 
mounting surface.  

PLACING 
OBJECT ON A 
SCANNING SLED 
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The scan object can be mounted to the sled with any number of adhesives. Hot 
glue works well, as does double sided tape. It is important that the scan object be 
rigidly mounted. Any movement during scanning will produce poor scan data. It is 
also suggested that the mounting surface of the sled be very smooth and hard (like 
Formica). This hard surface makes mounting and removing the scan objects quick 
and easy.  

The CarveWright will require that the sled be kept under rollers at all times so 
make sure that the object being scanned is at least 3.5 inches from either end of 
the sled. The scan object must also be at least 1 inch from either vertical rail to 
clear the body of the probe. 

 
Adding a grid pattern to the mounting surface of the sled surface makes 
positioning the scan object very easy. 

 

 
For the purposes of this manual we will assume that all pieces being scanned will 
be mounted to a scanning sled. Proper installation of the scanning sled is critical to 
the performance and continued operation of the scanning probe. To properly 
insert the sled: 

 

1. Press down on the sliding guide plate release lever and move the sliding 
guide plate to the right so that it will clear the width of the sled. 

2. Check the bottom of the sled for features that will make it unusable in the 
machine. The bottom surface of the sled where it contacts the squaring 
plate must be flat and level for a width of at least 3/8 inches along the 
bottom edge to allow the Board Tracking Sensor to accurately calculate the 
position of the workpiece at all times (see Figure 7). 

3. Lay the sled on the traction drive so that it is centered lengthwise under 
the head. 

4. Push the sled firmly up against the squaring plate. 
5. Gently push the sliding plate up against the inside edge of the sled. DO 

NOT push the sliding plate against the sled with significant force. The 
sliding plate is used to guide the sled and is not intended to lock the piece 
in position. 

6. At this point it is critical that you assure that the sled can travel freely in 
and out of the machine along its entire length without binding or 

INSERTING THE 
SCANNING SLED 
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encountering significant drag. Do this by moving the sled in and out of the 
machine by hand, while laying flat on the traction drive. 
 
WARNING: Do not attempt to load a sled that varies in height by more 
than 1/16” along its entire length. This condition could bind the machine 
and damage the traction drive. 
 
WARNING: Do not attempt to load a sled that does not have parallel 
sides. This condition can bind the machine and damage the traction 
drive. 
 

7. Lower the head by turning the head crank handle counter-clockwise until 
the clutch clicks several times (at least 5 clicks recommended). The clutch 
is intended to load the sled against the traction drive with consistent force. 

 

8. Rotate the head-locking lever outward into the locked position. The sled is 
now secure. 

9. Make sure that the top safety cover is closed before proceeding. 
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Before the CarveWright can begin to function, the CarveWright memory card must 
be installed. With the power off, push the memory card gently into the memory 
card slot until it stops, making sure the label is up. Once the sled is installed and 
the cover is closed, proceed to turn the machine on. 

 

At this point, control is accessed through the Keypad and LCD Display. The scan 
utility will automatically sense the scanning probe and will display the Scan Area 
menu item. 

 

When the Scan Area item has been selected from the display menu, the 
CarveWright will send the head to the home position. The display will then prompt 
for the user to specify the starting corner of the scan area.  

The scan area is determined by specifying any two diagonal corners of the scan 
object. The user will need to jog the probe tip to the first corner point using the 
arrow keys. This is accomplished using the up and down arrows on the keypad to 
move the truck across the width of the sled (near to far), and the left and right 
arrows to move the sled along its length (left or right). 

 

JOGGING THE 
SCANNING 
PROBE 

SETTING THE 
SCAN AREA 
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Holding an arrow key down results in a fast movement. 
Precise final positioning is accomplished using short bumps 
on the key.  

Once the probe tip has been jogged to the desired corner location press ENTER. 
The probe tip will now slowly lower until the tip touches the surface. Verify that 
this is the correct location and press ENTER again. You can continue to tweak the 
tip location if it is desired before pressing ENTER. Repeat these steps for specifying 
the second corner. 

Once both corners have been specified the display will show the Scan Options 
menu. The current scan quality will be shown in parentheses. The Scan Options 
menu has three options: 1) Proceed with Scan, 2) Change Quality, and 3) Set Max 
Depth. If you wish to continue with the scan at this point select option one, 
Proceed with Scan.  

If you wish to change the quality setting select option two, Change Quality. Use the 
up/down arrow keys to find the desired quality and select ENTER to confirm. 
These quality modes affect the step size for each point measurement taken. The 
higher the quality mode selected, the smaller the step size. The Best setting step 
size is .010”, the Normal setting step size is .020” and the Draft setting step size is 
.040”. It is recommended that scans be performed at the highest possible quality 
setting if time permits. 

The machine will check the memory card to verify that there is enough 
space to store all of the scan information. An empty memory card can 
hold approximately 2.2 ft2 of Best quality mode scan data. If the 

message Scan Too Large For Card appears on the display then there is not enough 
room to store the proposed scan. Options to correct this situation are to reduce 
the size of the scan area or delete existing information on the card using the Flash 
Manager in the CarveWright Design Software.  

After the quality mode has been confirmed the CarveWright display will show the 
Scan Option menu again. There are instances where the maximum depth of the 
scan will need to be limited. For example, in some scanning probe, this can cause 
the body of the scanner to impact the object and stall the scan. The Set Max Depth 
option allows the user to put a floor on the depth that the probe tip will reach. The 
procedure for setting the max depth works very similar to setting the corners of 
the scan area. Identify the desired max depth on the scan object surface. Jog the 
probe tip to a point directly over this location and press ENTER. At the chosen 
location the probe will lower until it makes contact with the surface. By default this 
depth will now be the maximum scan depth. If this depth is acceptable select 
ENTER otherwise reposition the probe tip and repeat.  

SETTING THE 
SCAN OPTIONS 
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Once a max depth has been confirmed the display will prompt the user to Use 
Selected Depth or Apply Offset. If the Apply Offset option item is chosen, the user 
is prompted to input a numeric offset using the keypad. Select ENTER to proceed 
or STOP to cancel the offset. The entered offset will be added to the already 
confirmed max depth. Once the desired settings have been set, proceed with the 
scan by selecting Proceed with Scan. The CarveWright will begin to scan the object. 
The scanning probe tip will follow along the object contour, mapping the 3-D 
coordinates of the surface as it proceeds. The height map information is stored 
onto the memory card for future retrieval by the scanning software. A real time 
scanning completion estimator will be displayed on the LCD and provides an 
estimate of how much of the current scan is completed. 

At any point during operation the CarveWright machine can be stopped 
by pressing the STOP key or by lifting the cover. If desired the machine 
can be restarted by closing the cover and pressing ENTER. The machine 

will resume scanning at the point where it was stopped. If you press the stop 
button a second time the scan will be aborted so be careful when restarting your 
project. 

WARNING: Never remove the memory card from the machine while it is on. 
Doing so can result in damage to the workpiece. 

 

When the scan is completed the LCD Display will show a prompt to set another 
scan area. If you do not wish to produce another scan, turn off the machine, lift the 
top safety cover, release the head lockdown lever, and crank the head up to free 
the sled. The sled can then be removed. 

 
Remove the CarveWright memory card and place it into the CarveWright memory 
card programmer. Open the CarveWright Design software and access the scan data 
by selecting the Download Scan menu item on the File menu. 

MAXIMUM SCANNING DEPTH is 1.0 inch. Scanning objects deeper than this can 
damage the probe or produce poor quality scans. 

ALL MOTORS ARE DISABLED when the front safety cover is open. The cover must 
be closed before the machine can proceed. 

USE A SUPPORT FOR LONG PIECES TO BE SCANNED AND ALSO FOR SCANNING 
SLEDS. To minimize the risk of over stressing the machine, use sturdy roller stands 
(not included) for support when scanning long pieces more than 36 inches in 
length. 

ACCESSING THE 
SCAN DATA 

GENERAL TIPS 
AND HELPFUL 
REMINDERS 
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WHEN LOADING THE PIECE TO BE SCANNED, there are several critical checks to 
make before proceeding. 

• Do not attempt to load a piece to be scanned (or sled) that has a 
significant taper to the sides. A tapered workpiece will bind between the 
sliding plate and the squaring plate and will damage the traction drive. 

• Do not attempt to load a piece to be scanned (or sled) that varies in 
thickness by more than 1/16” along its entire length. Using a workpiece 
with a larger thickness variation than 1’16” can lead to damage to the 
machine. 

• Always make sure the Board Tracking Sensor that contacts the bottom of 
the workpiece (or sled) has a smooth, even surface to follow. This means 
that the bottom edge area of the workpiece adjacent to the squaring plate 
is clean, smooth, and even for a width of at least 3/8 inch along the full 
length of the workpiece. 

• Warped, bowed, or cupped pieces should be used only if this condition is 
minor and if the Board Tracking Sensor can follow it. 

 

MAKE SURE THAT THE HEAD LOCKING LEVER IS RELEASED after finishing the scan. 
If the locking lever is not released the head will not move up and down. The lever 
is in the locked position if it is rotated out from the face of the machine. It is in the 
released position if it is flush to the front face of the head. 

SMALL PIECES TO BE SCANNED MUST ALWAYS USE A SCANNING SLED. Any piece 
to be scanned smaller than 1.5 inches wide x 0.25 inches thick x 7 inches long will 
require it to be placed on a scanning sled. 

TO LOCATE THE MACHINE TOTAL SCAN-TIME, use the Options shortcut key on the 
keypad to access the information. 

TO LOCATE THE SERIAL NUMBER, use the Options shortcut key on the keypad to 
access the information. 

UNPLUG THE FLEXSHAFT, for more consistent results. 
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Use these drawings to build a scanning sled. 

 
 
 
 
 

BUILDING A 
SCANNING SLED 
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ROTARY JIG 

 

CARVING IN THE ROUND: A REVOLUTIONARY IDEA

The Rotary Jig, and accompanying software, enables the design, import, 
and carving of turned projects.  It’s like a lathe, but with carvings. The 
rotary software, included with purchase of the jig, shows the carved 
round piece along side a �at board where the design is manipulated.  The 
jig is simple to use.  Load your material in, calibrate the jig, and carve your 
pieces in the round.  With the STL Importer add on, you can even import 
STL’s directly into the rotary format. Now this is truly revolutionary.

Follow the guide on the following pages and watch the tutorial videos 
online for more information. 
http://www.carvewright.com/accessories-page/rotary-jig/

http://www.carvewright.com/accessories-page/rotary-jig/


Rotary Jig and Material Setup

Congratulations on your purchase 
of the Rotary Jig accessory for 
your . We 

hope you will enjoy your new 
capability of carving in the 
round! 

This document outlines the basic 
setup and use of the Rotary Jig for rotary 
carving. Visit carvewright.com to view 

“ video tutorials for  creating 
your own custom rotary 
projects using the Designer 
software and software add-on 

enhancements.

You will need to own the CarveWright 
1/8 Long-Reach Carving Bit for use with 
your Rotary Jig. This bit is specifically 
designed for the rotary jig and for deep 
carving of “flat” projects. (fig. 1)

Jig Material Size Requirements

CarveWright machine

how-to” 

"

Material Diameter Specifications
The jig requires material with a minimum 
diameter size of 1 "up to a maximum of 
4.25 " diameter. (fig. 2a, 2b)

Material Length Specifications
The jig requires material with a minimum 
length of 5.5 " to a maximum  length of 13 " 
(fig. 2c)

CarveWright Tutorial

IMPORTANT:
Measure across the widest diameter of your 
stock. This OUTER diameter is what you 
will need to remember when it comes time 
to input the diameter measurement at the 
machine during project runs. 

Rotary Carving Accessory for CarveWright™ CNC Machines

04/2014
www.carvewright.com

Rotary Carving!

Basic Instruction

fig. 1 1/8 "Long-Reach Carving Bit
 

Rotary Jig
 

1 inch
min diameter

4.25 inch
max diameter

fig. 2a

Stock shape can be:

Square Corner Cut Round

(cont.)

(outer dia. never to exceed
4.25 " nor be less than 1")fig. 2b



fig. 3f

fig. 3e

Jig Material Size Requirements (cont.)

Mounting the Material Into the Jig

Drill holes at the center mark on each end about ½"  
7deep using a /32" drill bit. (fig. 3c)  

Cut your material to the appropriate length, then mark 
the center-point on both ends. A clear plastic center 
marking template is handy for this (especially for round 
stock), but not absolutely necessary. (fig. 3a, 3b)

(cont.)

Page 2

(cont.)

T

Slide the end panel to the stock and align the tailstock 
point into the drilled hole. 

Tighten the wing nuts “finger tight” so it holds the 
stock snugly, but can still rotate freely. (fig. 3f)

hread the stock onto the screw chuck. (fig. 3d) 

(fig. 3e)

Rotary Jig and Material Setup

CarveWright Tutorial
www.carvewright.com

fig. 2c

fig. 3a fig. 3b

fig. 3c

fig. 3d



Mounting the Material Into the Jig (cont.)

On the belt drive end of the jig, you will see a trough 
on the outside metal hub. This allows access to two 
countersunk holes and the end of the material. Rotate 
the material to line up with one of the holes. (3f) 

1Drive a #6 x 1 / " coarse-thread screw through this 4

hole and flush with the countersink. (fig. 3h) 

Rotate the material again to line up the second hole.   
Drive in another screw. These screws secure the 
material from slipping during the carving process. 
Check that the material rotates with no binding of the 
screw heads against the plate.

Placing the Jig Into the Machine

The jig has two tabs extending from the bottom of each 
end panel. These tabs fit into the U-shaped slots of the 
stationary squaring plate (keypad side of the machine) 
and the moveable sliding plate. (fig. 4a)

Move the sliding plate all the way to the right, then 
raise the head just enough to be able to maneuver the 
jig into the machine. Don’t raise the head too high or it 
will lock in place and you’ll need to manually lower it.
(fig. 4b)

Position the jig so the tab rests in the stationary plate 
slot. Move the sliding plate against the jig so that the 
other tab rests inside that slot, as well. The sliding plate 
edge should be right up against the jig roller bearings 
which rest on the traction belt. (fig. 4c)

(cont.)

Page 3

(cont.)

Rotary Jig and Material Setup
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fig. 3g

fig. 3h

fig. 3i

Confirm the
secured stock 
and mechanism
rotates with
no binding after
driving in both
screws

fig. 4a The jig’s tabs fit into the two plate slots

fig. 4b

Raise head and
place the jig into
the machine with
the gear drive on
the keypad side
of the machine

 

fig. 4c

Each tab fits into
a plate slot on
each side of the
machine

 (this photo shows
the tab resting in the
sliding plate slot)

 



Aligning the Jig

With the jig properly placed (the jig side panels are 
elevated slightly ABOVE the guide plates of the 
machine) crank down the head of the machine to hold 
the jig securely. You will notice a groove on top of each 
side panel of the jig. These are alignment references. 
(fig. 5a) 

Insert a bit into the chuck. To check alignment, 
carefully lower the chuck/bit to each mark on both 
sides of the jig by hand. The tip of the bit should be in 
alignment with both grooves. (fig. 5b)

If the bit doesn’t line up with the marks, take note of 
how much it is “off” and remove the jig. Adjust one or 
both of the metal tabs on the side panel(s) by loosening 
the screws and repositioning the tab(s). Reinsert the jig 
into the machine and check alignment again. Repeat 
the process, if necessary, until the jig marks are aligned 
with the tip of the bit. (fig. 5c)

(cont.)
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Calibrating the Jig

The jig must be calibrated before each rotary carve. 
Load your stock into the jig and insert the jig into the 
machine, check alignment, then follow these steps:

• Insert the carving bit and close the cover.

• Turn on the machine and press “0” on the keypad to 
access the Options Menu, then press “6” to access the 
Configuration Menu, then press “7” to access the 
Rotary Cal

• To begin calibration, press the green “Enter” button
(there will be a brief Homing routine, then the Jog To 
Touch menu appears on the LCD panel)

• Use the arrow keys on the keypad to jog the bit to 
your chosen location on the stock. The 
arrows rotate the stock. The up/down arrows move the 
bit across the stock.
(fig. 6a)

• Now, open the cover, then “jab” the chuck/bit up and 
down by hand into the stock to create a visible divot 
mark. After a clear divot mark is made, raise the 
chuck/bit back up out of the way of the jig. 

This divot mark will be used for the next step of the 
calibration. 

side-to-side 

(fig. 6b)

Rotary Jig and Material Setup

CarveWright Tutorial
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Alignment
Groove

 

fig. 5a

Carefully lower the
chuck/bit by hand
into the groove on 
top of each jig side
to check alignment
 

fig. 5c

fig. 5b

fig. 6a

(cont.)

fig. 6b



Calibrating the Jig (cont.)

• Now that you’ve made your reference divot mark and 
raised the bit up out of the way, go ahead and press the 
green “Enter” button. The machine will rotate the stock 
three times and then stop. You should see your divot 
mark. Lower the chuck/bit by hand to see whether the 
tip of the bit is still centered with your mark. (fig. 6c) 

If they do not line up, use the arrow keys to reposition 
the bit to match the reference mark (and lower the bit 
by hand, to confirm alignment). Once aligned, press the 
green “Enter” button again. The LCD screen will now 
display the “old” and the “new” settings, and the option 
to 1) Keep or 2) Abort. You want to press “1” to keep 
the new setting. The stock will rotate again and you can 
observe if the bit aligns with the mark this time. (6d)

It is advised to run the calibration at least twice in order 
to ensure a consistent result. If the results are still 
inconsistent (i.e., the bit and mark won’t align), then 
it’s most likely the machine’s head pressure is too low 
or the jig is not positioned properly. Sometimes a little 
extra “push” with your hand while cranking down the 
head can increase the head pressure enough to get a 
good calibration, so try that first.

Once calibrated, you are now ready to run your project.

(cont.)
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Running A Rotary Project

• From the Project Menu, select your rotary project, 
then press “Enter”

• The machine will measure the length of your stock to 
make sure it is long enough for your project

• Next, the machine will prompt you to input the 
stock’s diameter (the initial number displayed is simply 
the minimum diameter required for the project). The 
stock’s OUTER diameter is what you need to specify. 
(see pg. 1, fig. 2b)

• Use the up/down arrow keys to select the stock’s 
OUTER diameter. Select the next higher diameter if 
there is no exact match. Aside from the initial diameter 
display, the diameter choices are in .25" increments. 
Press ENTER after making your selection.

• You will then be prompted for the bit, as usual. Insert 
the bit and press ENTER. The machine will proceed 
with Homing/Bit Find and then run your rotary project!

For additional information and resources, please visit: 
http://www.carvewright.com/support-page/getting-
started/tutorials/ 

There are also several Rotary sections available at the 
CarveWright Community Forum you may find helpful. 
Please visit: http://forum.carvewright.com/forum.php

Rotary Jig and Material Setup

CarveWright Tutorial
www.carvewright.com

(cont.)

fig. 6d

fig. 6c

Press “1”
to Keep

 

fig. 7a

Use the arrow
keys to scroll
through the

diameter choices
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The trademarks, service marks and logos (the “Trademarks”) used and displayed here are registered and unregistered Trademarks of LHR and others.

RESOURCES...
There are numerous resources for the CarveWright/CompuCarve owner to make their experience with these 
machines much more enjoyable. 

Every owner should join the CarveWright User Forum (http://forum.carvewright.com/forum.php) where fellow 
users share their experiences and knowledge with these machines on a daily basis. It is a FREE service that you 
will surely appreciate. A handy Search Feature helps you find answers to any questions you may have.

Additional Resources

CarveWright Tutorial
www.carvewright.com

http://www.carvewright.com
https://store.carvewright.com/home.php?cat=263
http://www.carvewright.com
https://store.carvewright.com/product.php?productid=24895


 

Page 238 of 242 
 

SANDING MOPS 
Sanding mops are a great way to speed 
up and simplify the sanding and 
cleaning of your carvings. Attach it to a 
drill press or another high speed motor, 
and quickly polish your projects 
without removing your carved details. 
It will literally save you hours of 
tedious, hand sanding work. With two 
grits and two sizes, no matter the 
project, we’ve got you covered. We also have sandpaper refills for when you wear 
them out from all the great projects you are making. 

 

The CarveWright sanding mop is very easy to assemble into a number of different 
configurations to best suit the job at hand. By adding spacers between the layers 
you can change the “softness” and “aggressiveness” of the sanding. 
Fundamentally, the sanding mop is made up of sets of top and bottom facing strips 
of sandpaper that are set 45º from each other. No matter which size of mop you 
have purchased, you will want to start by building sets of two sanding strips lined 
up with the grit sides facing away from each other. Then you will want to take two 
of these sets and place them at 90º to each other to form what is called a sanding 
unit (Figure 1). Each sanding units are then assembled on to the mandrel at 45 
degrees to the last sanding unit. Continue crisscrossing sanding units (Fig. 1) until 
you reach the mop thickness you desire. 

 

FIGURE 1 

 

The stiffness and aggressiveness of your sanding mop can be varied by changing 
the way you assemble the supplied stabilizers (thin white plastic disks) and the unit 
spacers (black rubber washers) into the sanding units. 

ASSEMBLY 
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For Maximum stiffness: Use the stabilizers only (with the sanding units in 
between). This configuration is useful for sanding routed edges. 

For Medium stiffness: Use the stabilizers in addition to the spacers. This will 
reduce the aggressiveness and stiffness of the sanding mop, allowing it to get into 
the carved detail more efficiently. Note: If you wish to use the spacers on the small 
sanding mop place a spacer on the mandrel after every two sanding units (8 
sanding strips) as opposed to after every sanding unit as done on the large sanding 
mop. 

For Minimum stiffness: Use only the spacers to further increase the softness of the 
sanding mop. This configuration works very well when sanding fine details in deep 
carvings. 

If you wish to use the stabilizers in your configuration, begin the assembly by 
placing one stabilizer on the mandrel and end the assembly by placing the 
remaining stabilizer on the mandrel directly before the nut(s). Tighten the nut and 
place the sanding mop securely in a drill, drill press, lathe, bench grinder. Before 
you begin using your sanding mop you must separate the splits in the sanding 
strips by pressing a corner of a piece of hardwood in to the sanding mop while it is 
spinning. 
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CHAPTER 9 – TROUBLESHOOTING 

AND MAINTENANCE 
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Please note that this guide has been  generated to help users 
identify machine issues and diagnose certain common causes.  
It is not a repair guide and should not be treated as such.  Any 
repair to your CompuCarve or CarveWright machine must be 
at the direction of a trained CarveWright service technician in 
order to satisfy all warranty conditions.  Also note that the 
issues listed below are compiled from all machine configura-
tions from the beginning of production and many of them will 
not apply to your machine configuration.  

Troubleshooting Guide
Rev 1.07

The carvewright support web-
site has a searchable knowl-
edgebase with much of this 
information in video format. We 
recommend using this resource 
along with this guide.

http://support.carvewright.com/

http://support.carvewright.com/
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Board Too Thick to Cut Message 
 
Description of Issue 
The “Board Too Thick to Cut” message appears on the LCD screen when the machine measures 
the inserted board thickness and determines that it is thicker than the cutting bit can cut all the 
way through.  This message will only appear if there is a cutting operation in the project. 
 
Possible Causes 
The causes can be: a sliding plate that is not slid all the way over against the board, the wrong bit 
his inserted into the machine, a case where the user is using a jig on a project that has a cut-out in 
it and the height of the jig does not allow the bit to touch the board sensor during homing, or a 
damaged board sensor. 
 
Troubleshooting Steps 

1. Verify that the board is NOT over 1” thick. 
2. Check that the sliding plate is slid over against the edge of the board. 
3. Verify that the correct bit is inserted and correctly assembled. 
4. Check hole in the board sensor.  Check for a hole on the board tracking sensor - Look on 

the plastic bar of the board tracking sensor for hole.  If there is a hole, place a dime on top 
of that and run the machine.  Machine should run normally after that.  You also obtain a 
clip (Board Position Encoder touch plate - P1323) to cover the hole. 

5. Check Tracking Roller" error message.  This error is shown because of out of limit 
numbers when measuring the length of the board. 

6. Run a project and watch where the error occurs and what the machine is attempting to do.   
7. Consult CarveWright. 
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Check Cut Motor Message 
 
Description of Issue 
The machine can report a Check Cut Motor message when the sensors are not reading the 
expected cut motor RPM.  This cut motor message can be disregarded if the user desires.  The 
motor will run without the sensor feedback but may run fast. 
 
Possible Causes 
Causes include: a cut motor that is not spinning (various reasons), a bad cut motor sensor, a 
faulty cut motor sensor magnet, or a faulty X termination board.   
 
Troubleshooting Steps 

1. Check to see that the cut motor is spinning when it should be spinning.  If the cut motor is 
not spinning see the section titled “Cut Motor Not Spinning”. 

2. Check to see that the cut motor sensor is recording the shaft as it spins.  To check the status 
of the cut motor sensor, go to the CarveWright Main Menu->Configuration->Sensor Check 
menu.  Use the arrow keys to find the item titled “Cut Sensor” on the bottom line of the 
display.  Spin the spindle as fast as possible by hand and see if the count on the display 
changes.  If the count is not changing the magnet and/or the cut sensor is bad. 

3. If the cut motor RPMs are fluctuating during the project (readily heard), check the leads on 
the large brown capacitor on the X termination board for breakage.  Replace the X 
termination board if necessary. 

4. If none of the above steps solves the issue consult CarveWright. 
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Check Tracking Roller Message 
 

Description of Issue 
The “Check Tracking Roller” message appears on the LCD screen when the machine is seeing 
out of limit numbers when measuring the length of the board at the beginning of the project.  
Typically the board will progress out one end of the machine and just off the tracking roller 
before stopping. 
 

Possible Causes 
The two main causes of this error are: 1) there is a stuck compression roller and 2) there is some 
issue with the board tracking sensor.  The most likely cause is stuck compression roller.  When 
measuring the length of a board, the machine waits until the roller closest to that end it is 
measuring drops to signal that it should start to look for the edge of the board with the board 
sensor.  Usually this message is caused when one of the compression rollers fails to switch from 
“Compressed” to “Released” when it falls off the end of the board and the board continues to 
move out of the machine until the board tracking sensor stops rotating.  The cause is almost 
always dust in under the end of the compression roller that prevents the roller sensor from seeing 
the drop.   
 

Issues that will cause a board tracking roller to indicate this error are: board defects, rolled up 
belt, low head pressure, damaged or missing o-ring on the board tracking sensor, dust in the 
board tracking sensor, improperly set/loose sliding plate, missing damper spring under the board 
tracking sensor, incorrectly adjusted outfeed trays, or a board that is thinner than .5” 
 

Troubleshooting Steps 
1. Check the roller state in the sensor check menu.  Remove the workpiece, turn the machine 

ON, and navigate to the Configurations Menu from the CarveWright Main Menu by using 
the up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Front Roller and 
Back Roller.  With no board inserted they should both read “Released”. 

2. Lift up on the left end of each roller and blow air underneath the rubber washers that shield 
the end of the roller.  Verify that the rollers now both read” Released” when there is no 
board present. 

 
 
 
 
 
 
 
 
 
 
 
 

Rear Compression Roller 

Front Compression Roller

Rear Rubber Washer 

Front Rubber Washer 
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3. Check the board for defects (existing carvings, warping, holes, rounded edges, etc.) and 
make sure it is inserted correctly into the machine.  For a detailed discussion on the board 
requirements please see the “Inserting a Board” section in the CarveWright Owner’s 
manual. 

4. Verify that the board is thicker than .5”. 
5. Check that the sliding plate is tight and up against the board.  A board that is not captured 

by the sliding plate will allow the board to walk slightly from side to side.  This small 
amount of walking can lead to a wide variance in measured lengths. 

6. Check to see if the squaring plate (where the tracking sensor is attached) is loose.  This is a 
rare issue but it can happen. If the square plate is loose, it will not measure the board right 
and could give the Edge Detection error, possible board removal, or give a wrong 
measurement for the board.  Re-tighten the 2 screws that hold the squaring plate. 

7. Verify that the board sensor rotates freely. 
8. O-ring on the board tracking sensor is in place and not damaged. 
9. Verify that the head pressure is within correct limits. 
10. Verify that neither of the belts are damaged or rolled up. 
11. Verify that the damper spring is still under the board tracking sensor. 
12. Check to see that the outfeed rollers are not adjusted too high.  If they are high they can lift 

the board off of the board tracking roller during operation and cause it to lose track of the 
position. 

13. Check for dust in the board tracking sensor. 
14. If none of the above steps solves the issue consult CarveWright. 
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Edge Detection Failure Message 
 
Description of Issue 
The edge detect failure occurs when the board sensor gets bad data when looking for a board 
edge during the initial measuring and homing part of the project. 
 
Possible Causes 
Causes include: a low board sensor reading, a very dark color workpiece, sawdust on the sliding 
plate, a hole in the board, or board tracking issue that confuses the board sensor when looking for 
an edge.  These tracking issues can include: board defects, rolled up belts, low head pressure, 
dust in the board tracking sensor, improperly set/loose sliding plate, missing damper spring 
under the board tracking sensor, or incorrectly adjusted outfeed trays. 
 
Troubleshooting Steps 

1. Determine if the error is occurring when measuring the edge in the Y direction (left to right 
across the machine) or in the X direction (in and out of the machine).  If it occurs when 
measuring in the Y direction, proceed with Step 2.  If it occurs when measuring the X 
direction, skip to Step 8. 

2. Check the board sensor reading when the Y truck is pushed all the way over to the left side 
of the machine (off the board).  It should read less than 10.  Then move the truck over a 
light colored board and verify that the reading is greater than 100.  If either of these values 
is not met please refer to the “Please Clear Board Sensor” document. 

3. Verify that the color of the workpiece is not too dark by making sure that the board sensor 
is reading at least 100 while over a light colored workpiece. 

4. Check the board for defects (existing carvings, warping, holes, rounded edges, etc.) and 
make sure it is inserted correctly into the machine.  For a detailed discussion on the board 
requirements please see the “Inserting a Board” section in the CarveWright Owner’s 
manual. 

5. Check that the sliding plate is tight and up against the right side of the board and clear of 
sawdust. 

6. Next check and see if there is dust in the Y encoder that is causing it to lose track of 
position.  Check the Y encoder readings in the sensor check menu.  Turn the machine ON 
and navigate to the Configurations Menu from the CarveWright Main Menu by using the 
up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Y Position.  
Record the encoder readings for the far left and right positions as you move the Y truck.  
The total Y travel should read between 15.5” and 16”.  Move it back and forth several 
times checking to see that the values at each side do not change.  Replace the motor pack if 
these readings do not match up. 

7. If none of the above steps solves the Y edge detection failure, consult CarveWright. 
8. Check to see if the squaring plate (where the tracking sensor is attached) is loose.  This is a 

rare issue but it can happen. If the square plate is loose, it will not measure the board right 
and could give the Edge Detection error, possible board removal, or give a wrong 
measurement for the board.  Re-tighten the 2 screws that hold the squaring plate. 
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9. Verify that the head pressure is within correct limits. 
10. Verify that neither of the belts are damaged or rolled up. 
11. Verify that the damper spring is still under the board tracking sensor. 
12. Check to see that the outfeed rollers are not adjusted too high.  If they are high they can lift 

the board off of the board tracking roller during operation and cause it to lose track of the 
position. 

13. Check for dust in the board tracking sensor. 
14. If none of the above steps solves the issue consult CarveWright. 



LHR Technologies, Inc.    CarveWright™ Troubleshooting Guide (Rev 1.07) 05/10/11 11 

 

Error Loading Size: 28 Message 
 
Description of Issue 
The machine will tend to show this error message during the beginning process or starting a 
carving when it cannot access the memory card data. 
 
Possible Causes 
The machine displays this error message when the project on the memory card has been 
corrupted.  It improperly loads the incorrect project size, resulting in the error message. 
 
Troubleshooting Steps 

1. Take the card back to the computer and reformat the memory card.  Overwrite the firmware 
on the card.  This is very important even if the version is the same. 

2. Load the project again and try running the project. 
3. If the problem persists, email the project file to CarveWright support for analysis.  
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Please Clear Board Sensor Message 
 
Description of Issue 
This error appears when the sensor used to find the edges of the workpiece is not seeing reading 
within its operational limits.  The sensor system consists of an infrared LED and an infrared 
detector.  The board sensor works by reflecting infrared light off of the board and reading the 
intensity of the reflection.  When the board is underneath the sensor, the reflected intensity is 
high and when the sensor is off the edge of the board, the intensity is low.  The LED and detector 
are mounted behind a clear window in a plastic case at the bottom of the horizontal moving Y-
Truck. 
 
Possible Causes 
There are several reasons why the machine will prompt the user to “Clear Board Sensor” 
including:  

1. There is dust obscuring the sensor lens. 
2. There is dust piled in the machine to the right of the board that looks like a continuation of 

the board to the sensor. 
3. There are existing features on the workpiece, like holes or other carved features, which 

prevent the sensor from tracking the top surface.  
4. The material is too transparent or reflective.   
5. The board is positioned incorrectly in the machine; usually the board is installed on top of 

the squaring plate instead of up against it.  It will also give this error if the board is placed 
in the middle of the machine and not slid up against the strongback. 

6. The environmental temperature is below 40 degrees Fahrenheit. 
 
Troubleshooting Steps 
The following steps only touch on the most likely causes of this issue.  For an in-depth 
troubleshooting procedure please consult the detailed trouble shooting document titled “Please 
Clear Board Sensor” 

1. Clean the Board Sensor.  The most common reason for this issue to occur is that the sensor 
is obscured by dust.  To clean, simply blow low-pressure compressed air (<80 psi) onto the 
sensor window or wipe with a clean cloth.  It is recommended that this sensor be cleaned 
after every project.  If using pressurized canned air make sure to keep the can vertical.  If 
the can is tipped upside down it will eject a stream of freezing liquid instead of air.  This 
will usually damage the sensor. 

2. Verify that the temperature is above 40oF. 
3. Verify that the board is pushed up against the squaring plate and not riding on top of it. 
4. Check to see that there is no dust piled on the squaring plate that may trick the sensor. 
5. Verify that there are no existing features on the workpiece, like holes or other carved 

features, which trick the sensor into thinking that it has found the edge and preventing it 
from seeing the entire top surface of the board.  Use masking tape to hide these features 
from the sensor. 

6. Verify that the material is not too transparent or reflective.  Since the sensor works by 
using reflected light to determine the board edge, any material that is very light in color or 
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very dark in color cause it to get a reading that is out of its normal limits.  This can be fixed 
by placing a piece of masking tape on the surface of the workpiece along the line that the 
sensor traces while measuring.  This generally requires placing tape across the width and 
length of the workpiece. 

7. If the board sensor error cannot be resolved by doing the above checks you will need to 
check the sensor readings directly to see if it is working properly.  To check the status of 
the board edge sensor, go to the CarveWright Main Menu->Configuration->Sensor Check 
menu.  Use the arrow keys to find the item titled “Board Sensor” on the bottom line of the 
display.  Do the following checks: 

a. Load a pine or similar colored board, lower the head, and check the reading 
displayed on the LCD when the sensor is over the board.  Anything reading over 90 
is acceptable.  Anything under 90 requires a new sensor. 

b. Check the reading displayed on the LCD when the sensor is not over a board by 
moving the cutting head all the way to the left.  The correct reading should be less 
than 10 and ideally 0. 

c. Raise the head, so that a small board can be easily place underneath the Board 
Sensor.  Move it up and down so as to cause the Board Sensor reading to go greater 
than 50.  Quickly remove it from under the sensor.  The reading should drop 
immediately to less than 10 and ideally 0.  If it does not drop immediately the 
sensor is faulty and needs to be replaced. 

8. If none of the above steps solves the issue consult CarveWright and the detailed trouble 
shooting document titled “Please Clear Board Sensor”. 
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Please Close Cover Message 
 
Description of Issue 
The “Please Close Cover” message appears once the project begins even though the cover is 
closed.  The machine has two switches that check to see that the cover is down before cutting.  
The left one reports the cover state to the electronics and the left one connects the power circuit 
to the cut motor which allows it to run when the cover is down.  If the left one is not showing 
“Closed” then the machine will show this message. 
 
Possible Causes 
Causes include: a faulty cover switch (or full of dust), a loose cover or switch, a bent cover that 
does not allow the cover to fully actuate the switch, or a disconnected cover cable on the head 
termination board (seen especially right after servicing where the cover was removed). 
 
Troubleshooting Steps 

1. Check the state of the cover switch in the sensor check menu.  Turn the machine ON and 
navigate to the Configurations Menu from the CarveWright Main Menu by using the 
up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Cover Switch.  
With the cover up it should say “Open” and with the cover closed it should say “Closed”.  
Open and close the cover and see if the switch changes state for “Open” to “Closed”.  

2. Check that the left cover hinge cover is not loose and that the switch is not loose.  If either 
is loose it can affect the actuation of the switch button by the finger on the clear cover.  

3. Verify that the connectors to the switch are in place and tight. 
4. Take a small implement and manually depress the switch button by hand.  If you can get 

the LCD to switch to “Closed” then there is something wrong with the cover that is 
preventing it from depressing the switch far enough.  Resolve this cover issue.   

5. Also listen for a clicking sound as you depress the switch by hand.  If the connector is 
seated and the clicking can be heard without the cover showing “Closed” then most likely 
the switch has dust in it or is bad.  Blow out the switch and test again.  

6. If the error occurs during carving then check the cover engagement with the switch.  It is 
possible that the vibration lifts the cover enough to release the switch momentarily.  In this 
case it usually happens with regularity.  Adjust the cover so that the switch engagement is 
positive 

7. If the machine has recently been serviced and the cover was removed it is very possible 
that the switch cable was not plugged in correctly.  Verify that the cover cable is correctly 
plugged into the head termination board.  Unplug and re-plug if the seating is unsure. 

8. If none of the above steps solves the issue consult CarveWright. 
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Please Load Bit Message 
 
Description of Issue 
The “Please Load Bit Error” message occurs during homing when the machine is unable to 
verify the position of the bit tip.  The machine uses surfaces on the board tracking sensor (in the 
cutout of the strongback at the far left of the bit travel) and the swinging bit touch plate (at the far 
right of travel) to locate the position of the bit tip.  Failure to touch these surfaces results in this 
error. 
 
Possible Causes 
Causes include: no bit loaded into the machine, outdated firmware, incorrectly assembled bit, a 
malfunctioning bit plate, or a damaged board sensor. 
 
Troubleshooting Steps 

1. Verify that the correct bit is inserted, correctly assembled, and not loose. 
2. Check that the Y/Z trucks are not loose. 
3. Verify that the card has the latest firmware version. 
4. Check for damage (usually a hole) on the board tracking sensor body.  The damage will be 

on the plastic bar of the board tracking sensor where the bit touches during homing at the 
far left of its travel.  If there is a hole, temporarily place a dime in the triangular recess of 
the board sensor over the hole and run the machine.  If this fixes the issue, add the Board 
Position Encoder Touch Plate (P1323) instead of the dime. 

5. Run a project and watch if the bit plate is swinging out far enough for the bit to touch when 
it moves down.  The bit should touch on the flat surface of the plate and not on the edge.  If 
the plate is not swinging out far enough clean and lubricate the bit plate pivot post and 
spring.  Clean the plate mechanism with compressed air and spray WD40 on the spring.  
Crank the head all the way up to the top and spry upward at the pivot shaft.  Actuate the bit 
plate several times to let the WD40 penetrate the mechanism.  

6. Re-tension the Y belt.  A loose belt can decrease the force that the Y-truck uses to swing 
the bit plate out. 

7. If the bit is touching the swinging bit plate on the flat surface and still getting the error, 
rotate the bit plate all the way and push down, slightly bending the plate down.  This will 
slightly bend the plate and increase the depth measurement.   

8. If the bit is still not touching the bit plate then proceed to the "Bit Not Touching the Bit 
Plate" section. 
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Please Load Board Message 
 
Description of Issue 
The “Please Load Board” message comes up when the machine begins to measure the board and 
senses that there is not a board in the machine.  It checks that both compression roller sensors are 
reading compressed to verify that a board is loaded into the machine. 
 
Possible Causes 
Causes include: no board loaded into the machine, a board loaded only under one roller, the head 
is not cranked down, a warped board, a board with features carved all the way across the width 
of the board, a board that is too thin, low head compression, or a bad compression roller sensor. 
 
Troubleshooting Steps 

1. Check that a workpiece is in the machine (and under both rollers) and that the head is 
cranked down properly. 

2. Verify that the board is not thinner than 1/2". 
3. Check for major features on the board that would cause one roller to compress and the 

other to be released.  The workpiece needs to be flat, smooth and without warps or 
significant thickness change. 

4. Verify that the head pressure is within correct limits.  This is especially important when 
carving wide material because the rollers do not compress as much the wider it gets. 

5. Check for a stuck or defective compression roller.  Please review the section titled “Stuck 
Compression Roller” in this troubleshooting guide. 

6. If none of the above steps solves the issue consult CarveWright. 
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Please Set Sliding Plate Message 
 
Description of Issue 
The “Please Set Sliding Plate” message comes up when the machine is unable to locate the 
sliding plate with the tip of the bit, usually when measuring the bit before doing a cut-out 
operation.  The tip of the bit goes below the bottom plane of the board during the cut-out 
operation and uses the sliding plate as a depth reference so as not to damage the machine.  
 
Possible Causes 
The causes can be: a sliding plate that is not slid all the way over against the board, a case where 
the user has put the wrong bit into the machine and it is too short to reach the sliding plate, or a 
case where the user is using a jig on a project that has a cut-out in it and the height of the jig does 
not allow the bit to touch the sliding plate. 
 
Troubleshooting Steps 

1. Check to see that the sliding plate is set up against the board. 
2. Check and double check that the bit that is inserted is in fact the bit that the machine is 

calling for.  As noted usually this happens when trying to do a cutout. 
3. Check to see if the user is using a jig.  Some jigs can be too high for the cutout function to 

work properly. 
4. If none of the above resolve the issue, set up a project and watch exactly the sequence of 

events and where the error occurs.  Then bring this information to a CarveWright for 
consultation. 
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Possible Board Problem Message 
 
Description of Issue 
The Possible Board Problem message occurs when the board tracking sensor is unable to closely 
track the board with respect to the commanded motion of the drive motors. 
 
Possible Causes 
Cause can be: board defects, rolled up belt, low head pressure, damaged or missing o-ring on the 
board tracking sensor, dust in the board tracking sensor, improperly set/loose sliding plate, 
missing damper spring under the board tracking sensor, incorrectly adjusted outfeed trays, a 
board that is thinner than .5”, or excessive backlash in the X-drive gears. 
 
Troubleshooting Steps 

1. Check the board for defects (existing carvings, warping, holes, rounded edges, etc.) and 
make sure it is inserted correctly into the machine.  For a detailed discussion on the board 
requirements please see the “Inserting a Board” section in the CarveWright Owner’s 
manual. 

2. Verify that the board is thicker than .5”. 
3. Check that the sliding plate is tight and up against the board.  A board that is not captured 

by the sliding plate will allow the board to walk slightly from side to side.  This small 
amount of walking can lead to a wide variance in measured lengths. 

4. Check to see if the squaring plate (where the tracking sensor is attached) is loose.  This is a 
rare issue but it can happen. If the square plate is loose, it will not measure the board right 
and could give the Edge Detection error, possible board removal, or give a wrong 
measurement for the board.  Re-tighten the 2 screws that hold the squaring plate. 

5. Verify that the board sensor rotates freely. 
6. O-ring on the board tracking sensor is in place and not damaged. 
7. Verify that the head pressure is within correct limits. 
8. Verify that neither of the belts are damaged or rolled up. 
9. Verify that the damper spring is still under the board tracking sensor. 
10. Check to see that the outfeed rollers are not adjusted too high.  If they are high they can lift 

the board off of the board tracking roller during operation and cause it to lose track of the 
position. 

11. Check for dust in the board tracking sensor. 
12. If none of the above steps solves the issue consult a CarveWright. 



LHR Technologies, Inc.    CarveWright™ Troubleshooting Guide (Rev 1.07) 05/10/11 19 

 

Possible Board Removal Message 
 
Description of Issue 
The “Possible Board Removal” message occurs when the head is cranked up unexpectedly.  Both 
compression roller switches would have to be showing released during the project which the 
machine interprets as no board being present. 
 
Possible Causes 
Possible causes are: the head is cranked up in the middle of the project, here is a fault in one or 
both compression roller switches, or one of the rollers falls when the board is only under it. 
 
Troubleshooting Steps 

1. Verify that the head was not cranked up during the project. 
2. Check that there are no features going all the way across the board that would cause one 

roller to drop and go “Released”. 
1. Check the roller state in the sensor check menu.  Remove the workpiece, turn the machine 

ON, and navigate to the Configurations Menu from the CarveWright Main Menu by using 
the up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Front Roller and 
Back Roller.  With no board inserted they should both read Released. 

3. If none of the above steps solves the issue consult CarveWright. 
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Power Fluctuation Message 
 
Description of Issue 
The machine displays the Power Fluctuation message when it encounters an under-voltage 
condition on the 5V power supply.  The machine shuts down and safes all operations. 
 
Possible Causes 
There are four main causes for the under-voltage condition, a faulty power supply, a loose 
connector, a drawdown on the circuit, and a short somewhere in the machine. 
 
Troubleshooting Steps 

1. Check that there are no other machines or devices on the circuit that can draw down the 
110V to the machine.  Also make sure that the machine is not on a power strip or extension 
cord which can be a large in line resistive load.  

2. Check the power connections to the electronics for looseness. UNPLUG THE MACHINE 
and remove the bottom cover.  Check the seating of all of the connectors to the power 
supply, controller, and ON/OFF switch.    

3. Most likely if the fluctuation is randomly appearing, it is the result of a faulty power 
supply.  Consult CarveWright and see if the Power Supply (A2038) should be replaced. 

4. If the new power supply does not work have the machine returned for repair. 
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SRAM Message 
 
Description of Issue 
During initial power up, the LCD screen displays the CarveWright banner and “SRAM followed 
by numeric characters”.  It will not let you proceed from this screen. 
 
Possible Causes 
The cause is a defective controller board (A2065). 
 
Troubleshooting Steps 

1. Replace the controller board (A2065). 
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Stuck Compression Roller Message 
 

Description of Issue 
During operation machine can report that one of the two sprung loaded compression rollers is 
stuck.  This occurs when the sensors that monitor the compressed/released state of the roller is 
reporting an unexpected state.  See a detailed description of this mechanism in the 
Troubleshooting section of the CarveWright Operator’s manual. 
 

Possible Causes 
The stuck roller error can be caused by: dust preventing the roller from returning to the released 
state, a twisted or warped board, a misaligned roller sensor, a board that is thinner than .5”, or 
even a bad roller sensor. 
 

Troubleshooting Steps 
1. Verify that the board is thicker than .5”. 
2. Check the roller state in the sensor check menu.  Remove the workpiece, turn the machine 

ON, and navigate to the Configurations Menu from the CarveWright Main Menu by using 
the up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Front Roller and 
Back Roller.  With no board inserted they should both read Released. 

3. If one of the rollers says Compressed even with no board loaded, reach into the machine 
through the open cover and lift and release each of the rollers by hand watching to see if 
the LCD screen indicates that the state of the roller has changed.  A faint clicking should be 
heard as the roller goes from Released to Compressed.  Blow air underneath the rubber 
washers that shield the end of the roller. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. If none of the above steps solves the issue consult CarveWright. 
 

Rear Compression Roller 

Front Compression Roller 

Rear Rubber Washer 

Front Rubber Washer 
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System Error (81).  Please Contact CarveWright Message. 
 

Description of Issue 
At startup the machine reports this error. 
 

Possible Causes 
The serial number stored on the controller electronics is corrupt. 
 

Troubleshooting Steps 
1. Verify that the serial number is corrupt by turning the machine ON and navigating to the 

Configurations Menu from the CarveWright Main Menu by using the up/down arrows or 
pressing the “0” (Options) key on the keypad.  Navigate to, or select key “4”, Show serial 
Number.  If it is corrupt it will show it here. 

2. Contact CarveWright support and they will email you instructions on restoring the serial 
number in the machine. 
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Bit Not Touching the Bit Plate 
 
Description of Issue 
The machine uses the top surface on the swinging bit touch plate (located at the far right of 
travel) to locate the position of the bit tip during its homing routine.  Failure to touch the top 
surface of the bit plate results in a “Please Load Bit Error” discussed above. 
 
Possible Causes 
Causes include: a bit plate that is not swinging all the way out, obstacles that prevent the Y-truck 
from moving far enough to the right during the bit touch on the bit plate or a bit plate that is bent 
out of position.  
 
Troubleshooting Steps 

1. Clean and lubricate the bit plate pivot post and spring.  Clean the plate mechanism with 
compressed air and spray WD40 on the spring.  Crank the head all the way up to the top 
and spry upward at the pivot shaft.  Actuate the bit plate several times to let the WD40 
penetrate the mechanism.  

2. Make sure that there are no obstacles to the Y-truck moving far enough to the right to 
actuate the swinging bit plate.  Turn the machine off, position the Y-truck on the left near 
to the keypad, and move Y-truck all the way to the right side of the machine.  Pay attention 
to see if the Y-truck is getting stuck somewhere along the travel.  Check for wires or 
interference with the cover that prevent the Y-truck for moving far enough right.  Also 
check that the screws holding the Z encoder cap are not hitting on the cover at the far right 
side. 

3. Make sure that there are no obstacles to the Z-truck moving far enough down to touch the 
top surface of the bit plate. 

4. If none of the above steps solves the issue consult CarveWright. 
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Carving Edge Shifts in the Y Direction 
 
Description of Issue 
This issue occurs when the edge or boundary of a carving starts to gradually (or even radically) 
shift in the side-to-side direction unexpectedly. 
 
Possible Causes 
Causes include: a loose Y belt tensioner, dust in the Y encoder, a Y belt missing teeth, or a loose 
encoder wheel on the Y encoder.  The situation can be revealed or made worse by high force 
operations like vector cuts with large bits. 
 
Troubleshooting Steps 

1. Check tension on the Y-belt.  A loose belt can lead to skipping which may cause this error, 
especially on the Y axis.  Loosen the Y-belt tension bracket screw, re-tension the belt, and 
re-tighten the screw.  Also make sure that there is a star shaped lock washer under the head 
of the screw to lock the tension bracket in place. 

2. Next check and see if there is dust in the Y encoder that is causing it to lose track of 
position.  Check the Y encoder readings in the sensor check menu.  Turn the machine ON 
and navigate to the Configurations Menu from the CarveWright Main Menu by using the 
up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Y Position.  
Record the encoder readings for the far left and right positions as you move the Y truck.  
The total Y travel should read between 15.5” and 16”.  Move it back and forth several 
times checking to see that the values at each side do not change.  Replace the motor pack if 
these readings do not match up. 

3. Check for missing teeth on the Y belt. 
4. If none of the above steps solves the issue consult CarveWright. 
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Carving Gets Shallower Going Side to Side 
 
Description of Issue 
In rare cases we have seen unexpected carvings where the depth becomes shallower as the bit 
moves from right to left (as seen facing the machine) doing a raster pattern. 
 
Possible Causes 
Causes include a loose bit, a board that varies in thickness from side to side, a cupped board or a 
machine with an unlevel head. 
 
Troubleshooting Steps 

1. Check that the bit is not loose in the holder. 
2. Verify that the board is not thicker on one side. 
3. Check the board for major cupping on both the top and bottom surfaces.  A cupped board 

can result in depth variations in the side-to-side direction. 
4. If none of the above steps solves the issue consult CarveWright. 
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Carving Increases in Depth 
 
Description of Issue 
The machine can unexpectedly begin to carve deeper as the carving progresses. 
 
Possible Causes 
Causes include: a loose bit, dust in the Z encoder, a loose Z belt clamp on the back of the Z-
truck, or a loose encoder wheel on the Z motor.  The situation can be revealed or made worse by 
high force operations like vector cuts with large bits. 
 
Troubleshooting Steps 

1. Make sure that the bit is held tightly in the bit adapter and the spindle.  Because of the 
spiral flutes, a loose bit will then to be pulled out of the adapter during carving. 

2. Rapidly move the Z truck up and down seeing if you can get the belt to skip on the pulley 
or within the clamp that holds the belt onto the back of the truck. 

3. Next check and see if there is dust in the Z encoder that is causing it to lose track of 
position.  Check the Z encoder readings in the sensor check menu.  Turn the machine ON 
and navigate to the Configurations Menu from the CarveWright Main Menu by using the 
up/down arrows or pressing the “0” (Options) key on the keypad.  Navigate to, or select 
key “7”, Sensor Check.  Use the up/down arrows to find menu items titled Z Position.  
Record the encoder readings for the up and down positions as you move the Z truck.  The 
total Z travel should read between 2.5” and 3”.  Move it up and down several times 
checking to see that the values at each extreme do not change.  Replace the motor pack if 
these readings do not match up. 

4. If none of the above steps solves the issue consult CarveWright. 
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Carving of an Imported Image is Very Rough 
 
Description of Issue 
Users sometimes report very unsatisfactory results when carving imported images or graphics.  
Be aware that carving an imported picture is very difficult to make look right in wood.  The 
reason why is that the machine is trying to carve every single detail of the picture and there is a 
limited amount of information contained in a photo. 
 
Possible Causes 
Low resolution on the imported images causes rough carving. 
 
Troubleshooting Steps 
Use high resolution photos and graphics.  Use the pattern editor tools in the software to clean up 
the images, especially around the edges.  There are several Tips and Tricks articles on the Learn 
section of the CarveWright website that detail these tools. 
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Clicking Sound Heard During Homing or Carving 
 
Description of Issue 
A clicking sound is heard from the machine during homing or carving, especially when the Y 
truck is moving to the right of the machine.  The clicking can also precede a Y/Z stall or even a 
skipping in the raster pattern. 
 
Possible Causes 
Causes include: a loose Y/Z belt tensioner, a frozen Y/Z belt pulley, or a loose Y/Z belt clamp on 
the back of the Y-truck/Z-truck.  The situation can be revealed or made worse by high force 
operations like vector cuts with large bits. 
 
Troubleshooting Steps 

1. Verify that the Y/Z pulleys are free to rotate.  Use compressed air and WD40 to get them 
rotating freely if needed. 

2. Check tension on the Y and Z belts.  A loose belt can lead to skipping which may cause 
this sound, especially on the Y axis.  Loosen the Y-belt tension bracket screw, re-tension 
the belt, and re-tighten the screw.  Also make sure that there is a star shaped lock washer 
under the head of the screw to lock the tension bracket in place. 

3. Rapidly move the trucks back and forth seeing if you can get the belt to skip on the pulley 
or within the clamp that holds the belt onto the back of the truck. 

4. If none of the above steps solves the issue consult CarveWright. 
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Cut Motor Changes Speed in the Middle of the Project. 
 
Description of Issue 
The cut motor audibly changes pitch during a carving.  This is indicative of the sensor losing 
track of the RPM and defaulting to a pre-programmed speed.  
 
Possible Causes 
The cause of this change is most likely a faulty board sensor or sensor magnet. 
 
Troubleshooting Steps 

1. Check to see that the cut motor sensor is recording the shaft as it spins.  To check the status 
of the cut motor sensor, go to the CarveWright Main Menu->Configuration->Sensor Check 
menu.  Use the arrow keys to find the item titled “Cut Sensor” on the bottom line of the 
display.  Spin the spindle as fast as possible by hand and see if the count on the display 
changes.  If the count is not changing the magnet and/or the cut sensor is bad.  This 
message can be ignored and the motor will run on a default setting or the motor can be 
brought in for repair. 

2. If the above step does not solve the issue consult CarveWright. 



LHR Technologies, Inc.    CarveWright™ Troubleshooting Guide (Rev 1.07) 05/10/11 31 

 

Cut Motor Not Spinning 
 
Description of Issue 
The cutting motor does not turn on at the beginning of the carving. 
 
Possible Causes 
Causes include: a faulty switch, a loose connector, a faulty X-termination board, a pinched wire 
in the cut motor, a loose power wire, a head cover that is not engaging the AC motor switch, or a 
bad controller. 
 
Troubleshooting Steps 

1. Check that the right clear cover hinge cover is not loose and that the switch is not loose.  If 
either is loose it can affect the actuation of the switch button by the finger on the clear 
cover.  

2. Verify that the connectors to the switch are in place and tight. 
3. Verify that the cut motor switch (the one on the right side of the cover) is working by 

listening for the click as the cover is lowered.  
4. Take a small implement and manually depress the switch button by hand.  If you can hear 

the click when you do it by hand but not when the cover is lowered then there is something 
wrong with the cover that is preventing it from depressing the switch far enough.  Resolve 
this cover issue.   

5. UNPLUG THE MACHINE and remove the bottom cover.  Check the seating of all of the 
connectors to the power supply, controller, X-termination board, and ON/OFF switch. 

6. Check the AC motor brushes for excessive wear. 
7. Check traces on the X-termination board for signs of a burnt trace. 
8. If none of the above steps solves the issue consult CarveWright. 
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Flexshaft Core Breaking at the End 
 
Description of Issue 
In rare cases, the flexshaft core will be broken anywhere from 1" to 1 1/2" from either end.  This 
will usually happen within one hour of use. 
 
Possible Causes 
A burr has been raised on the inside of the flexshaft sheath that cuts into the core. 
 
Troubleshooting Steps 

1. Change the flexshaft assembly (A2045) 
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Flexshaft is Overheating or Melted 
 
Description of Issue 
The flexshaft sheath temperature should be cool enough that you can hold it in your hand even 
after long periods of operation.  If the flexshaft core becomes hot enough it can melt the outer 
rubber sheath.  A melted flexshaft sheath requires the immediate replacement of the entire 
A2045 flexshaft assembly.  In the case of an overheating flexshaft diagnose the issue before 
permanent damage can occur. 
 
Possible Causes 
Flexshaft overheating (and eventual melting), is usually caused by incorrectly assembling 
flexshaft core when putting the machine together.  If the flexshaft is assembled such that the steel 
core (the rotating part) is subjected to compressive forces then it will quickly overheat.  
Overheating can also be caused by insufficient or incorrect lubrication, a sheath that is not kept 
within the wire guide, a non-free floating flexshaft core, a bad flexshaft core, or even by a 
damaged spindle assembly. 
 
Troubleshooting Steps 

1. Verify that the sheath is staying within the wire guide while carving.  The wire guide 
maintains the proper bend radius on the sheath to assure that it does not kink. 

2. Verify that the core can slide in and out of both the motor end and spindle end freely.  
Sometimes rust or a frayed wire can prevent it from floating in the hole.  The flexshaft 
must be free to float within the sheath as the cutting head moves up and down and left and 
right. 

3. In the simple case of overheating, check that the flexshaft is assembled correctly.  
Disengage the flexshaft, remove the core and look for any damage or discoloration.  Grab 
the core at each end with your fingers, pull taunt, and twist.  A good flexshaft will have 
little rotational movement (<90o of rotation).  Replace any bad flexshaft core by following 
the service instructions CarveWright Owner’s Manual. 

4. Check for any play in the spindle by moving it side to side.  You should not be able to feel 
any slop or play in the spindle. 

5. If the flexshaft is still running hot, lubricate it.  The lubrication that you should use is 
"Chain Lube with Moly".  You can find it at any hardware, automotive or home 
improvement store and the instructions are also found in the CarveWright Owner’s Manual 
or online. 

6. If none of the above steps solves the issue consult CarveWright. 
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Head Will not Lower 
 
Description of Issue 
The head fails to lower when using the crank.  Usually it sits in place and the crank clutch 
continues to click. 
 
Possible Causes 
Causes include: the red locking lever is engaged, the head is raised to the top of travel and stuck, 
the lowering mechanism needs lubrication, the crank handle is not engaging, the head is not 
level, the vertical guide posts are out of alignment, or there is damage to the cranking 
mechanism. 
 
Troubleshooting Steps 

1. Check that the head is not already at the top of its travel (up against the side stabilizers).  
Cranking the head beyond its highest useable height can result in it locking in a position 
where the head crank cannot lower it.  Releasing from this locked position it is very easy. 
The right side threaded leadscrew needs to be manually turned and can be accessed from 
the inside of the machine.  There is a hole in the leadscrew just above the traction belts.  
Insert an Allen wrench or similar tool and rotate it in the clockwise direction to unlock it.  
For detailed instruction and pictures, consult the Troubleshooting section of the 
CarveWright Operator’s Manual. 

2. Verify that the red head locking lever is not engaged.  To unlock, make sure it is pushed 
back flat against the head casting. 

3. Verify that the crank is engaging the clutch mechanism when rotating it.  It should be very 
hard to turn if the head is not moving down. 

4. Clean and lubricate the four vertical guide posts and the two lead screws.  Clean the guide 
post and the lead screw with a dry rag and add liberal amounts of white lithium grease to 
these parts.  Crank the head up and down to work the grease into the parts.  Make sure that 
the head pressure is within limits before proceeding. 

5. Check the level of the head by measuring from the top of the head casting to the underside 
of the plastic stabilizers on all four corners.  If there is more than 1/32” difference the head 
will need to be leveled.  Note that there is always a reason for the head to become unlevel 
and this cause will have to be found and fixed before the issue can be closed.  There are 
two problems that can cause the head to lose lever: a loose leadscrew nut or a 
loose/damaged gear on the tierod.  Please consult the document Titled Head Pressure – 
Adjusting the Head Level on the CarveWright website for detailed instructions.  This is not 
an easy procedure and can be very difficult for a customer to do in some cases and should 
be a last resort and only at the direction and supervision of a CarveWright support 
technician. 

6. If none of the above steps solves the issue consult CarveWright. 
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Head Will not Raise Up 
 
Description of Issue 
The head fails to raise-up when using the crank. 
 
Possible Causes 
Causes include: the red locking lever is engaged, the head is raised to the top of travel, the crank 
handle is not engaging, the head is not level, or there is damage to the cranking mechanism. 
 
Troubleshooting Steps 

1. Check that the head is not already at the top of its travel (up against the side stabilizers).  
Cranking the head beyond its highest useable height can result in it locking in a position 
where the head crank cannot lower it.  Releasing from this locked position it is very easy. 
The right side threaded leadscrew needs to be manually turned and can be accessed from 
the inside of the machine.  There is a hole in the leadscrew just above the traction belts.  
Insert an Allen wrench or similar tool and rotate it in the clockwise direction to unlock it.  
For detailed instruction and pictures, consult the Troubleshooting section of the 
CarveWright Operator’s Manual. 

2. Verify that the red head locking lever is not engaged.  To unlock make sure it is pushed 
back flat against the head casting. 

3. Verify that the crank is engaging the clutch mechanism when rotating it.  It should be very 
hard to turn if the head is not moving down. 

4. Check the level of the head by measuring from the top of the head casting to the underside 
of the plastic stabilizers on all four corners.  If there is more than 1/32” difference the head 
will need to be leveled.  Note that there is always a reason for the head to become unlevel 
and this cause will have to be found and fixed before the issue can be closed.  There are 
two problems that can cause the head to lose lever: a loose leadscrew nut or a 
loose/damaged gear on the tierod.  Please consult the document Titled Head Pressure – 
Adjusting the Head Level on the CarveWright website for detailed instructions.  This is not 
an easy procedure and can be very difficult for a customer to do in some cases and should 
be a last resort and only at the direction and supervision of a CarveWright support 
technician. 

5. If none of the above steps solves the issue consult CarveWright. 
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Inconsistent Board Measurements or Tracking Issues 
 
Description of Issue 
This occurs when the machine measures differently in the length (or X) direction in seemingly 
similar situations.  For example, you measure two similar colored and conditioned boards and the 
machine comes up with widely varying lengths. 
 
Possible Causes 
Cause can be: board defects, rolled up belt, low head pressure, damaged or missing o-ring on the 
board tracking sensor, dust in the board tracking sensor, improperly set/loose sliding plate, 
missing damper spring under the board tracking sensor, bent roller on sandpaper belt tray, 
incorrectly adjusted outfeed trays (adjusted too high or too low), or a broken X-drive gear (you 
can hear a cyclic “chirp” when a tooth is missing or damaged as the board moves in and out). 
 
Troubleshooting Steps 

1. In the case where the board is measuring off in a consistent and predictable way it is 
recommended that the user calibration routine be run on the machine so the internal offsets 
can be adjusted. 

2. Check the board for defects and make sure it is inserted correctly into the machine.  For a 
detailed discussion on the board requirements please see the “Inserting a Board” section in 
the CarveWright Owner’s manual.  Place your test board on a flat surface (for example, a 
bench or the floor).  Scan the edges next to the floor making sure the board touches the 
floor all around.  Press down on the 4 corners of the board to make sure the board does not 
‘pop up’ on the opposite corners. Press down in the center, making sure the board does not 
bow. 

3. Check that the sliding plate is tight and up against the board.  A board that is not captured 
by the sliding plate will allow the board to walk slightly from side to side.  This small 
amount of walking can lead to a wide variance in measured lengths. 

4. Verify that the board sensor is rotating freely.  
5. Verify that the damper spring is still under the board tracking sensor. 
6. Verify that the head pressure is within correct limits. 
7. Verify that neither of the belts are damaged or rolled up. 
8. Check to see that the outfeed rollers are not adjusted too high.  If they are high they can lift 

the board off of the board tracking roller during operation and cause it to lose track of the 
position.   

9. Check to see that the outfeed rollers are not adjusted too low or that the workpiece is 
supported well when it comes out of the machine. If the rollers are too low and the 
workpiece is long and/or heavy then it could lift off the Board tracking Sensor early and 
cause a faulty measurement.  For long boards (over 36”) or for heavy boards make sure that 
they are supported by additional outfeed rollers. 

10. Check to see if the machine has been recently upgraded from sandpaper to rubber belts.  If 
so, the sprung idle roller on the tray may have been bent during installation.  If the belt is 
removed it is very easy to see if the roller is bent. 

11. Check for dust in the board tracking sensor. 
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Additional Tests to Help Pinpoint the Problem 
 

12. Run the project on a different board and see if the problem is repeatable. 
13. Measure several boards with the machine and compare to dimensions found using a tape 

measure. 
14. Place masking tape on the bottom edge nearest the keypad and run a measure board 

routine.  If you cannot see the indentations all the way along the tape then there is 
something wrong with the workpiece that is keeping the tracking roller from engaging. 

15. Remove the o-ring on the Board Tracking Sensor and re-run the project. 
16. If none of the above steps solves the issue consult CarveWright. 
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LCD is Blank 
 
Description of Issue 
The LCD screen shows nothing when the machine is turned on. 
 
Possible Causes 
Cause include: the machine not plugged in, the machine not turned on, the contrast knob on the 
keypad turned down very low, an improperly inserted memory card, a corrupted memory card, a 
disconnected wire to the power supply, a faulty display, or a faulty power supply. 
 
Troubleshooting Steps 

1. Verify that the ON/OFF switch is in the proper position. 
2. Verify that the memory card is properly seated. 
3. Check that the power-strip is ON and functioning. 
4. Verify that there is power to the outlet (have them plug it in somewhere else). 
5. Check that the contrast knob on the keypad is not turned all the way down (to the left).  

Rotate the knob to the extremes in both directions looking for the menu text. 
6. Check to see if power is getting to the machine even though the display is blank.  Turn the 

machine completely OFF, wait 30 seconds, and the move Z-truck up and down and the Y 
truck left and right while noting how much resistance there is to moving them.  Then turn 
the machine ON and feel the resistance again.  If resistance is greater than it was before but 
still nothing shows up on the LCD, first check that the ribbon cable going to the display is 
plugged in (on both sides) and is not damaged.  If the cable appears functional, replace the 
Control Panel Assembly (A2043).   

7. Hit the “7” (Measure) key on the keypad to see if it begins the homing routine.  If it begins 
to move then the LCD screen is faulty. 

8. If the motor resistance is the same when the machine is both ON and OFF there is no 
power to the machine.  UNPLUG THE MACHINE and remove the bottom cover.  Check 
the seating of all of the connectors to the power supply, controller, and ON/OFF switch.  
Plug in the machine and do the test in Step 6 again.  If the motor resistance is still the same 
replace the power supply. 

9. If none of the above steps solves the issue consult CarveWright. 
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LCD Shows Black Squares 
 
Description of Issue 
The LCD screen shows nothing but black squares when the machine is turned on.  There is no 
way to proceed through the menus. 
 
Possible Causes 
Causes include: no memory card inserted in the machine, the contrast knob on the keypad turned 
too high, a faulty memory card, a faulty controller electronics board, or an electrical short in the 
machine. 
 
Troubleshooting Steps 

1. Check that the memory card is inserted.  Slide it out and re-insert. 
2. Check that the contrast knob on the keypad is not turned too high.  Rotate the knob to the 

extremes in both directions looking for the menu text. 
3. Check for an electrical short in the machine.  Turn the machine off and unplug.  Take the 

bottom panel off the machine and unplug the largest of the two ribbon cables from the 
bottom of the enclosed controller box (the controller is what the memory card slides into) 
and the 10 pin cable going to the X termination board.  Turn the machine ON and see if the 
black squares vanish to reveal the menu text.  If so, there is most likely an electrical short 
in the machine.  Have the machine sent in for repair. 

4. If black squares still appear on the LCD screen it means that the memory card or controller 
electronics are probably faulty.  Unfortunately it is impossible to tell which one it is unless 
the user has an extra card.  Send a Memory card (CWMC1) first and if that does not work 
then send a controller (A2065). 
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LCD Shows Random Characters 
 
Description of Issue 
During initial power up, the LCD screen displays a series of random characters. 
 
Possible Causes 
The cause is either a defective controller board (A2065) or a faulty LCD cable. 
 
Troubleshooting Steps 

1. Send the machine in for repair. 
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Machine Reboots at Random Times 
 
Description of Issue 
The machine loses power at random times and reboots to the main menu. 
 
Possible Causes 
Causes include: other machines are on the same power circuit (including unexpected items like 
AC units, compressors, refrigerators, and sump pumps), a faulty power supply, a faulty 
controller, a faulty power switch, or a short somewhere in the machine. 
 
Troubleshooting Steps 

1. Check to see that the machine is plugged into a dedicated circuit and is also not on an 
extension cord.  Try another outlet somewhere else in the house to verify that the circuit is 
not the issue. 

2. Check and see if there are any common variables in the random reboots (position in Y or Z, 
location in the project, etc.) 

3. UNPLUG THE MACHINE and remove the machine’s bottom cover.  Check the seating of 
all of the connectors to the power supply, controller and ON/OFF switch.  Plug in the 
machine and test again. 

4. The next likely candidate is a faulty power supply. 
5. If none of the above steps solves the issue consult CarveWright. 
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No Power to the Machine 
 
Description of Issue 
The machine appears to have no power because nothing is displayed on the LCD screen when 
the machine is turned on. 
 
Possible Causes 
Machine not plugged in, no power to the outlet, machine not turned on, contrast knob for the 
LCD turned too far down, faulty LCD display, faulty power supply, faulty power-strip, cut wire, 
loose wire 
 
Troubleshooting Steps 

1. Verify that the ON/OFF switch is in the proper position. 
2. Check that the power-strip is ON and functioning. 
3. Verify that there is power to the outlet (have them plug it in somewhere else). 
4. Check that the contrast knob on the keypad is not turned all the way down (to the left).  

Rotate the knob to the extremes in both directions 
5. Check that the memory card is inserted. 
6. Check to see if power is getting to the machine even though the display is blank.  Turn the 

machine completely OFF, wait 30 seconds, and the move Z-truck up and down and the Y 
truck left and right while noting how much resistance there is to moving them.  Then turn 
the machine ON and feel the resistance again.  If resistance is greater than it was before but 
still nothing shows up on the LCD, go to “LCD is Blank” troubleshooting section.  If the 
resistance is the same when it is both ON and OFF we are not getting power to the machine. 

7. Hit the “7” (Measure) key on the keypad to see if it begins the homing routine.  If it begins 
to move then the LCD screen is faulty  

8. UNPLUG THE MACHINE and remove the machine’s bottom cover.  Check the seating of 
all of the connectors to the power supply, controller and ON/OFF switch.  Plug in the 
machine and test again. 

9. If none of the above steps solves the issue consult CarveWright. 
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Random Errors Caused by Board Being too Thin 
 
Description of Issue 
There are several issues that can be caused by inserting a board that is below the .5” minimum 
required thickness into the machine.  These errors are all associated with other problems too so 
sometimes it is hard to diagnose unless you check the board thickness right away. 
 
Possible Causes 
A thin board can cause a “Check Front Compression Roller”, “Y-axis stall”, “X-axis stall”, 
“Please Load Board”, or “Possible Board Problem” messages. 
 
Troubleshooting Steps 

1. Verify that the board is always at least .5” thick. 
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Random X, Y, or Z-Axis Stall Errors 
 
Description of Issue 
A random x/y/z-stall is defined as a repeated stoppage during a project where the LCD shows an 
X-Axis Stall, Y-Axis Stall or Z-Axis Stall seemingly with no pattern.   
 
Possible Causes 
This issue is usually caused by an intermittent power supply voltage, an obstacle that is 
preventing movement or a something that is limiting the ability of the cutting bit to remove 
material (i.e. the bit is spinning slowly or not spinning at all when the machine starts to cut). 
 
Troubleshooting Steps 

1. See document titled Random X, Y, or Z-Axis Stall. 
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Sandpaper Belt is Torn 
 
Description of Issue 
When a sandpaper belt becomes torn it is imperative that the root cause be determined before the 
belt is replaced.  If you do not diagnose the issue, the machine may continue to tear them.  Also 
consider upgrading to the super tough Rubber belts 
 
Possible Causes 
The three main causes of sandpaper belts tearing are: the head pressure is too high, the board is 
binding in the machine, and there are imperfections in the board.   
 
Troubleshooting Steps 

1. Imperfections such as knots, fasteners, warp-age, or changes in board thickness can case 
the belts to tear.  The belts could get caught on the imperfections or be overstressed due to 
warp-age or thickness changes. 

2. Check that there are no pieces of material under the belts. 
3. Check the head pressure.  The head pressure should be between 75 and 85 lbs of pressure.  

To bring the head pressure down to the proper range, you will need to make sure that the 
clutch is properly greased.  You should use white lithium grease. 

4. Check that the workpiece is not binding in the machine.  A board that is not straight can get 
caught in the machine, causing the belts to tear.  The board should be perfectly straight. 

5. If none of the above steps solves the issue consult CarveWright. 
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Sandpaper Belt is Rolling Up 
 

Description of Issue 
A sandpaper belt roll-up can be the cause of many machine errors like board tracking issues, 
measuring errors, and even damage to the X drive gears.  The errors appear when the rolled-up 
sandpaper belts lift the workpiece off of the board tracking sensor that tracks the position of the 
board.  It is often not noticeable at first glance so make sure to inspect the edges of the belts for 
the telltale hump, especially on the keypad side of the machine (see photos below).  It is very 
important that the root cause of the roll-up be addressed before sending replacements belts so 
that the same issue does not happen immediately to the new belts.  Also consider upgrading to 
the super tough Rubber belts that do not roll up. 
 

Possible Causes 
In almost every case, the cause of a sandpaper belt rolling up is that the head pressure is too low.  
Very skinny boards (in the width) can also contribute to belts rolling up. 
 

Troubleshooting Steps 
1. If the user is seeing repeated belt rollups during carving of skinny boards (<3”) then 

recommend the rubber belts to eliminate this problem. 
2. Check and adjust the head pressure.  Please refer to the document titled “Checking and 

Adjusting the Head Pressure” found on the service section of the website to resolve the low 
head pressure issue.  Usually a simple lubrication of the vertical guide posts and lead 
screws will bring the pressure into range. 

3. Check that the belt guides on the bottom of the belt trays are in place and are not 
significantly worn.  Check wear against the other guides as a reference. 

 
 
 
 

 

Example of good sandpaper belt  
This picture is looking at the rear belt tray up next to 
the squaring plate on the keypad side of the machine.  
Notice that you can see the whitish edge of the belt and 
that there is no bump where it has rolled under itself.  
Also notice that there is a little of the roller visible. 

Example of a rolled up sandpaper belt  
The picture above-left is looking at the front belt tray up next to the squaring plate on the 
keypad side of the machine.  You can see (and feel) the bump where the belt has rolled 
under itself.  Also notice that the rolled up side is shifted to the end of the roller.  You 
can see the shift if you look at the opposite end of the bet as seen in the right picture. 
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Scan Area Message Appears Instead of the Main Menu 
 
Description of Issue 
The machine is turned on and the LCD screen shows “Scan Area” menu instead of the 
CarveWright Main menu.  This menu appears because the machine thinks that the scanning 
probe is installed. 
 
Possible Causes 
Causes include: scanning probe plugged in, old firmware, or the incorrect user setting telling the 
machine where to look for the scanning probe plug. 
 
Troubleshooting Steps 

1. Verify that the scanning probe is not plugged in. 
2. Verify that the  jumper cable (even without the probe) is not plugged in 
3. Verify that the firmware on the card is the latest release.  If not update the CarveWright 

software first on your computer and then update the memory card firmware through the 
CarveWright software. 

4. Check to see that the machine is looking for the scanning probe plug at the correct 
location. A series machines can be plugged into the Z-truck whereas B and C series 
machines will always be plugged into the connector on the head cover.  This procedure 
can be found in greater detail in the Scanning Probe Operator’s manual found on the 
CarveWright website on the support page. 

a. Insert the card and turn on the machine. “Scan Area: should appear on the LCD 
screen. 

b. Press the “0” (Options) key on the keypad.   
c. Using the up/down arrows, scroll down to the number 5, “User Options” menu 

item and press ENTER. You can also simply press the “5” key when the first 
option appears. 

d. Scroll down to Scan Probe. Make sure it is on “Cover” instead of “Z-truck”. Press 
ENTER to toggle between the options. 

e. Press STOP until you get back to main menu. It should now say Project Menu 
5. If none of the above steps solves the issue consult CarveWright. 
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X Gears Broken or Striped 
 
Description of Issue 
Broken or stripped X drive gears will be evident when the board stops moving through the 
machine when it is commanded.  Usually, this stoppage will be accompanied by a grating noise 
from the X- gear enclosure on the right side of the machine.  Once the gears are broken or 
stripped they will have to be replaced.  But before replacing them and running the machine, it is 
imperative that the root cause be determined so that it does not happen again immediately. 
 
Possible Causes 
Broken X-drive gears can result from excessive head pressure, rolled up sandpaper belts, a 
wedged board, a board that has a significant thickness taper to it, a gear set that has too much 
slop in it, a slow running cut motor, or a gear set that is out of alignment.  
 
Troubleshooting Steps 

1. Check to see that the sandpaper belts are not rolled up.  This will have the same effect as 
the varying thickness board.  This is almost always the case so double check it. 

2. Check to see that the board you were carving was not wedged in the machine (it will wedge 
if the width of the board varies significantly along its length).  Do this by slightly cranking 
up the head and moving the board in and out of the machine along its length looking to see 
if it wedges between the squaring plate and the sliding plate. 

3. Check to see that the board you were carving does not vary in thickness over its length.  If 
it does it will wedge between the upper compression rollers and the belt drives and 
overload the X gears. 

4. Check that the head pressure is between 75 to 85 lbs.  If the head pressure is lower than 75 
lbs or higher than 85 lbs, it could well make the x-gears to stripe or brake.  Please see the 
“Checking the Head Pressure” document on the CarveWright website for continued 
troubleshooting of this issue. 

5. Check the spacing of the metal gear on the X belt drives.  When the machine is apart to 
replace the X gears make sure that the spacing on the metal drive gear attached to the belt 
tray roller is correctly spaced out from the end of the tray.  You can see instructions for 
checking this in the document titled “Replacing the Sandpaper Drive Belts”.  In place of 
the spacer mentioned in that document use a stacked penny and dime. 

6. Verify that the cut motor is not getting bogged down or stopping during the project.  If the 
bit is not cutting it will cause increased force on the gears. 

7. If none of the above steps solves the issue consult CarveWright. 
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Z-Truck Overheating 
 
Description of Issue 
The temperature of the Z-truck should stay below 60 degrees Celsius (140 degrees Fahrenheit) at 
all times.  As a rule of thumb, if you cannot hold your hand on the surface of the truck for more 
than 5 seconds it is too hot.  There is a run-in period with a new machine where the temperature 
will be slightly higher than normal as it wears in it bearings, but even then it should never get 
above 60C.  Certain operations, like cutting or routing with large bits, will also increase the 
temperature of the Z-Truck over that seen under normal operating conditions. 
 
Possible Causes 
If the Z-truck is running hot, it is most likely an issue with the spindle (bearings, tolerance rings, 
or quick change).  A bad or improperly installed flexshaft or a dull or loose bit can also cause the 
Z-truck to heat up.  Adding any sort of lubrication to the flexshaft other than the prescribed 
Chain Lube with Moly will get into and destroy the bearings.   
 
Troubleshooting Steps 

1. Check to make sure the cutting bit is not dull.  This is especially important when using the 
larger decorative bits. 

2. Check to see if the flexshaft has been lubricated lately and if so verify that it was Chain 
Lube with Moly applied in the proper way. 

3. Verify that the flexshaft is properly seated into the spindle.  Please see instructions in the 
CarveWright Owner’s Manual. 

4. Check for any play in the spindle by moving it side to side.  You should not be able to feel 
any slop or play in the spindle. 

5. Check to make sure that the bit is not loose in the spindle or holder. 
6. If none of the above steps solves the issue consult CarveWright. 
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Consolidated Error Codes 
 
Machine errors are now in the form: Exx-yyyy. The number "xx" is one of the numbers listed 
below.  The number "yyyy" is the line number in the code. (Note:  This only applies to machines 
running the firmware 1.175 or later).  When an error is encountered make sure that you record 
the error number exactly as it will greatly assist in troubleshooting.  All of the following errors 
are non-recoverable meaning that the project will need to be restarted after the issue is fixed. 
 
E02 - Exception stack fault 
Cycle the machine power and retry the project.  If the error persists, record the seven digit error 
code and contact CarveWright customer support. 
 
E03 - Board edge detection failure 
This error is shown when STOP is pressed after the "Clear Board Sensor" message is displayed.  
See the “Clear Board Sensor” troubleshooting section for more details.  The “Clear Board 
Sensor” error occurs during the length (or X) edge find.  After the roller releases the board sensor 
was not able to find the edge within approximately 4".  Can also occur when the board sensor did 
not detect a large enough transition to define an edge (usually happens when the material is very 
dark or there is dust on the sliding plate). 
 
E04 - X axis stall 

Description of Issue 
An “X-Axis Stall” will happen when the machine is not able to move the board in and out of 
the machine when commanded. 
 

Possible Causes 
An “X-Axis Stall” can result from excessive head pressure, rolled up sandpaper belts, a 
wedged board, a board that has a significant thickness taper to it, a gear set that has too much 
slop in it, a slow running cut motor, or a gear set that is out of alignment.  
 

Troubleshooting Steps 
1. Check to see that the sandpaper belts are not rolled up.  This will have the same effect as 

the varying thickness board.  This is almost always the case so double check it. 
2. Check to see that the board you were carving was not wedged in the machine (it will 

wedge if the width of the board varies significantly along its length).  Do this by slightly 
cranking up the head and moving the board in and out of the machine along its length 
looking to see if it wedges between the squaring plate and the sliding plate. 

3. Check to see that the board you were carving does not vary in thickness over its length.  If 
it does it will wedge between the upper compression rollers and the belt drives and 
overload the X gears. 

4. Check that the head pressure is between 75 to 85 lbs.  If the head pressure is lower than 75 
lbs or higher than 85 lbs, it could well make the x-gears to stripe or brake.  Please see the 
“Checking the Head Pressure” document on the CarveWright website for continued 
troubleshooting of this issue. 

5. Check the spacing of the metal gear on the X belt drives.  When the machine is apart to 
replace the X gears make sure that the spacing on the metal drive gear attached to the belt 
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tray roller is correctly spaced out from the end of the tray.  You can see instructions for 
checking this in the document titled “Replacing the Sandpaper Drive Belts”.  In place of 
the spacer mentioned in that document use a stacked penny and dime. 

6. Verify that the cut motor is not getting bogged down or stopping during the project.  If the 
bit is not cutting it will cause increased force on the gears. 

7. If none of the above steps solves the issue consult CarveWright. 
 
E05 - Y axis stall (Normal) 

Possible Causes 
A Y-axis stall is caused when the difference between the commanded distance becomes much 
more than the actual distance over the allotted time interval.  An easy example of this would 
be putting your hand on the cutting truck and preventing it from moving during an operation.  
The computer is commanding it (and expecting it to move a certain distance in a given time 
interval) but your hand is preventing it from moving; or stalling the movement.  A stall does 
not have to be a physical obstacle to movement.  For instance if a power lead to the motor was 
broken then the motor would not move when commanded and the computer would record a 
stall. 
 

Possible Causes 
Causes include: obstacles blocking the movement of the cutting head, outdated firmware, 
faulty electrical circuit in the shop, and electrical short in the machine, a loose connector, a 
faulty power supply, or a cut motor that is not spinning.   
 

Troubleshooting Steps 
Consult the troubleshooting document titled “Y-Axis Stall” for detailed diagnosis instructions. 

 
E06 - Z axis stall (Normal) 

Description of Issue 
A Z-axis stall is caused when the difference between the commanded distance becomes much 
more than the actual distance over the allotted time interval.  An easy example of this would 
be putting your hand on the cutting truck and preventing it from moving during an operation.  
The computer is commanding it (and expecting it to move a certain distance in a given time 
interval) but your hand is preventing it from moving; or stalling the movement.  A stall does 
not have to be a physical obstacle to movement.  For instance if a power lead to the motor was 
broken then the motor would not move when commanded and the computer would record a 
stall. 
 

Possible Causes 
Causes include: obstacles blocking the movement of the cutting head, outdated firmware, 
faulty electrical circuit in the shop, and electrical short in the machine, a loose connector, a 
faulty power supply, or a cut motor that is not spinning.   
 

Troubleshooting Steps 
Consult the troubleshooting document titled “Z-Axis Stall” for detailed diagnosis instructions. 

 
E09 - Homing fault (Low) 
Cycle the machine power and retry the project.  If the error persists, record the seven digit error 
code and contact CarveWright. 
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E10 - No Bit Detected (Low) 
This error message occurs when STOP is pressed when asked to reload the bit. Restart the 
project. 
 
E14 - Cutter arm fault (Low) 
If cut motor is activated while a probe is inserted, or when it is activated when cut motor is not 
enabled.  Remove probe when doing a project. 
 
E16 - Bit Selection Error (Low) 
Bit selection part of the project data is corrupted.  Format the memory card and reload the 
project. 
 
E17 - Board find range (Low) 
This error message occurs when STOP is pressed when user is told to set the sliding plate 
properly.  Restart the project. 
 
E32 - Tracking Sensor Fault (Low) 
This error occurs only during the initial homing and measurement routine before the carving.  It 
occurs when the measured backlash on the X–drive is too large or movement was not detected.  
It most likely occurs when there is an issue with the board that causes tracking problems.  Go to 
the “Possible Board Problem” message section above to troubleshoot. 
 
E33 - Front Roller Fault (Normal) 
While searching for the front edge of the board, the machine is waiting for the front roller to 
release and then activate the board sensor to find the edge.  The “Front Roller Fault” occurs 
when the back roller releases before the front roller indicating that the front roller is actually 
stuck.  Go to the “Stuck Compression Roller” message section above to troubleshoot. 
 
E34 - Back Roller Fault (Normal) 
While searching for the back edge of the board, the machine is waiting for the back roller to 
release and then activate the board sensor to find the edge.  The “Back Roller Fault” occurs when 
the front roller releases before the back roller indicating that the back roller is actually stuck.  Go 
to the “Stuck Compression Roller” message section above to troubleshoot. 
 
E37 - Cut Motor Motor Sensor Fault (Low) 
This error message occurs when STOP is pressed when prompting to check the cut motor.  
Restart the project. 
 
E44 - User calibration failure (Low) 
During the user "Sensor" calibration, the board cut/edge test failed to perform within its 
tolerances.  The machine is told to cut a small (0.050" or so) slice from the notches it puts in the 
board with the 3/8" bit.  The board sensor re-reads the slice and checks if the machine cut the 
proper amount.  If the test cannot get within 0.005" & 0.003" in 3 cuts, you get this error. 
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E45 - Settings value out of range (Never) 
This error is replaced by the "Calibration Range Error" message during user calibration if a 
number that is too big is input.  Make sure to follow the direction for user calibration precisely. 
 
E46 - Attempting to call pure virtual method (Never) 
Cycle the machine power and retry the project.  If the error persists, record the seven digit error 
code and contact CarveWright. 
 
E47 - Probe Detected (Never) 
Cycle the machine power and retry the project.  If the error persists, record the seven digit error 
code and contact CarveWright. 
 
E48 - Waiting on motion while servoing disabled (Low) 
Motion was requested in software when the X/Y/Z servos were disabled.  The machine will 
report "motion flush w/o servo", then throw error E48 to the screen when the user presses a key.  
Cycle the machine power and retry the project.  If the error persists, record the seven digit error 
code and contact CarveWright. 
 
E49 - Tracking roller failed (Low) 
This error occurs only during the initial homing and measurement routine before the carving.  It 
occurs when STOP is pressed during "Check Tracking Roller" error message.  This error is 
shown because of out of limit numbers when measuring the length of the board. 
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CHAPTER 10 – QUICK TOOL 

REFERENCE GUIDE



File MenuFile MenuFile Menu

New Piece/ProjectNew Piece/Project Select this button to launch the New Dialog to create a new 
piece or project.

Open Piece/ProjectOpen Piece/Project Select this button to launch an operating system File Open 
Dialog to recall a piece or project previously saved to disk.

Open with Preview (Designer 
PRO)
Open with Preview (Designer 
PRO)

Option to open a preview of patterns or projects.  This 
function must create a database first.  It can be turned off.

SaveSave Select this button to launch an operating system Save 
Dialog to save a work currently in progress.

Save AsSave As Allows you to place it in a new location on your computer 
and/or change its name.

Flash ManagerFlash Manager
Accesses your memory card where you can manage card 
space and firmware, reformat the card, download scan, 
access and manage quality settings and estimated time. 

UploadUpload Select this button to upload a project to the flash card.

Download Scan (Pattern 
Editor)
Download Scan (Pattern 
Editor) Accesses scans from memory card.

Download Scan from file 
(Pattern Editor)
Download Scan from file 
(Pattern Editor) Accesses scan files from location on your computer.
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ImportImport
Used to bring in artwork and images created in various 
other programs and additional software maybe required 
depending on the format the piece was created in.

CW Racing Dragster (CO2 
Dragster Software)
CW Racing Dragster (CO2 
Dragster Software)

This add-on feature allows use of the CW CO2 Dragster 
Jig.

Import Tracing Image (2D 
Vector Drawing)
Import Tracing Image (2D 
Vector Drawing)

Import Tracing Image allows for an image file (jpg, png, gif, 
bmp) to be imported and placed on the design board to be 
used as a pattern for tracing with the drawing tools. The 
image can be cropped and scaled during the import 
process to suit your needs and can be toggled on and off to 
better view your drawing.

Import ImageImport Image Select this button to import an image into your pattern 
library.

Import DXF File (DXF 
Importer)
Import DXF File (DXF 
Importer)

This advanced feature allows the import of 2D vector 
drawing saved in the DXF format.

Import STL File (STL 
Importer)
Import STL File (STL 
Importer)

This advanced feature allows the import of 3D models 
saved in the STL format.

Launch Pattern Editor 
(Pattern Editor)
Launch Pattern Editor 
(Pattern Editor)

This add-on feature allows scanned and imported patterns 
to be edited on a pixel by pixel basis.

Launch Pattern Sculptor 
(Pattern Sculptor and 
Designer PRO)

Launch Pattern Sculptor 
(Pattern Sculptor and 
Designer PRO)

This advanced feature allows patterns to be edited with 
powerful sculpting tools.

PrintPrint Select this button to print a paper copy of the workpiece.

ExitExit Closes out the program. (WINDOWS)
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Edit MenuEdit MenuEdit Menu

UndoUndo Select this button to undo the last edit operation.

RedoRedo Select this button to redo the last undone edit operation.

CutCut Select this button to cut the currently selected carvings or 
figures and place them onto the clipboard.

CopyCopy Select this button to copy the currently selected carvings or 
figures onto the clipboard.

PastePaste Select this button to paste any carvings or figures currently 
on the clipboard onto the board.

Select allSelect all Select this button to select all items on the board.

DeleteDelete Select this button to delete highlighted items from the 
workpiece.

PreferencesPreferences Manages general behavior of software, measurement 
preference, cache and 3D graphics.

Board SettingsBoard Settings Allows management of board size, pattern bit, and virtual 
representation of wood type, stain and finish.
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Drawing MenuDrawing MenuDrawing Menu

Pointer ToolPointer Tool

Select this tool, then left-click on the board to select 
carvings for manipulation. You may hold down the SHIFT 
key to select or de-select additional carvings. You may also 
click and drag to draw a wire-box to select multiple 
carvings.

Line Segment ToolLine Segment Tool
Select this tool, then left-click on the board to begin a line 
segment. Left-click again to end it. You may also click and 
drag to create a segment.

Connected Lines ToolConnected Lines Tool

Select this tool, then left-click on the board to begin a line 
segment.  Each successive left click ends the previous 
segment and begins a new one. To end the segments, you 
may either double-click to place a final segment,  click on 
the last vertex placed, press the ESC key, or click on the 
first vertex to create a closed loop.

Spline ToolSpline Tool

Select this tool, then left-click on the board to begin a 
curved segment.  Each successive left click ends the 
previous segment and begins a new one. You need to 
create two or more connected segments to see the curve 
effect. To end the segments, you may either double-click to 
place a final segment, click on the last vertex placed, press 
the ESC key, or click on the first vertex to create a closed 
loop.

Smart Spline Tool (2D Vector 
Drawing)
Smart Spline Tool (2D Vector 
Drawing)

Allows the ability for free form draw with multiple points 
either as tangents or line segments.

Square ToolSquare Tool
Select this tool, then left-click on the board to start a 
square, and then left-click again to end it. You may also 
click and drag to create a square. Squares will maintain 
their square aspect when manipulated.

Rectangle ToolRectangle Tool
Select this tool, then left-click on the board to start a 
rectangle, and then left-click again to end it. You may also 
click and drag to create a rectangle.

Circle ToolCircle Tool
Select this tool, then left-click on the board to place the 
center of the circle, then left-click again to end it. You may 
also click and drag to create a circle. Circles will maintain 
their circular aspect when manipulated.
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Oval ToolOval Tool
Select this tool, then left-click on the board to place the 
center of the oval, then left-click again to end it. You may 
also click and drag to create an oval.

Arc ToolArc Tool

Select this tool, then left-click on the board to place one 
end of the arc, then left-click to place the other end. You 
may also click and drag to create an arc. Either way you 
need to click and drag the Green Control Point to change 
the radius of the arch.

Text ToolText Tool Select this tool, then left-click to place text. See Placing 
Text for more information.

Rout ToolRout Tool The rout tool allows for adjusting the pivot point of a depth 
profile.

Trim Tool (2D Vector Drawing)Trim Tool (2D Vector Drawing)
Select this tool to trim intersecting line segments.  To use 
this tool, select at least two intersecting line segments. 
Then select this tool and left-click  the portion of the line 
segment or segments you wish to keep.

Carving MenuCarving MenuCarving Menu

Pattern ToolPattern Tool

Selecting this tool will display the pattern selection window. 
Select a pattern from the list, view it in the thumbnail view 
window beneath the pattern list, and then left-click on the 
board to place the pattern. See the Placing 
Patterns section for more information.

FeatherFeather

This sets the degree of feathering applied to the 
highlighted pattern on the workpiece. This angle is 
projected from the base of the patternʼs outer edge. Used 
for creating a transition from the top surface of the board to 
the base of the carving.

Feather NoneFeather None Removes any feather settings.

Feather 1/8Feather 1/8 This sets the degree of feathering to 1/8”
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